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Notice To Users 

Federal Communications Commission Notice 

This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures: 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected. 

• Reorient or relocate the receiving antenna. 

• Consult the dealer or an experienced radio or television 
technician for help. 

Supplied Software 

Copyright laws prohibit reproducing the software or the manual 
accompanying it in whole or in part, or renting the software without the 
permission of the copyright holder. 

In no event will Freedom Scientific, LLC. be liable for any financial 
damage, or loss of profits, including claims made by third parties, arising 
out of the use of the software supplied with this computer. 

In the event a problem occurs with this software as a result of defective 
manufacturing, Freedom Scientific, LLC will replace it. However, Freedom 
Scientific bears no other responsibility. 

The software provided with this computer cannot be used with equipment 
other than that which is so designated. 

Please note that, due to continued efforts to improve quality, the software 
specifications may be changed without notice. Operation of this computer 
with software other than that provided is not covered by the warranty. 
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Welcome 
Congratulations on your purchase of the PAC Mate BNS. The PAC 
Mate BNS is the first in the series of Personal Data Computers 
designed and developed by Freedom Scientific.  

What is PAC Mate? 
The PAC Mate line of computers combines the Windows® Pocket 
PC platform with JAWS screen reading technology. It offers the 
latest in mobile technology making it a powerful portable 
information management tool. 

Key features include: 
• JAWS screen reader for Windows CE 
• Four sided cursor cross for easy navigation and command 

execution  
• Four function keys for execution of specific application 

commands 
• 64 MB RAM 
• 32 MB Flash 
• Slots for Compact Flash Cards and PC Cards 
• Support for both dial up and broadband Internet access 

(requires modem or network card) 
• USB Port 
• ActiveSync 
• Infrared Wireless Input/Output Port 
• User Replaceable Battery  
• Serial Port 
• Internal microphone and external microphone jack making for 

quick voice notes 
• Internal speaker and stereo headphone jack 
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• Dual stereo mixer so you can listen to a media file and JAWS 
at the same time 

Getting Help 
PAC Mate provides a variety of ways to get help and provides this 
help as conveniently as possible.  

One of the ways PAC Mate provides help is through Tutor 
Messages. Tutor Messages provide information on how to navigate 
and use various controls. This can be very useful for beginners 
who are not familiar with JAWS. In addition, these messages can 
be repeated by pressing G CHORD (DOTS 1-2-4-5 CHORD). Tutor 
Messages are enabled by default, but you can disable this feature 
and still access Tutor Messages with G CHORD (DOTS 1-2-4-5 
CHORD). For more information on Tutor Messages, please see 
Setting Up PAC Mate, Verbosity. 

Another way PAC Mate provides help is with Access Key 
Messages. Access keys are the keys you press to move directly to 
a control or an item in a menu. Access Key Messages, like Tutor 
Messages, are enabled by default and are announced 
automatically. You can disable this control in the Verbosity Settings 
dialog. Once disabled, you can press Dropped G CHORD (DOTS 
2-3-5-6 CHORD) to hear the access key message. Press DOTS 2-
3-4-5-6 CHORD followed by the access key to move directly to that 
control. For more information on Access Key Messages, please 
see Setting Up PAC Mate, Verbosity.  

Help at Your Fingertips 
The following commands provide quick access to Help as you 
use PAC Mate.  

Description Command 
Control Help Question Mark CHORD, C 

(DOTS 1-4-5-6 CHORD, DOTS 1-4) 

Keyboard Help Question Mark CHORD, K 
(DOTS 1-4-5-6 CHORD, DOTS 1-3) 
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Context Help Question Mark CHORD, H 
(DOTS 1-4-5-6 CHORD, DOTS 1-2-5) 

Basics for PAC  
Mate Help 

Question Mark CHORD, T 
(DOTS 1-4-5-6 CHORD, DOTS 2-3-4-5) 

PAC Mate  
Keystrokes 

Question Mark CHORD, P 
(DOTS 1-4-5-6 CHORD, DOTS 1-2-3-4) 

Control Help 
Use Question Mark CHORD, C when you want to know how 
and what commands are used to change, enable, or set a 
control in a dialog.  

Keyboard Help 
Turn on this feature to explore PAC Mate commands. As you 
press key combinations, PAC Mate tells you which keyboard 
commands do what, safely - without actually performing the 
command. Press Question Mark CHORD, K again to exit 
keyboard help. 

Context Help 
Use Question Mark CHORD, H when you want to know 
information and the commands for the current application, 
window, or dialog. 

Basics for PAC Mate Help 
The command Question Mark CHORD, T opens the online help 
file, Basics for PAC Mate Help, when you need to review topics 
such as navigation, PAC Mate Commands, or how to access the 
Settings Menu.  

PAC Mate Keystrokes 
Press Question Mark CHORD, P when you want to open Help 
to PAC Mate’s online table of commands. 
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Using PAC Mate’s Online Help 
Tip:  The fastest way to open Help is to go to the Start 

Menu (F3), press the UP ARROW once and then 
press ENTER (DOT 8) or press F3, H (DOTS 1-2-5). 

PAC Mate’s online help uses a task-oriented approach and 
briefly covers the steps necessary to complete a task. To aid 
you, the online help is specific to the program that is running. 
For example, while in FSEdit when you open Help from the Start 
Menu, only FSEdit Help opens. 

In addition, because PAC Mate’s online help is written in HTML, 
you can use many of Internet Explorer’s commands to navigate 
and read each help topic. For example, you can navigate to a 
topic quickly by opening a list of links with the command H 
CHORD, L. Or you can move easily through a table using DOT 
8 plus the cursor cross. 

For added convenience, next links have been added to Help so 
you can easily move to the next consecutive topic. To move 
back, just press DOT 2-4-6 CHORD. If, after you go back to the 
previous help topic, you are not at the top of the page, press L 
CHORD (DOTS 1-2-3 CHORD) and then use the reading 
commands. 

The table below lists the Internet Explorer commands that you 
can use to navigate the online help. 

Description Command 
Back DOTS 2-4-6 CHORD 
Refresh Page  SH CHORD, R 

(DOTS 1-4-6 CHORD, DOTS 1-2-3-5) 
Next Link DOTS 4-5 CHORD 
Prior Link DOTS 1-2 CHORD 
Link List H CHORD, L 

(DOTS 1-2-5 CHORD, DOTS 1-2-3) 
Move to Next 
Non-Link Text 

N (DOTS 1-3-4-5) 
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List Headings H CHORD, H 
(DOTS 1-2-5 CHORD, DOTS 1-2-5) 

Next Heading H (DOTS 1-2-5) 
Prior Heading DOTS 1-2-5-7 
First Heading H CHORD, UP ARROW 
Last Heading H CHORD, DOWN ARROW 
Read Current Cell H CHORD, C 
Next Cell DOT 8+RIGHT ARROW 
Prior Cell DOT 8+Left ARROW 
Cell Above DOT 8+UP ARROW 
Cell Below DOT 8+DOWN ARROW 
First Cell DOTS 1-3-8 
Last Cell DOTS 4-6-8 

Visit our Web Site  
At Freedom Scientific, we are continually updating and 
improving PAC Mate documentation. To access the latest and 
most complete PAC Mate documentation, visit our web site at 
http://www.freedomscientific.com/fs_support/support_document
ation.asp  

Documentation Conventions 
Commands are documented in two formats, the Braille letter or 
sign is listed, or the Braille dot pattern is specified. When dot 
patterns are specified, the dot numbers are joined by dashes. All 
dots must be pressed at the same time. 

A plus sign (+) is used to indicate that keys are pressed together. 
For example, "Press DOT 5+RIGHT ARROW to move to and read 
the next word." 

A chorded command is a command that includes the SPACEBAR.  

440060-001 Rev. A  5 

http://www.freedomscientific.com/fs_support/support_documentation.asp
http://www.freedomscientific.com/fs_support/support_documentation.asp


 

A layered command is a two-part command. Press the keys in the 
first sequence, release them all, and press the keys in the second 
sequence. For example, "press I CHORD, T (DOTS 2-4 CHORD, 
DOTS 2-3-4-5) to read the current window title." 

The term program is synonymous with the term application and 
may be used interchangeably in this manual. 

Another convention is the reference regarding the active state of an 
item. When an item is in the active state, this means that PAC 
Mate is focusing on the item and certain keystrokes performed 
affect that item. PAC Mate gives auditory feedback to indicate the 
active state.   

Using Windows CE with PAC Mate 
Using Windows CE with PAC Mate is quite easy once you master 
the basic skills. It is recommended that you read and learn this 
section as it teaches you basic PAC Mate skills needed to operate 
Windows CE.  

Starting PAC Mate  
Before you start your PAC Mate for the first time, plug the AC 
adapter into a wall plug and then plug the other end into PAC 
Mate using the jack in the upper left corner of the case. Next, 
press the On/Off switch on the upper right side of the case. To 
indicate that it is on, the PAC Mate uses an audible low high 
sound and to indicate that it is off, it uses a high low sound.  

After a few seconds you will hear, "JAWS for Pocket PC is 
ready." 

You can immediately start using your PAC Mate while it is 
charging, but let the initial charge of your battery last for at 
least three hours.  

Keyboard Orientation and Basic Commands 
The PAC Mate BNS keyboard consists of eight keys, a 
spacebar, four function keys, and the cursor cross. The eight 
keys from left to right are: 7, 3, 2, 1, 4, 5, 6, and 8.The spacebar 
is near the front, in the center of the keyboard. Between keys 1 
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and 4 is the cursor cross. Towards the rear on the left and right 
edges of the unit are the four function keys. Function key one 
(F1) is the top left key with function key two (F2) below it. 
Function key three (F3) is the top right key with function key four 
(F4) below it. 

 
To use PAC Mate you only need to know the four basic keys 
and six common commands:  
• F1 (Cancel or ESC) 
• F2 (Menu Bar) 
• F3 (Start Menu)  
• Cursor cross (UP, DOWN, LEFT, and RIGHT ARROW)  
• DOT 8 (ENTER)  
• DOTS 4-5 CHORD (TAB) 
• DOTS 1-2 CHORD (SHIFT+TAB) 
• DOTS 6-8 (Stop Speech)  
• S CHORD, UP ARROW (Increase Volume)  
• S CHORD, DOWN ARROW (Decrease Volume)  
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Note:  A CHORD is created anytime you press the 
SPACEBAR in conjunction with a keystroke. 

In addition, many of the PAC Mate menus allow first letter 
navigation.  

These nine commands are the foundation from which you will 
become familiar with your PAC Mate. For more information on 
commands, please see Appendix A: PAC Mate Commands. 

Another command you should get familiar with right away is the 
F2 CHORD. This command activates the Context Menu, which 
allows you to quickly perform an action on an item. For example, 
you can use a Context Menu to cut, copy, select all, paste, 
delete or create a new folder. To access a Context Menu, select 
an item such as a word in a document, a date in the Calendar 
View, or a file in a list view and press F2 CHORD. A menu 
opens with a variety of commands, select a command with the 
cursor cross and press ENTER. Or press F1 to escape the 
menu without performing the action. 

Today Screen Orientation and Program Layout 
When you turn PAC Mate on, your Today Screen is immediately 
available. On your Today Screen are five items: owner’s 
information, appointments messages, tasks, and battery charge. 
You move to these items using the UP or DOWN ARROWS, 
which are on the cursor cross in the center of the keyboard. To 
open any of these items, press DOT 8 (ENTER). To cancel the 
item and return to the Today Screen, press F1. You handle all 
menu navigation, including the Start Menu (F3), in this manner 
as well. Regardless of where you are or what you are doing on 
the PAC Mate, the Start Menu is always accessible with the F3 
key.  

There is one more component to the Today Screen that you 
may find convenient. Like all programs on the PAC Mate, the 
Today Screen has a menu. To access this menu, press F2. 
From this menu you can quickly; create an appointment, task or 
note, enter a contact, write an e-mail message, and open a 
Word document or Excel spreadsheet. 
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Note:  As you explore your PAC Mate, you will occasionally 
come across unsupported features or phrases such 
as the words, “tap here.” In this instance, instead of 
tapping, press DOT 8. For more information about 
unsupported features, refer to Appendix C. 

Typically, most programs have a menu bar with menus such as 
New, Edit, or Tools. The menus on the menu bar are accessed 
with the F2 command. Press ENTER on the menu you want to 
open. Many menus have submenus, which frequently are 
announced. For submenus that are announced, you can press 
ENTER or the RIGHT ARROW to open the submenu and use 
the LEFT ARROW to return to the menu. 

For submenus that are unannounced, you cannot return to the 
menu with the LEFT ARROW, but must press F2 again. 
Similarly, once you press ENTER to open a menu you cannot 
use the arrow keys to move to and from other menus as you can 
on a desktop or laptop computer. Instead you must press F2 
again. 

Working with Dialogs and Controls 
Dialogs are smaller windows that usually appear from a menu 
choice. They contain controls used to configure various settings.  

There are many types of controls in a dialog, such as edit fields, 
combo boxes, and slide controls.  

In dialogs, DOTS 4-5 CHORD (TAB) moves you forward 
through the controls, while DOTS 1-2 CHORD (SHIFT+TAB) 
moves you backwards. 

Radio Buttons 
Radio buttons are presented in a dialog as two or more small 
circles. This control type allows exclusive selections in that only 
one radio button in a group can be selected. Use DOWN 
ARROW to move through the radio buttons, and when you land 
on the appropriate choice, press DOTS 4-5 CHORD to move to 
the next control.  
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Note:  Only one radio button in a group can be selected at 
a time.  

Edit Fields 
Edit fields are similar to the edit fields in word processors. You 
can type text into an edit field, and typically you can use the 
same navigation keystrokes here, as you would in a document 
edit field. A multi-line edit field allows you to type more than one 
line in an edit field.  

Edit Combo Box 
An edit combo box is a combination of two controls: an edit field 
and a list box. You can either type in a value or press DOT 
7+DOWN ARROW to open a list box. The list contains 
suggestions for the contents of this field. Use the UP and 
DOWN ARROW keys to move through the list, and use DOT 
7+UP ARROW or F1 to close the list box. If you do not find your 
choice in the list box, type it in the edit field.  

Combo Box 
A plain combo box differs from the edit combo box. You must 
make your selection from suggestions provided by the program. 
Either press DOWN ARROW to move through the choices, or 
press the first letter of the choice you want to make.  

Note:  When you encounter a combo box you may need to 
press DOWN ARROW twice in order to move to the 
next item. 

Edit Spin Box 
The edit spin box is also a combination of two controls. You can 
type in this field, or use the arrow keys to move through the list 
of suggestions. Edit spin boxes are common for fields that 
require numeric values.  
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Left/Right Slider 
Left/right sliders are oriented horizontally. You can use your 
LEFT and RIGHT ARROWS to adjust this control. For some 
controls, the commands, DOT 2+UP ARROW and DOT 
2+DOWN ARROW, are implemented so you can move by larger 
increments.  

Check Box 
A check box can be checked or unchecked. PAC Mate 
announces the current state of a check box when you move to 
it. Press SPACEBAR to check or clear a check box.  

In an extended select list box, use the arrow keys to navigate 
the list of options that have check boxes related to them, and 
press SPACEBAR to check or clear the check boxes.  

Buttons 
Buttons are common to dialogs and in the Pocket PC 
environment require special consideration. In most dialogs, 
pressing the SPACEBAR activates a button. However, there are 
instances where a button does not respond to the SPACEBAR. 
When you encounter these instances, press ENTER instead. 
Also, the default button in a dialog always responds to ENTER, 
even if another control is active. For example, in the JAWS 
Voice Settings dialog, just press ENTER after adjusting the 
speech rate to activate the OK button, which closes the dialog 
and saves your changes. 

Multi-Page Dialogs 
A Multi-Page dialog is a dialog with multiple pages. When you 
open a multi-page dialog, the name of the current page is 
announced after the name of the dialog. For example, "Sounds 
and Notifications, Volume page." 

Multi-page dialogs contain an extra control, the page tab control. 
Move to this control the same as any other control, by pressing 
DOTS 4-5 CHORD (TAB) or DOTS 1-2 CHORD (SHIFT+TAB) 
until it is reached. Press RIGHT ARROW or LEFT ARROW to 
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move between the pages of the dialog, and press DOTS 4-5 
CHORD to move to the first control on that dialog page. 

You can also press DOTS 5-6 CHORD or DOTS 2-3 CHORD to 
switch pages in a multi-page dialog. 

List View 
This control lists items such as files and folders, and may 
contain several columns of information. To hear the available 
items in a list view, press UP or DOWN ARROW. As you move 
through the list, the first column of information is read. To hear 
information from all columns for the current item, press DOTS 1-
4 CHORD, the Read Current Line command. 

In a list view, the current item is selected. You can select 
multiple items as long as they are listed one after the other. 
Press and hold DOT 7, then press DOT 4 CHORD to select the 
current item. Continue holding DOT 7, and press DOT 4 
CHORD again to select the next item as well. 

Tree View 
In a tree view, items are presented in a hierarchical format, 
which is organized vertically on the screen. Press UP or DOWN 
ARROW to move through the tree view. When you hear, "level 
zero closed," you press RIGHT ARROW to open that level. You 
are then presented with more information beneath it. Press 
DOWN ARROW to move through the next level. One of those 
items may also be closed so you would press RIGHT ARROW 
again to open that item. If you want to close a level, press LEFT 
ARROW or DOT 7.  

Note:  The PAC Mate only announces the level number 
when it changes. 

Using File Explorer 
File Explorer, like Windows Explorer, gives you access to all the 
files on your PAC Mate. To open File Explorer, go to the Start 
Menu (F3) and press P (DOTS 1-2-3-4) to open the Programs 
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submenu. Then press F (DOTS 1-2-4) and ENTER (DOT 8) to 
open File Explorer. 

When you first launch File Explorer, you hear “My Documents 
list view, Business folder, one of three.” The phrase, “My 
Documents list view,” means that the My Documents folder is 
open listing all of its folders and files. The phrases, “Business 
folder, one of three,” means that the Business folder is selected 
and it is one of the three subfolders in the My Documents folder.  

To view all the files and folders on your PAC Mate, from the list 
view press F2. Move to Show By and press ENTER. Then move 
to My Device and press ENTER again. 

To navigate among the folders and files, use the commands 
listed in the following table. 

Description Command 
Prior File/Folder UP ARROW 
Next File/Folder DOWN ARROW 
Open File/Folder RIGHT ARROW or ENTER 
Up One Folder Level LEFT ARROW 
Select File or Folder SPACEBAR 
Show By SH CHORD, W 

(DOTS 1-4-6 CHORD, DOTS 2-4-5-6) 
Sort By SH CHORD, Y 

(DOTS 1-4-6 CHORD, DOTS 1-3-4-5-6) 

In File Explorer, the menu bar (F2) contains: Edit, Open My 
Documents, Flash Disk, Show By, and Sort By. To open a file or 
folder, select it from the list view and press ENTER.  

To quickly delete, rename, copy, or move a file or folder, select 
it from the list view by pressing the SPACEBAR and press E 
CHORD, D or open the Context Menu with F2 CHORD and 
choose Delete. To select multiple items, use the 
SPACEBAR+DOWN ARROW.  
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Here are some examples of how File Explorer can help you 
maintain and manage your files.  

Moving or copying a file(s) to your compact flash card: 
1. Select the file(s) you want to move. 
2. Open the Context Menu.  
3. Use the cursor cross to select copy or move a file and 

press ENTER.  
4. Next, press F2 to access the menu bar and select 

FlashFX Disk.  
5. Navigate to the folder you want to store them in and open 

it. 
6. Press F2 again and select Edit, and paste.  

Sorting files by their type: 
1. From the list view, press F2. 
2. Use the cursor cross to select Sort By and press ENTER. 
3. Again, use the cursor cross, but this time select Type and 

press ENTER.  

Creating a new folder: 
1. In File Explorer, decide where you want to create a new 

folder. You can create folders at every level except at My 
Device. 

2. Press F2 and press ENTER on Edit. 
3. Use the cursor cross to move to New Folder and press 

ENTER. 
4. When you hear the prompt, “New Folder,” type in a name 

for the folder you have just created. 

Using the Find Feature 
1. Open the Start menu (F3), move to Find, and press 

ENTER.  
2. Enter the text, topic or subject you are trying to find 
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Tip:  If you have looked for this text before, press DOWN 
ARROW in the Find box and select the name from 
the list.  

3. In the Type combo box, use your cursor cross to narrow 
your search by selecting the appropriate item in the combo 
where you will find it.  

4. Press TAB to move to the Go button and press 
SPACEBAR.  

Press TAB to move to the Results list, use the cursor cross to 
select what you are looking for and then press ENTER on the to 
open it. 

Personalizing Your PAC Mate  
If you are a person who will be using your PAC Mate in public 
places, then this section will be important to you because it 
discusses how to personalize, password protect, and identify your 
PAC Mate.  

This section is also important if you want to purchase any of the off 
the shelf programs available for PAC Mate as it discusses how to 
locate hardware and software information.  

Entering Owner Information 
In addition to placing an identification card in the ID pocket of 
your carrying case, you can also enter this information in the 
Owner Information dialog of the PAC Mate. 

To do this, go to the Start Menu (F3) and press S (DOTS 2-3-4). 
This opens the Settings multi-page dialog. Use the ARROW 
keys to move to Owner Information and press ENTER (DOT 8) 
or press O (DOTS 1-3-5) for Owner Information and then press 
ENTER.  

When this dialog opens, the Identification page is active for you 
to enter your personal information. Place a check (SPACEBAR) 
in the “Show information when device is turned on” check box 
so that if you lose your PAC Mate, it may be returned to you.  
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If you want to add any additional information, press TAB (DOTS 
4-5 CHORD) until you hear, “Identification tab.” Now, use the 
RIGHT ARROW to move to the Notes tab. Type in the 
information you want to add and press the SPACEBAR to 
enable the check box if you want to display this information 
when the PAC Mate is on. Press ENTER to save the changes 
and close the dialog and then press F1 to return to the Today 
Screen. 

Protecting PAC Mate Information 
As you become familiar with PAC Mate and begin to truly use it 
as your personal data assistant, you may find that you are 
storing more and more personal or confidential information. For 
example, names and phone numbers of important contacts, 
credit card numbers, and work or school related documents. To 
protect you from data theft, your PAC Mate allows you to 
password protect your information.  

Go to the Start Menu (F3), move to Settings and press ENTER 
or just press S (DOTS 2-3-4). Use the cursor cross to move to 
Password or just press P (DOTS 1-2-3-4) and then ENTER.  

On the Password Settings dialog, use the cursor cross to select 
one of the three radio button password options you would like to 
use; no password, 4 digit, or alphanumeric.  

To type the password, press TAB twice to move to the edit box 
and, if necessary, confirm the password. It is helpful to record 
this password and store it elsewhere for safekeeping. 

Note:  If you choose to use an alphanumeric password it 
must be at least seven characters long and contain 
a combination of uppercase and lowercase letters, 
numerals, or punctuation. Press and hold DOT 7 to 
type uppercase letters. 

Next, press SHIFT+TAB to select how long your PAC Mate 
must be idle before the password is required to use it again. 
When you are done press ENTER, then F1 to return to the 
Today Screen. Now, when you turn your PAC Mate on it will 
require the password to access it. 
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Caution:  If you forget your password, you must perform a 
hard reset to clear the memory before you can 
access your PAC Mate. This erases all files and data 
you have created and programs you have installed. 
For this reason, it is recommended that you use 
ActiveSync to create a backup file of all of your 
programs and data so they can be restored.  

Locating the PAC Mate Serial Number  
The PAC Mate serial number identifies your PAC Mate in 
Freedom Scientific’s product database. This number, found in 
the center of the bottom surface, is printed and brailled. It may 
be helpful to record and store this number for safekeeping. 

Finding Firmware Information 
Anytime you call Freedom Scientific's Technical Support, you 
will need to have your serial number and other information 
available. This information is found in the Version Information 
dialog, which is accessed using the command Question Mark 
CHORD, A. 

Knowing About Pocket PC 
To learn more about your PAC Mate system go to the About 
multi-page dialog. Here you will find information on Pocket PC 
software version, processor type, memory amount, device ID, 
and Copyright notifications. 

To view this information, go to the Start Menu (F3) and press S 
to open the Settings multi-page dialog. Press SHIFT+TAB to 
move to the System tab, then press the RIGHT ARROW to 
move to Systems page. If About is not selected in the list view, 
press SPACEBAR, then A. If it is selected, press ENTER.  

When the About dialog first opens, you are on the Version page. 
PAC Mate will automatically read the contents of this page, 
which includes software version, processor, memory, expansion 
slot and owner information.  
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When you are done with this page press TAB to move to the 
Version tab and use the RIGHT ARROW to move to the Device 
ID tab. On this page there is a “Device name edit field” and a 
“Description edit field.” PAC Mate uses the Device name to 
identify itself when connecting to other computers. If you cannot 
connect to a network because another device is already 
connected using the same name, type a new name in this edit 
field. You may include a description to go with the identification. 

To read the copyright notice follow the steps above to move to 
the Copyright tab. 
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PAC Mate Basics  
Adjusting Speech Settings 

The Voice Settings dialog configures PAC Mate to speak the way 
that suits you best. There are three approaches you can take to 
adjust speech.  

The first approach uses general keyboard navigation.  

Go to the Start Menu (F3), and then press the UP ARROW three 
times to move to Settings. Press ENTER (DOT 8) and use the 
DOWN ARROW to select “Voice Settings.” Press ENTER again. 

This second approach uses first letter navigation.  

Press the Start Menu key, and then press S (DOTS 2-3-4) to open 
the Settings multi-page dialog. Next, press V (DOTS 1-2-3-6) twice 
to move to Voice Settings and press ENTER.  

As you can see the second approach is more direct and faster.  

When the Voice Settings dialog opens, the speech rate control is 
active. This is a slide control and requires that you use the LEFT 
and RIGHT ARROWS to increase or decrease the speech rate. To 
move forward to the next control, press TAB (DOTS 4-5 CHORD).  

The voices control is a combo box that allows you to choose from a 
selection of eight voices. With combo boxes, use the UP or DOWN 
ARROW keys to make your selection. You will hear the actual 
voice as you arrow through this list.  

Each time you move to a control, you should notice that JAWS 
indicates what type of control it is. For the voice pitch slide control, 
use the LEFT and RIGHT ARROWS to adjust the pitch to your 
liking. When you are done, press TAB to move forward to the next 
control. 

This control, Upper Case Pitch, is a little different than anything 
discussed so far. It is an edit box and when you pressed TAB to 
move to it, you should have heard JAWS say, “Upper Case Pitch 
increment edit twenty.” This means that the number twenty is the 
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increment that JAWS uses when it reads an upper case letter. To 
change the pitch, type in a new number using Computer Braille. 
When you are done, press TAB (DOTS 4-5 CHORD) to move to 
the next control. 

The last control in this dialog is the punctuation combo box. This 
control has four choices that you can use to control the amount of 
punctuation that you hear. They are none, some, most or all. Use 
the cursor cross to select your choice. When you are done, press 
ENTER (DOT 8) to return to the Settings Multi-page dialog. To exit 
the Settings dialog and return to the Today Screen, press F1. 

The third approach to adjust speech settings uses S CHORD, 
which you can press at anytime, in any program.    

Note:  If you adjust speech with S CHORD and later 
perform a warm reset (DOTS 1-2-3-4-6-7-8 CHORD) 
or refresh the screen (F1 CHORD), your speech 
settings will revert to the previous adjustments made 
from the Settings dialog.  

The commands introduced here are called layered commands 
because you only have to press S CHORD once to have all the 
speech parameters settings available. For example, press S 
CHORD, then use the cursor cross to adjust the voice rate and 
volume. When you are done, press P until you set the punctuation 
to the level you want, etc. To move out of settings, press TAB. To 
read more information on layered commands, please see PAC 
Mate Basics, Understanding Layered Commands. 

The table below lists all the commands used to adjust speech. 

Description Command 
Increase Voice Rate S CHORD, RIGHT ARROW 

(DOTS 2-3-4 CHORD, RIGHT ARROW) 
Decrease Voice 
Rate 

S CHORD, LEFT ARROW 
(DOTS 2-3-4 CHORD, LEFT ARROW) 

Increase Volume S CHORD, UP ARROW 
(DOTS 2-3-4 CHORD, UP ARROW) 
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Decrease Volume S CHORD, DOWN ARROW 
(DOTS 2-3-4 CHORD, DOWN ARROW) 

Punctuation Level S CHORD, P 
(DOTS 2-3-4 CHORD, DOTS 1-2-3-4) 

Speech Output 
Level 

S CHORD, S 
(DOTS 2-3-4 CHORD, DOTS 2-3-4) 

Keyboard Echo S CHORD, K 
(DOTS 2-3-4 CHORD, DOTS 1-3) 

Grade 2 Braille S CHORD, G 
(DOTS 2-3-4 CHORD, DOTS 1-2-4-5) 

Understanding Layered Commands 
There are several types of keyboard combinations in the PAC 
Mate. Most key combinations are pressed once and released, and 
the command runs. 

There are also layered commands. These are layered key 
combinations, where one set of keys is pressed and released, then 
another set of keys are pressed and released, and the command 
runs. For example, press I CHORD, T (DOTS 2-4 CHORD, DOTS 
2-3-4-5) to read the current window title. 

Repeating layered commands allow you to press the second key 
combination in the sequence multiple times. For example, press S 
CHORD, RIGHT ARROW to increase the speech rate. After 
pressing S CHORD (DOTS 2-3-4 CHORD), press RIGHT ARROW 
repeatedly until the speech rate you desire is reached. If you think 
it's too fast, press LEFT ARROW to decrease the rate. You don't 
have to press S CHORD again unless you pressed a key 
combination that is not assigned to the second layer for repeating 
commands that start with S CHORD. 

If you do press the first key combination in a layered command, 
followed by a key combination that is not assigned to the second 
layer, the PAC Mate plays a sound to indicate that the command is 
invalid. 
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The PAC Mate also provides help for Layered Commands. Press 
the first layer command sequence followed by QUESTION MARK 
to display a listing of all the commands in that layer. Move to a 
command in the list and press ENTER to activate the command. 
For example, press S CHORD, QUESTION MARK to list the 
settings commands. Adjust the speech rate and volume right from 
the list.  

Working with Text 
This section introduces you to PAC Mate’s Grade 2 Braille feature, 
explains how to read and manipulate text, lists all the associated 
commands and provides examples on the more frequently used 
actions performed with text. 

Brailling in Grade 2 
Currently, Grade 2 Braille is available in the following 
applications: FSEdit, Pocket Word and Pocket Outlook (i.e., 
Inbox, Contacts, Tasks, Calendar, Notes). For each new file 
created in an application, Grade 2 Braille must be enabled, as 
Computer Braille is the default in PAC Mate. 

Note:  If you want to write literary braille using Grade 1, you 
should enable Grade 2 and write using the rules for 
Grade 2. For example, single letters should be 
preceded by a letter sign (DOTS 5-6). 

Because FSEdit was developed to include Braille input and 
output, the Grade 2 Braille feature in FSEdit works differently 
than it does in Pocket PC applications. For more information on 
FSEdit and Grade 2 Braille, please see Using PAC Mate 
Programs, FSEdit. 

For Pocket Word and Pocket Outlook, pressing S CHORD, G 
enables Grade 2 Braille. But, unlike the other speech 
commands, this is not a repeating layered command, which 
means you can immediately begin brailling your text in the multi-
line edit field (i.e., a Pocket Word document). 

In edit fields where you can only type a single line of text, such 
as the To: or Subject: fields of an e-mail header or the 
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Appointment Information dialog of Calendar, you must type in 
computer Braille as the PAC Mate (with Tutor Messages 
enabled) announces, "Computer Braille only."  

Inserting Computer Braille into a Grade 2 File 
When writing in Grade 2, it is sometimes necessary to insert 
symbols so the text will be read or translated as Computer 
Braille. To mark the beginning of Computer Braille text, use 
DOTS 4-5-6, DOTS 3-4-6. To mark the end of the Computer 
Braille text, use DOTS 4-5-6, DOTS 1-5-6. 

Translating a Document 
To translate a file from one grade to another: 
1. Make sure the grade is set properly. If you have written 

text in Grade 2, press S CHORD, G and set the file to 
Grade 2.  

2. Press T CHORD to translate the file.  

Sharing Grade 2 Files 
Once your Grade 2 Braille document, message, or note is 
complete, you should translate to computer Braille before saving 
or synchronizing it. To translate, press T CHORD. Although T 
CHORD works for translating an e-mail message, the command 
SH CHORD, T is more convenient as it translates and sends the 
e-mail message. See Using PAC Mate Programs, Inbox for 
more information about creating or sending e-mail.  

Grade 2 back translation (T CHORD) is important because 
when you, your friend, or colleague opens an untranslated 
Grade 2 Braille file on an other device or desktop computer, the 
text is recognized and read as Computer Braille. Similarly, any 
e-mail or document composed in Grade 2 Braille that is sent to a 
friend or colleague who uses JAWS and/or a Braille display with 
Grade 2 translation enabled will read a Grade 2 translation of 
Grade 2 Braille.  

When working in Pocket PC applications that support Grade 2 
Braille it is important to remember that this feature has been 
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implemented for input convenience only. Thus, in situations 
where you are co-creating or co-editing a document with a 
colleague, it is recommended that when working on the PAC 
Mate BNS you use FSEdit as your word processor. 

Reading 
Depending on what you are trying to achieve, you may find 
reading by character, sentence or paragraph more suitable than 
reading with the Say All command (DOTS 4-5-6-8 CHORD). For 
instance, if you are trying to understand the syntax of a 
paragraph, you may want to read by line or by sentence. If you 
want to know how a word is spelled, you would want to read by 
character or press the command for “Spell Current Word” 
(DOTS 2-5 CHORD twice quickly). The table below lists all the 
reading/moving commands available on PAC Mate. 

Description Command 
Prior Character DOT 3 CHORD 

Next Character DOT 6 CHORD 

Current Character DOTS 3-6 CHORD 

Current Character Phonetic DOTS 3-6 CHORD twice quickly 

Prior Word DOT 2 CHORD 

Next Word DOT 5 CHORD 

Current Word DOTS 2-5 CHORD 

Spell Current Word DOTS 2-5 CHORD twice quickly 

Prior Line DOT 1 CHORD 

Next Line DOT 4 CHORD 

Current Line DOTS 1-4 CHORD 

Prior Sentence DOT 4+LEFT ARROW 

Next Sentence DOT 4+RIGHT ARROW 

Current Sentence DOT 4+LEFT+RIGHT ARROW 

Prior Paragraph DOT 1+UP ARROW 
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Next Paragraph DOT 1+DOWN ARROW 

Current Paragraph DOT 1+UP+DOWN ARROW 

Page Up DOT 2+UP ARROW 

Page Down DOT 2+DOWN ARROW 

Alternate Reading Commands 
Alternate reading commands use the arrow keys. LEFT and 
RIGHT ARROW move and read horizontally. LEFT ARROW is 
for prior, RIGHT ARROW is for next, and when pressed 
together read the current line. Press them alone for character, or 
add DOT 5 for word or DOT 4 for sentence. 

The UP and DOWN ARROW move and read vertically. UP 
ARROW is for prior; DOWN ARROW is for next, and when 
pressed together read the current line. Press them individually 
for line, add DOT 1 for paragraph, or add DOT 2 to move by 
page. 

File Edges 
Adding DOT 3 to your cursor cross movement lets you move to 
the edges of your document (i.e., beginning/end of the current 
line, or top/bottom of the file). Just press DOT 3 plus the arrow 
key that points in the direction you want to move. If you don't 
want to move the cursor, but want to read what's between that 
edge of the file and the cursor, add DOT 7 to the command. For 
example, DOTS 3-7+RIGHT ARROW reads to the end of the 
line. 

Below is a table that lists the commands used for moving about 
the edges of a text document. 

Description Command 

Move to Beginning of Line DOT 3+LEFT ARROW 

Move to End of Line DOT 3+RIGHT ARROW 

Move to Top of File DOT 3+UP ARROW 
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Move to Bottom of File DOT 3+DOWN ARROW 

Read from Beginning of Line DOTS 3-7+LEFT ARROW 

Read to End of Line DOTS 3-7+RIGHT ARROW 

Say All 
When you want to read text in its entirety without stopping, use 
the Say All command (DOTS 4-5-6-8 CHORD). With Say All, 
PAC Mate reads text from the point where you initiate the 
command to the end of the document or until you press the Stop 
Speech command (DOTS 6-8). During a “Say All” there are 
several commands you can use to move swiftly through the text 
you are reading. For example, you can press the LEFT or 
RIGHT ARROW to rewind or fast-forward through a document. 
In addition, you can decrease or increase the speech rate and 
volume. This table lists the commands available during a Say 
All. 

Description Command 

Say All DOTS 4-5-6-8 CHORD  

Rewind LEFT ARROW 

Fast Forward RIGHT ARROW 

Increase Speech Rate DOTS 4-8 

Decrease Speech Rate DOTS 1-8 

Increase Volume DOTS 5-8 

Decrease Volume DOTS 2-8 

Stop Speech DOTS 6-8 

Editing 
While there are many aspects to editing a document, this 
section focuses on the commands used to edit text and provides 
an example with their implementation.  
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First, it is helpful to know that while most programs have an Edit 
Menu from which you can select an action, the PAC Mate has 
its own keyboard commands. The table below lists PAC Mate’s 
editing commands, which can be used in any program.  

Description Command 
Undo E CHORD, U 

(DOTS 1-5 CHORD, DOTS 1-3-6) 

Cut E CHORD, X 
(DOTS 1-5 CHORD, DOTS 1-3-4-6) 

Copy E CHORD, C 
(DOTS 1-5 CHORD, DOTS 1-4) 

Paste E CHORD, P 
(DOTS 1-5 CHORD, DOTS 1-2-3-4) 

Select All E CHORD, A 
(DOTS 1-5 CHORD, DOT 1) 

Find E CHORD, F 
(DOTS 1-5 CHORD, DOTS 1-2-4) 

Find Next E CHORD, N 
(DOTS 1-5 CHORD, DOTS 1-3-4-5) 

Replace E CHORD, R 
(DOTS 1-5 CHORD, DOTS 1-2-3-5) 

Delete E CHORD, D 
(DOTS 1-5 CHORD, DOTS 1-4-5) 

Delete Current Word DOTS 1-2-3-4-5-6-8 CHORD 

Delete Prior Word DOTS 1-2-3-4-5-6-7 CHORD 

In many cases, any editing that you do requires that you select 
text.  

Example1: In the following two sentences, copy the word 
“stylus,” cut the word “pen” and then paste the word “stylus” in 
the place of “pen.”  

440060-001 Rev. A  27 



 

Do you have a pen?  

No, I have a stylus. 

If you typed these sentences into one of the word processing 
applications on your PAC Mate and then followed the directions, 
you would have had to select text twice. (Once to cut pen, and 
once to copy stylus.) 
1. Open FSEdit (F3, P, F, F, F, ENTER). 
2. In the Name edit field type: Example1 (to capitalize a letter 

press DOT 7). When done, press ENTER. 
3. Type the sentence: Do you have a pen? When you are 

done, press ENTER. Then type: No, I have a stylus. 
4. Press DOT 3 CHORD or LEFT ARROW to move left one 

character.  
5. Next, select the word, stylus, by pressing DOTS 2-7 

CHORD and copy it with E CHORD, C. 
6. Press the UP ARROW or DOT 1 CHORD to move up to 

the prior sentence. 
7. Press DOT 5 CHORD or DOT 2 CHORD until you hear 

the word “pen,” then press DOTS 5-7 CHORD to select 
pen or you can press DOTS 6-7 CHORD to select it by 
character so the question mark is not included. 

8. Now, press E CHORD, X to cut the word pen, then press 
E CHORD, P to paste the word stylus. 

The following two tables present all of the selecting commands 
available on PAC Mate. 

Selecting Commands 
Description Command 
Select Prior Character DOTS 3-7 CHORD 

Select to Next Character DOTS 6-7 CHORD 

Select Prior Word DOTS 2-7 CHORD 

Select to Next Word DOTS 5-7 CHORD 
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Select Prior Line UP ARROW CHORD 

Select Next Line DOWN ARROW CHORD 

Select Prior Sentence DOT 4+LEFT ARROW CHORD 

Select to Next Sentence DOT 4+RIGHT ARROW CHORD 

Select Prior Paragraph DOT 1+UP ARROW CHORD 

Select to Next Paragraph DOT 1+DOWN ARROW CHORD 

Select Page Up DOT 2+UP ARROW CHORD 

Select Page Down DOT 2+DOWN ARROW CHORD 

Read Selected Text DOTS 4-5-6-7-8 CHORD 

Alternate Selecting Commands 
Alternate selection commands are extensions of the alternate 
reading commands with the SPACEBAR added to make it a 
chorded command. For example, LEFT ARROW CHORD 
selects the prior character, and RIGHT ARROW CHORD 
selects to the next character. Add DOT 5 to select by word, or 
add DOT 4 to select by sentence. 

UP ARROW CHORD selects the prior line, and DOWN ARROW 
CHORD selects to the next line. Add DOT 1 to select by 
paragraph, or add DOT 2 to select by page. 

Selecting File Edges Commands 
Description Command 

Select to 
Beginning of Line 

DOT 3+LEFT ARROW CHORD 

Select to 
End of Line 

DOT 3+RIGHT ARROW CHORD 

Select to 
Top of File 

DOT 3+UP ARROW CHORD 

Select to 
Bottom of File 

DOT 3+DOWN ARROW CHORD 
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Alternate Selecting File Edges Commands 
The alternates for these selection commands are based on the 
notetaker reading commands. Just add DOT 7 to the equivalent 
reading command. DOTS 1-3-7 CHORD selects to the 
beginning of the line, and DOTS 4-6-7 CHORD selects to the 
end of the line. DOTS 1-2-3-7 CHORD selects to the top of the 
file, and DOTS 4-5-6-7 CHORD selects to the end of the file. 

Formatting  
Like the Edit Menu, many programs provide a Format Menu or 
dialog where you can change the appearance of text. But rather 
than use a menu or dialog, you should get familiar with PAC 
Mate’s keyboard formatting commands as they are quick and 
easy to use. The tables below list the formatting commands 
available on PAC Mate.  

Formatting Commands 
Description Command 
Bold F+DOT 8, B  

(DOTS 1-2-4-8, DOTS 1-2) 

Italic F+DOT 8, I  
(DOTS 1-2-4-8, DOTS 2-4) 

Underline F+DOT 8, U  
(DOTS 1-2-4-8, DOTS 1-3-6) 

Strikethrough F+DOT 8, S  
(DOTS 1-2-4-8, DOTS 2-3-4) 

Center F+DOT 8, C  
(DOTS 1-2-4-8, DOTS 1-4) 

Left Justify F+DOT 8, L  
(DOTS 1-2-4-8, DOTS 1-2-3) 

Right Justify F+DOT 8, R  
(DOTS 1-2-4-8, DOTS 1-2-3-5) 
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Set Font F+DOT 8, F CHORD 
(DOTS 1-2-4-8, DOTS 1-2-4 CHORD)

Uppercase 
Description Command 
Caps Lock On U CHORD, U 

(DOTS 1-3-6 CHORD, DOTS 1-3-6)

Caps Lock Off U CHORD, L 
(DOTS 1-3-6 CHORD, DOTS 1-2-3)

Inserting Information 

Description 
Command 
DOT Pattern 

Insert Date and Time I+DOT 8, D 
(DOTS 2-4-8, DOTS 1-4-5) 

Insert Numbering I+DOT 8, N 
(DOTS 2-4-8, DOTS 1-3-4-5) 

New Paragraph DOT 8 pressed twice 

Much of the process used to format text is similar to the process 
involved in editing text.  

Example2: Center the following word “pac mate.” Capitalize p, a, 
c and m. Then bold the whole word.  
1. Open FSEdit (F3, P, F, F, F, ENTER). 
2. In the Name edit field type: Example2 (to capitalize a letter 

press DOT 7). When done, press ENTER. 
3. Type the word: pac mate.  
4. Press F+DOT 8, C to center the word. (There is no need 

to move to the beginning of the word to center it.) 
5. Press the LEFT ARROW or DOT 3 CHORD to move left 

by character. Stop when you hear the letter “a.”  
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6. Then select to the beginning of the line with DOT 3+LEFT 
ARROW CHORD.  

7. Next, press U CHORD, U to change p, a, c and m to 
uppercase. 

8. Now, press DOT 3+LEFT ARROW, and DOT 3+RIGHT 
ARROW CHORD. This moves you to the beginning of the 
line so you can select all the text to the end of the line. 

9. Last, to make everything bold, press F+DOT 8, B. (To 
unselect PAC Mate, press the cursor cross.) 

Now, that you have created a title for your document, you are on 
your way to writing its content. When you press ENTER to start 
your first sentence, it will be centered. To left justify, press 
F+DOT 8, L. 

Embossing 
Embossing a document can be done only in the FSEdit 
program. This section covers only the basics of embossing. For 
more information on this topic, please see FSEdit, Embossing a 
Document.  

Embossing is initiated from FSEdit’s Emboss dialog. To open 
the Emboss dialog you must open the File Menu (SH CHORD, 
F) (DOTS 1-4-6 CHORD, DOTS 1-2-4) and select Emboss (E) 
(DOTS 1-5). With the Emboss dialog open, you have several 
controls that allow you to change the way your document is 
embossed. If you do not want to change any of the parameters 
and are ready to emboss, press ENTER.  

Printing  
Currently, all PAC Mate documents must be synchronized and 
printed with your desktop or laptop computer and printer. For 
more information on synchronizing documents, please see 
Connecting the PAC Mate, Connecting to a PC with ActiveSync. 

For printing .brl files as text files, please see FSEdit, Printing in 
FSEdit. 
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Adding Programs 
Before you purchase an off-the-shelf program for your PAC Mate, 
make sure JAWS supports it and that it is compatible with the 
Pocket PC 2002 platform and your PAC Mate’s processor. For 
more information on the processor, please see Personalizing Your 
PAC Mate, Knowing About Pocket PC.  

Any application that you want to add to your PAC Mate must be 
installed using ActiveSync and your computer. For more 
information on ActiveSync, please see Connecting the PAC Mate, 
Connecting to a PC with ActiveSync  

Before you can add a program to PAC Mate, you must install it on 
your PC. You do not need to be connected or have a partnership 
established. After you install the program, it remains on your PC in 
ActiveSync so you can add or remove it from your PAC Mate when 
needed.  

If you have yet to make a connection between your PAC Mate and 
your PC and only want to add or remove programs, establish a 
guest partnership in ActiveSync. If you want to synchronize and 
add or remove programs, establish a standard partnership.   

With a guest partnership, the Add/Remove Programs dialog 
automatically launches to your PC desktop where you can check 
the box next to the program(s) you want added to your PAC Mate. 
With a standard partnership, you go to the Tools Menu (ALT+T) in 
ActiveSync on your PC and select Add/Remove Programs. Once 
you have checked the program(s) you want to add, press TAB to 
move to the OK button and press ENTER to close the dialog. 

Note:  Any listed program that does not have a check in the 
box is removed from PAC Mate. 

If additional installation is required, installation dialogs will 
automatically open on your PAC Mate and step you through the 
rest of the process.  
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Removing Programs 
Programs that come with your PAC mate cannot be removed. Only 
programs that you install can be removed.  

There are a couple of ways to remove programs from your PAC 
Mate. The easiest way is to use the Add/Remove Programs dialog 
in ActiveSync on your PC. This dialog lets you remove any 
applications you are not currently using, but because they remain 
on your PC, you can re-add them to your PAC Mate at anytime.  

To remove programs, establish a partnership in ActiveSync. With 
ActiveSync open on your PC desktop, go to the Tools Menu 
(ALT+T) and select Add/Remove Programs from the menu. In the 
Add/Remove Programs dialog, uncheck the box next to the 
program(s) you want removed from your PAC Mate. Once you 
have unchecked the program(s) you want removed, move to the 
OK button and press ENTER. The program(s) are automatically 
removed from your PAC Mate. 

Note:  Any listed program that has a check in the box 
remains on PAC Mate. 

The second way to remove programs installed is to use the 
Remove Programs dialog on your PAC Mate. To do this, go to 
Settings on the Start Menu and press ENTER (DOT 8). Press 
SHIFT+TAB (DOTS 1-2 CHORD) until you hear, “Personal tab.” 
Then use the RIGHT ARROW to move to the System tab. Next, 
press TAB (DOTS 4-5 CHORD) once, then press R (DOTS 1-2-3-
5) twice to move to Remove Programs and press ENTER.  

On the Remove Programs dialog use the DOWN ARROW to select 
the program(s) you want removed. Press TAB to move to the 
Remove button and press SPACEBAR. 
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PAC Mate Hardware 
The PAC Mate has buttons and keys on the top, ports and 
switches on the sides, and the battery in the back. The overall size 
of the PAC Mate is 5.4 inches x 9.75 inches x 1.25 inches and 
weighs 1.5 lbs. 

Ports and Switches 
On the right edge of the PAC Mate, near the front is the PC card 
slot for I/O devices. Behind this is the On/Off switch. On the left 
end of the unit, from front to back, are the compact flash slot, the 
nine-pin serial port, the USB port, and the AC adapter jack. Above 
the compact flash slot are two audio jacks. The one nearest the 
front of the unit is a 1/8th inch audio output jack, and behind that is 
a 1/16th inch audio input jack. On the back of the unit is the 
removable battery pack, which takes up most of the space along 
the back. On the left side of the battery pack is the infrared port. 

There is a reset button inset on the bottom of the PAC Mate. To 
find the reset button, place your index finger near or on the On/Off 
switch and turn the PAC Mate bottom side up. Next to the rubber 
pad, closest to the On/Off switch, is a raised round ridge with a 
hole in its center. This is the reset button. 

Caution:  The reset button erases all data and deletes all 
programs. For more information, please see PAC 
Mate Hardware, Resetting the PAC Mate. 
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Note:  PC cards must be inserted label side down. 

Compact Flash cards must be inserted label side up. 

Both the compact flash and PC card plug into the PAC Mate in 
one direction only. If you insert the card(s) the wrong way, 
simply remove the card, turn it over and gently reinsert the 
card(s). Never push or jam the card. When you correctly insert 
the card(s), you can feel it gently plug into place. 

To remove the compact flash card, grasp and pull the card with 
your index finger and thumb. To remove the PC card, push the 
button that is next to the PC card slot. You can find this button 
only when a PC card is inserted into its slot and by running your 
index finger along the right side of the unit, feeling for a cut 
away in the plastic. The button is in line with the PC card and is 
near the front of the unit. 

 

 

36 440060-001 Rev. A 



 

 

Battery 
The PAC Mate is powered with a lightweight, high-density lithium 
ion battery that, with continuous use, holds its charge for 12 hours. 
It may be charged repeatedly and at any time within the battery 
cycle without losing capacity. When the battery has only 20% of its 
charge remaining, the PAC Mate announces a warning that the 
battery is low. At 12% of battery life, the PAC Mate alerts you that 
the battery is critically low and after 2 minutes the PAC Mate will 
automatically turn off. Once the battery charger is connected, the 
battery takes approximately 4 hours to recharge. You can work 
with your PAC Mate while your battery is recharging without 
harming the unit. When you get ready to charge your PAC Mate, 
you must charge the battery with the AC adapter supplied with 
the unit.  When you switch battery packs, you should turn your 
PAC Mate off, insert the new battery pack, and then turn your PAC 
Mate on.  

To remove your battery pack, turn the PAC Mate bottom side up so 
that the battery pack is farthest away from you. Next, use your 
thumbs and feel for the spring-loaded buttons on either end of the 
battery. To disengage the battery, push these buttons towards 
each other or towards the center of the battery using your thumbs. 
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Then with the buttons held in this position, slide the battery out of 
its compartment.  

 
Warning:  To prevent data loss, do not remove the battery and 

the AC power source at the same time, as the life of 
the backup battery is approximately 30 minutes.  

Inserting the battery is easier as it fits into its compartment one way 
only. Once you have it positioned correctly, the battery slides in 
easily with two positive clicks. 

For convenience, the Today Screen indicates the percentage of 
battery charge available. To refresh the Today Screen so that it 
reflects the most current battery charge, press F1 CHORD.  For 
more information, please see PAC Mate Hardware, Power 
Management. 

If you own a spare battery pack we recommend that you store it in 
a dry place away from heat or direct sunlight. 

Power Management 
Whenever possible, use your PAC Mate with the AC adapter 
plugged to external power, especially when connecting to a PC, 
using a compact flash card, a modem or other peripheral. This will 
save your battery for those situations when you are mobile and 
away from a power source. 

Regardless of whether you are using an external power source or 
battery, you can conserve the amount of energy your PAC Mate is 
using by enabling the controls available to you in the Power 
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Settings dialog. There are two ways to access this dialog. The 
easiest way is to move down and press ENTER on the last of the 
five items on the Today Screen, which indicates the battery charge. 
The other way is from the Start Menu. 

From the Start Menu (F3), move to Settings and press ENTER 
(DOT 8). Press SHIFT+TAB (DOTS 1-2 CHORD) until you hear, 
“Personal tab.” Then, use the RIGHT ARROW to move to the 
System tab. Now, press TAB (DOTS 4-5 CHORD) once to move 
onto the page and press P (DOTS 1-2-3-4) to select Power. With 
Power selected press ENTER.  

With the Power Settings dialog open, press TAB to move to the 
“On battery power: Turn off device if not used for” check box. Press 
the SPACEBAR to enable this control, then move to the 
associated combo box to select the number of minutes. Follow this 
same procedure for the next control, which turns PAC Mate off 
when using external power. For additional information on the PAC 
Mate battery, please see PAC Mate Hardware, Battery and 
Appendix B: Special Considerations, Lithium Ion Battery. 

Resetting the PAC Mate  
Occasionally it may be necessary for you to reset your PAC Mate. 
Particularly, if it is operating slow and sluggish or if it stops 
responding completely. If this occurs often, contact Freedom 
Scientific's hardware technical support. However, if this occurs 
infrequently, perform the following to get your PAC Mate running 
without delay. 

Performing a Warm Reset  
A warm reset does not affect your files, programs or settings. 
Instead, it closes all running applications and returns you to the 
Today Screen. To perform a warm reset, press DOTS 1-2-3-4-6-
7-8 CHORD (i.e., every key except 5). 

Performing a Hard Reset 
A hard reset should be used only as a last resort as this erases 
all files and data you have created and programs you have 
installed. For this reason, it is recommended that you use 

440060-001 Rev. A  39 



 

ActiveSync to create a backup file of all of your programs and 
data. For more information on using ActiveSync, please see 
Connecting the PAC Mate, Connecting to a PC with ActiveSync.  

To find the reset button, place your index finger near or on the 
On/Off switch and turn the PAC Mate bottom side up. Next to 
the rubber pad, closest to the On/Off switch, is a raised round 
ridge with a hole in its center. This is the reset button. To reset 
your PAC Mate, use a straightened paper clip or a toothpick and 
press down gently. You should feel the button move slightly as 
you press.  

Carrying Case 
To use the carrying case, locate the front of the case by feeling for 
the Freedom Scientific logo on the lower right front of the case. 
Across the top of the case are two rows of Velcro, the first is for the 
case cover, while the second Velcro fastening can be opened to 
allow you to slide the PAC Mate inside.  

Turn the PAC Mate with the battery down and slip it into the case 
with the keypad side to the front of the case.  

Locate the strap for the case and connect each end to the rings at 
the bottom corners of the PAC Mate.  

Close the Velcro opening securely.  

Now open the front flap of the case. There is access to each of the 
connections through the top and sides of the case. On the front 
flap’s exterior there is a zippered pocket and on the flap’s interior is 
a pocket to slide in your ID card. 

General Care of PAC Mate 
The plastic body of PAC Mate is made of a blend of high impact 
polycarbonate and heat resistant polymers that meet strict 
environmental standards. In order to keep your PAC Mate in good 
working condition, it is recommend that you store your unit in a dry 
place away from direct sunlight, avoid operating the unit around 
liquids or food, and always operate the unit with clean, dry hands. 
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Clean the unit with a dry cloth and do not use commercial cleaners 
on any part of the unit. 

Never use the PAC Mate in an environment where it will be 
exposed to extremes of light, temperature, moisture or vibration. 
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Setting Up PAC Mate 
PAC Mate allows you to modify many settings that determine what 
and how much information JAWS reads. In addition: you can set 
alarm notifications, choose to read time in different formats, select 
what programs appear in the Start Menu and in the Programs 
submenu, and customize the Today Screen to view only those item 
you want. 

Verbosity  
Use the JAWS Verbosity dialog to set JAWS verbosity levels: 
Beginner, Intermediate, or Advanced. This determines how much 
information JAWS speaks.  

Go to the Start Menu (F3), move to Settings. When you press 
ENTER (DOT 8) on Settings you are in the Settings dialog on the 
Personal page list view. If nothing is selected, first press the 
SPACEBAR. Once an item is selected you can use first letter 
navigation. Press V (DOTS 1-2-3-6) once or use the cursor cross 
to move to Verbosity Settings. Once you have found it, press 
ENTER. 

With the JAWS Verbosity Settings dialog open, use the cursor 
cross to select the Verbosity Level. Move to the Preferences button 
with the TAB command and press SPACEBAR. This opens the 
Preferences dialog, where you can choose how much information 
JAWS speaks. Press TAB to move about the dialog. Use the 
SPACEBAR to check the boxes next to the type of message you 
want to hear. In the Message Length combo box, use the cursor 
cross to select long or short. If you want to restore the default 
settings, move to the Restore Default Settings button and press 
SPACEBAR. To close the Preferences dialog and save the 
settings, press ENTER.  

Before you exit out of JAWS Verbosity Settings, there are two more 
controls in this dialog that you should know about. They are the 
Tutor Messages and the Access Key Messages. These check 
boxes are checked by default. Tutor Messages provide 
navigational tips, while Access Key Messages provide information 
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on the access key that moves you directly to a control or to an item 
in a menu. If you prefer to disable this additional verbosity, use the 
SPACEBAR and uncheck these controls. 

If you want to continue adjusting features on your PAC Mate, return 
to the Settings dialog by pressing ENTER (DOT 8) and use first 
letter navigation or the cursor cross to move through the list view. 

To escape the Settings dialog, press F1.  

Text 
Use the Text Settings dialog to set preferences for how the Say All 
command (DOTS 4-5-6-8 CHORD) works. 

To use this dialog, go to the Start Menu (F3), move to Settings. 
When you press ENTER on Settings you are on the Personal page 
list view of the Settings multi-page dialog.  

If nothing is selected in the list view, press the SPACEBAR. If an 
item is selected when you first open the Settings dialog, press T 
once or use the cursor cross to move to Text Settings, then press 
ENTER.  

With the Text Settings dialog open, use the cursor cross to make a 
selection in the Say All combo box. Your choices in this box are: 

• Line with Pauses: This option reads by line, pausing slightly 
at the end of each line.  

• Line without Pauses: This option allows for smoother 
reading.  

• Sentence: Select this option for applications in which Say All 
sounds choppy. This moves the pauses between elements to 
the ends of sentences, and makes the reading sound 
smoother.  

• Paragraph: This option is very useful in large documents as 
you can press DOTS 5-6 CHORD to quickly move through 
the paragraphs without needing to interrupt Say All.  

As you move forward (TAB) in this dialog you arrive on the Say 
Blank Lines check box, use the SPACEBAR to check it if you want 
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blank lines announced when using the Say All command. This 
control is unchecked by default. 

If you want JAWS to speak numeric dates in a different format, use 
the Numeric Date Processing combo box to select a format. Your 
choices are: 

• No Translation: If this option is selected, numeric dates are 
read as numbers. This option is selected by default.  

• Some Translation: If this option is selected, numeric dates 
of month followed by day followed by year and separated by 
slashes or dashes are translated. For example, 03-16-00 is 
read as "March sixteenth two thousand."  

• Full Translation: If this option is selected, numeric dates of 
month followed by day and separated by slashes or dashes 
are translated in addition to those dates translated with Some 
Translation selected. For example, 03-16 is read as "March 
sixteen."  

Use the TAB command again to move to the Number Processing 
combo box. This combo box allows you to determine how numbers 
are read. Use the cursor cross to make your selection. Your 
choices are: 

• Digits: If this option is selected, numbers are read as a 
series of single numbers. For example, 123 is read "one two 
three."  

• Pairs: If this option is selected, numbers are read as a series 
of paired numbers. For example, 1050 is read as "ten fifty." If 
the number has an odd number of digits, the first digit is read 
as a single digit and the rest are paired. For example, 123 is 
read "one twenty three."  

• Whole Numbers: If this option is selected, numbers are 
always read as complete numbers. For example, 123 is read 
as "one hundred twenty three." This is the default option.  

The next control in this dialog is called Mixed Case Processing. 
This control causes JAWS to speak words that are joined together 
with capital letters, such as SayAll, as two words. This check box is 
enabled by default. To disable, use the SPACEBAR. 
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Immediately after the Mixed Case Processing check box, is the 
Speak Dollars check box. With this check box enabled, JAWS 
reads numbers preceded by a dollar sign ($) in the format of 
number of dollars and number of cents. For example, $9.95 is read 
as "nine dollars and ninety five cents." For monetary values less 
than a dollar, type a zero to the left of the decimal. For example, 
$0.02 is read as "two cents." This check box is disabled by default.  

To close this dialog, press ENTER (DOT 8). If you want to explore 
the other pages in the Settings dialog, press SHIFT+TAB (DOTS 
1-2 CHORD) until you hear, “Personal tab,” then RIGHT ARROW 
to the other pages. 

Format  
There may be times when you will find it necessary to know how a 
document is formatted, particularly if you are editing a document. 
For instance, a bibliography requires book and article titles. It 
includes authors, publishers and dates, which all require different 
attributes such as italic, underline, capitalization and indentation. 
With PAC Mate, you can enable these items in the Format Settings 
dialog.  

To use the Format Setting dialog, go to the Start Menu (F3), move 
to Settings and press ENTER. When you open the Settings dialog 
you are on the Personal page list view of the Settings multi-page 
dialog. If nothing is selected in the list view, press the SPACEBAR. 
If an item is selected when you first open the Settings dialog, press 
F and ENTER to open Format Settings.  

When you open Format Settings, you will hear PAC Mate say, 
“JAWS Format Settings dialog, speak text formatting check box, 
not checked.” Before you can enable any item in this dialog, you 
must enable this check box with the SPACEBAR. After, the 
following items can be enabled: 

• Attributes: Enable this check box if you want PAC Mate to 
announce when text is bold, italic, or underlined.  

• Font: Enable this check box if you want PAC Mate to 
announce the font name (such as Arial or Times New 
Roman). 
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• Point Size: Enable this check box when you want PAC Mate 
to announce text point size.  

• Capitalization: If this check box is checked, capitalized 
letters are indicated. PAC Mate says "cap" to indicate one 
character is capitalized, and "all caps" to indicate an entire 
word is capitalized.  

• Indented Characters: If this check box is checked, changes 
in indentation are indicated. PAC Mate announces the indent 
in pixels from the left side of the window.  

• Repeat Characters: Enable this check box to have PAC 
Mate filter out repeating characters, such as dashes or stars. 
To choose how many times you want to hear a character 
spoken, move to the combo box that accompanies this 
control. Your options are: Three, Four, Five, Six, All. Three is 
the default. 

When you are done with this dialog, press ENTER to return to the 
Settings dialog where you can continue adjusting other features of 
your PAC Mate. Remember, since JAWS Format Settings is 
already selected, you can use first letter navigation or the cursor 
cross to move through the list view. 

To escape the Settings dialog, press F1.  

HTML  
This dialog controls the way PAC Mate reads pages written in html. 
If you intend to browse the web, getting familiar and understanding 
this dialog is imperative.  

Go to the Start Menu (F3), move to Settings and press ENTER. 
When you open the Settings dialog, you are on the Personal page 
of the Settings multi-page dialog. If the Settings dialog opens with 
one of the thirteen items selected in the list view, press H once to 
select HTML Settings or use the cursor cross to select it. If an item 
is not selected, press SPACEBAR first, and then use first letter 
navigation. Once HTML Settings is selected, press ENTER.  

When you open HTML Settings, you will hear PAC Mate say, 
“JAWS HTML Settings dialog, Skip Past Repeated Text On New 
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Pages check box, checked.” With this control checked, PAC Mate 
skips text that is repeated on web pages within the same web site 
and automatically moves the cursor to new text found on the page.  

When you press TAB to move forward, the next control you 
encounter is the “Lines Per Page” edit field. This setting determines 
how many lines the cursor moves when pressing PAGE UP (DOT 
2+UP ARROW) or PAGE DOWN (DOT 2+DOWN ARROW). With 
the default value set to twenty-four, the cursor moves twenty-four 
lines. For more information on moving through and reading text, 
please see PAC Mate Basics, Working with Text. 

The next control is the “Maximum Line Length” edit field, which 
controls how many characters the cursor treats as one line of text. 
The default value is 150 characters.  

Headings are used to understand how each section of text relates 
to the web page as a whole. Press TAB to move to the “Headings 
Verbosity” combo box. With the Headings Verbosity combo box, 
use the cursor cross to choose whether PAC Mate announces 
headings and whether this includes heading levels. The default 
setting is Headings with levels indicated. 

Many web sites use Graphics as links. If you want PAC Mate to 
announce only graphical links that use alternate text, use the 
cursor cross to select Tagged Graphical Links in the Graphical Link 
Verbosity combo box.  

In addition to graphical links, frames are another web structure you 
will encounter. To control how PAC Mate responds to frames, 
choose one of the three options in the New Frame Indication 
combo box. Your options are:  

• No Indication: PAC Mate does not indicate when frames are 
entered or exited. 

• Say Frame Name: PAC Mate announces the frame name 
when it is entered or exited. This is the default option. 

• Say New Frame: PAC Mate announces when a frame is 
entered only. 

If you want to continue with adjusting HTML settings, press TAB to 
move to the Advanced button and press SPACEBAR. If you are 
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done with this dialog, press ENTER to return to the Settings dialog. 
Press F1 to return to the Today Screen.  

Advanced HTML Settings 
When you press SPACEBAR on the Advanced button in the 
JAWS HTML Settings dialog, you open the HTML Advanced 
dialog. The first three controls in this dialog are check boxes, 
which are checked by default. To uncheck the boxes, press the 
SPACEBAR.  

The first check box of this dialog is the “Say Link Type” check 
box, which sets PAC Mate to announce the type of links 
encountered when navigating an HTML document. To move to 
the next control, press TAB. 

With the “Identify Same Page Links” check box checked, PAC 
Mate announces when links point to other locations on the same 
page by stating, "same page link."  

The “Indicate Tables” check box sets PAC Mate to announce 
the start of a table by declaring its number of columns and rows 
and when the end of the table is reached. To move to the next 
control, press TAB. 

The “Text Block Length” edit box lets you specify the number of 
characters in a block of text. This control affects the H CHORD, 
T command used in Pocket Internet Explorer. When you press 
this command, PAC Mate moves to the next block of non-link 
text that is equal to or greater than the number of characters 
specified in this edit box. The default value is 25. 

The “Text Link Verbosity” combo box determines what 
information PAC Mate speaks when a text-based link is 
encountered. The following options are available: 
• Speak Title Text: When this option is selected, PAC Mate 

speaks information provided by the HTML title attribute, 
which is not displayed on the screen. If no title text is found, 
PAC Mate reads the on-screen text. 

• Speak Screen Text: PAC Mate reads the on-screen text of 
the link only. This is the default option. 
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• Speak Longest: PAC Mate reads the longer string of text 
whether it is the on-screen text displayed as a link or a title 
tag attribute. This option is meant to provide you with the 
most information possibly available on an HTML page. 

To move to the next control, press TAB. 

Similar to the “Text Link Verbosity” combo box, the “Graphic 
Verbosity” combo box allows you to specify how you want PAC 
Mate to announce graphics within HTML documents. The 
following options are available: 
• No Graphics: Graphics are not announced. 
• Tagged Graphics: Graphics that have alternate text 

specified within the HTML document are announced. PAC 
Mate states "graphic" and then reads the alternate text. This 
is the default option. 

• All Graphics: All graphics are announced. 

The last control in this dialog is the “Image Map Link Verbosity” 
combo box. This control determines how images, mapped with 
coordinates for use as links, are announced. PAC Mate offers 
the following options: 
• No Image Map Links: Image map links are not announced. 
• Tagged Image Map Links: Image map links that have 

Alternate text specified within the HTML document are 
announced. 

• All Image Map Links: All image map links are announced. 
This is the default option. 

If you are done, press ENTER twice to return to the Settings dialog. 
Then press F1 to return to the Today Screen. 

Keyboard 
When you want to adjust the amount of feedback you receive as 
you type in an edit field, use the “JAWS Keyboard Settings” dialog.  

To use this dialog, go to the Start Menu (F3), press S to open the 
Settings dialog. The Settings dialog opens to the Personal page of 
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a multi-page dialog. A list view of thirteen items is the first control 
on this page. 

If nothing is selected in the list view, press the SPACEBAR. If an 
item is selected when you first open the Settings dialog, press K 
once or use the cursor cross to move to Keyboard Settings, then 
press ENTER.  

When you open this dialog, the “Typing Echo” combo box is active 
and ready for you to use the cursor cross to select an option. Your 
options in this combo box are:  

• Off: PAC Mate is silent as you type.  
• Characters: Each character you type is echoed.  
• Words: Each word you type is echoed after pressing 

SPACEBAR or ENTER.  
• Characters and Words: Characters are echoed as you type 

them and words are echoed after you press SPACEBAR or 
ENTER. 

When you are done making your selection, press TAB to move to 
the next control. 

Tip:  You can also change these options with S CHORD, 
K. Continue to press K until you select the option 
you want.  

The next two controls, “Typing Interrupt” and “Reading Interrupt,” 
stop speech when typing or reading keys are pressed. These two 
controls are enabled by default. To disable either control, press the 
SPACEBAR. 

To save your settings and return to the Settings dialog, press 
ENTER. To close the Settings dialog and return to the Today 
Screen, press F1. Or if you want to explore the other pages in the 
Settings dialog, press SHIFT+TAB until you hear, “Personal tab,” 
then RIGHT ARROW to the other pages. 

Today  
Use the Today dialog to change the items and their information 
listed on your Today Screen.  
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To use the Today dialog, go to the Start Menu (F3), move to 
Settings and press ENTER. Next, press the SPACEBAR once to 
activate the Settings list view on the Personal page. From there, 
press T twice and ENTER to open the Today dialog.  

Note:  When the Today dialog opens, PAC Mate 
announces “Today dialog, Appearance page.” This 
page allows you to change the Appearance of 
Pocket PC’s user interface and is unsupported in 
PAC Mate.  

Press SHIFT+TAB until you hear “Appearance tab,” then press the 
RIGHT ARROW to move to the Items tab. From the Items tab, 
press TAB to activate the Items page. Use the cursor cross to 
move up and down the list of items and press the SPACEBAR to 
check or uncheck the associated boxes.  

You can rearrange the order in which the items appear on the 
Today Screen. Use the cursor cross to move to each item in the list 
view. Press TAB to see which of the three buttons, the Move 
Down, Move Up, and Options, become available for each item. Use 
the SPACEBAR to activate the buttons. The Options button lets 
you alter the information that is displayed for Calendar and Tasks. 

To save your settings and return to the Settings dialog, press 
ENTER. To close the Settings dialog and return to the Today 
Screen, press F1. 

Input 
While this Settings dialog has limited support, it does contain two 
controls that may be beneficial for you to know about. The first 
control is the “Voice Recording Format” combo box. The settings in 
this combo box determine the quality of your voice recording. The 
default setting is 8000 Hz, Mono (2 KB/s), which gives you the 
longest possible recording time, but with the least amount of 
recording quality. Naturally, Pocket PC offers you a wide variety of 
settings to choose from. To learn more about the Voice Recording 
Feature, please see Using PAC Mate Programs, Creating a 
Recording. 
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The second control in this dialog is the “Capitalize first letter of 
sentence" check box. With a check in this box, anytime you press 
ENTER to start a new line in an edit field, the first letter of the line 
is capitalized. This control works only with Pocket PC programs. 

To access these controls, go to the Input dialog (F3, S, I, ENTER) 
and move over to the Options page with CTRL+TAB. As the page 
opens the first active control is the “Voice Recording Format” 
combo box. Make your selection using the arrow keys and then 
press TAB until you reach the “Capitalize the first letter of 
sentence” check box. Use the SPACEBAR to disable or enable 
this control. 

Memory  
When a program becomes unstable or when program memory is 
low, the first step to take is to free memory manually by stopping 
any active programs on your PAC Mate.  

To do this, open the Settings dialog from the Start Menu (F3, S). 
Press CTRL+TAB until you hear, “System page,” then press M, 
ENTER to open the Memory multi-page dialog. Next, move to the 
Running Programs page (CTRL+TAB). Select the Program(s) in 
the list using the DOWN ARROW. Last, move to (TAB) and 
activate (SPACEBAR) either the Stop button or Stop All button. 

The second step would be to store files on a compact flash card. 
Press F3, move to Programs and press ENTER. Move to File 
Explorer and press ENTER again. Select the file with the DOWN or 
UP ARROW, or select multiple files with DOWN or UP 
ARROW+SPACEBAR. Next, press F2 CHORD and from the 
context menu, choose Cut and press ENTER. Press F2, use the 
DOWN ARROW to select Flash Disk and press ENTER. With 
Flash Disk open, press F2 CHORD again, choose Paste and press 
ENTER. For more information on working with File Explorer, please 
see Using Windows CE with PAC Mate, Using File Explorer. 

If the first two steps do not free enough memory, the third step 
would be to delete unnecessary files. In File Explorer, choose a 
file(s), press F2 CHORD, and select Delete.  
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To find and delete your largest files, Go to the Start Menu (F3) and 
choose Find. Press TAB to move into the Type combo box, and 
select Larger than 64 KB, then press SPACEBAR on the Go 
button.  

In Internet Explorer, delete all files and clear history.  

The last step would be to remove the programs you are not 
currently using. For more information on removing programs, 
please see PAC Mate Basics, Removing Programs.  

System Sounds & Notifications  
The Notification System on PAC Mate is controlled from the 
Sounds & Notifications settings dialog. In this dialog, you can 
choose what events you'd like to receive notifications for, and how 
you'd like to be notified.  

Note:  PAC Mate does not support pop-up screen display 
notifications or screen taps. 

You open the Sounds & Notifications dialog from the Settings list 
view on the Personal page. To quickly move to the Sounds & 
Notification dialog from the Today Screen, press F3, S. If the list 
view on the Settings dialog is active, press another S.  

If you open the Settings multi-page dialog and the Personal tab is 
active, press TAB once to move onto the Personal page and then 
press the SPACEBAR to select an item in the list view. Once an 
item is selected in the list view, use first letter navigation.  

The Sounds & Notifications dialog opens on the Volume page with 
the system volume control active. This particular control is a 
left/right slider, which you adjust with the LEFT and RIGHT 
ARROWS. After you press TAB to move forward, the next control 
is the “Enable sounds for Events (warnings, system events)” check 
box. Press the SPACEBAR to enable this control if you want to be 
alerted to system events such as the start and/or completion of 
synchronization or when e-mail arrives in your inbox. The next two 
controls are similar, except that it applies to program notifications 
such as reminders and alarms. Be sure to enable both the 
Programs and Notifications check boxes if you want to use 
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appointment/task reminders and the alarms on the clock. The last 
control in this dialog is the “Enable sounds for Hardware buttons” 
check box. This control is similar to the Typing Echo control in the 
Keyboard Settings dialog, except that it is a key click. If you check 
this box, be sure to move to the accompanying radio buttons where 
you can use the LEFT and RIGHT ARROWS to decide how loud 
you’d like the “clicks” to sound.  

When you are done with the Volume page, move to the Volume 
tab. This can be done with the SHIFT+TAB or TAB command. 
Once on the Volume tab, press the RIGHT ARROW to move to the 
Notifications tab and press TAB once to move onto the 
Notifications page.  

On this page, the “Select an event” and the “Select how to be 
notified, Play sound” controls work in tandem. That is, as you 
select an event from the combo box, move forward and enable the 
Play sound check box. Then move to the next control, which is a 
combo box, and choose the sound you want to hear for this event’s 
notification. Remember in combo boxes, the UP and DOWN 
ARROW selects, while the SPACEBAR activates buttons.  

When you are done with these settings, press ENTER to save and 
close this dialog. Press F1 to return to the Today Screen. 

Menus 
Depending on the programs you use most, you may find it useful to 
arrange the Start Menu and the Today Screen New Menu 
differently than the default. This is done from the Menus dialog 

To navigate and open this dialog, press F3, S to open the Settings 
dialog. With the list view on the Settings dialog active, press M, 
ENTER to open the Menus dialog.  

The Menus dialog opens with the list view in the Start Menu page 
active. Use the cursor cross to move up and down the list. 
Programs with a check in their box appear in the Start Menu, while 
programs with a clear check box appear in the Programs 
Submenu. Press the SPACEBAR to check or uncheck a box. The 
Start Menu can only hold nine programs.  
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When you are done with setting the Start Menu, press TAB to 
move to the Start Menu tab and press the RIGHT ARROW to move 
to the New Menu tab.  

(If you are not yet familiar with this menu, go to the Today Screen 
and press F2.) 

Because the first control on the New Menu page, Turn on New 
button menu, is not supported, press TAB twice to move to the list 
view. Use the cursor cross to move up and down the list and press 
the SPACEBAR to check or uncheck the item. All checked items 
appear in the New Menu. 

Regional Settings  
To set your PAC Mate to reflect the currency, time, date and 
numbers of a foreign country, use the Regional Settings dialog. 
Pocket PC has over 80 foreign regional settings to choose from. 

You open the Regional Settings dialog from the Settings list view 
on the Systems page. To quickly move to the Regional Settings 
dialog from the Today Screen, press F3, S. When the Settings 
dialog opens, press SHIFT+TAB to move to the Personal tab, then 
press the RIGHT ARROW to move to the Systems page. If the 
System page is not active as you move from the Personal tab, 
press TAB once to move onto the Systems page and then press R 
for Regional Settings and ENTER to open the dialog. 

The Regional Settings dialog opens with the Region page active. 
There is only one control on this page. For this combo box control, 
use the cursor cross to select a region.  

If you want to make further changes or just explore the other pages 
in this dialog, press TAB to move to the Region tab and use the 
cursor cross to move back and forth between pages. To move onto 
a page and navigate through the controls use the TAB and 
SHIFT+TAB commands. To make a selection in combo boxes, 
remember to use the UP and DOWN ARROWS.  
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Clock 
The Clock program features two clocks: one for home and one for 
visiting. So if you visit or have family that lives in a particular time 
zone you may want to adjust your Visiting clock to reflect that time 
zone. The Home clock is intended to keep time for the zone that 
you live in. 

Go to the Start Menu (F3), press S to open the Settings multi-page 
dialog. Press SHIFT+TAB until you hear, “Personal tab,” then use 
the RIGHT ARROW to move to the System tab. On the System 
tab, press TAB once and then press C to select Clock. On Clock, 
press ENTER. 

To view the Home or Visiting clock, use the UP or DOWN ARROW 
to choose the appropriate radio button. Each clock allows you to 
change the time zone, the time, and the date. Press TAB to move 
to any one of these controls. For the Time Zone combo box, 
choose a zone with the UP or DOWN ARROWS. For the time and 
date controls, you will use all the keys of the cursor cross. To move 
between the hour, minutes, seconds of the time control, use the 
LEFT and RIGHT ARROWS. To set these parameters, use the UP 
and DOWN ARROWS. These same commands apply to the date 
control as well.  

Using the Alarm 
This feature accommodates up to four alarm settings and 
requires that you enable the “Notifications (alarms, reminders) 
check box in the Sounds & Notifications dialog. For more 
information, please see Setting Up PAC Mate, System Sounds 
& Notifications. 

From the Today Screen, you access the alarm using the same 
steps for accessing the clock. 

Go to the Start Menu (F3), press S to open the Settings multi-
page dialog. Press SHIFT+TAB until you hear, “Personal tab,” 
then use the RIGHT ARROW to move to the System tab. On the 
System tab, press TAB once and then press C to select Clock. 
On Clock, press ENTER. 

56 440060-001 Rev. A 



 

Once this dialog opens, press SHIFT+TAB until you hear, “Time 
tab.” Then use the RIGHT ARROW to move to the Alarms tab.  

Now, press TAB once to hear, “Alarm 1 check box not 
checked.” To enable or disable check boxes, use the 
SPACEBAR. The next control you encounter is an edit field 
where you can type in a reason for the alarm. To choose how 
you would like to be notified, activate the “Set Notification Sound 
button” with the SPACEBAR.  

This opens a new dialog, which consists of three check boxes 
and a combo box. Use the appropriate commands to navigate 
and activate the controls on this page. When you are done, 
press F1 to return to the Alarms page.  

The last control to set for the alarm is the day(s) you want it to 
sound. For instance, you would like your alarm to sound off 
everyday except Saturday and Sunday. To select Monday 
through Friday, move to each day with the LEFT or RIGHT 
ARROW and press the SPACEBAR. You should hear “Monday 
selected,” “Tuesday select,” etc., but for each weekend day you 
will only hear Saturday and Sunday. To unselect a day, press 
the SPACEBAR again. 

Changing Time Format 
If you prefer reading time in 24 hour format, close the Clock 
dialog by pressing ENTER. Then open the Regional Settings 
dialog by pressing R, ENTER. Press SHIFT+TAB to move to the 
Region tab, and then use the RIGHT ARROW to move to the 
Time tab. To change the time display to 24 hours, choose a time 
style that starts with a capital "H."  

Buttons  
From within the Buttons dialog, you can assign eight hotkey 
commands to any of the programs on your PAC Mate. The 
following table lists the default program for each command.  

Program Command 
Record DOTS 3-4 CHORD, DOT 1 
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Calendar DOTS 3-4 CHORD, DOT 2 
Contacts DOTS 3-4 CHORD, DOT 3 
Tasks DOTS 3-4 CHORD, DOT 4 
Inbox DOTS 3-4 CHORD, DOT 5 
File Explorer DOTS 3-4 CHORD, DOT 6 
FSEdit DOTS 3-4 CHORD, DOT 7 
FSCalc DOTS 3-4 CHORD, DOT 8 

To assign a different program to a command, open the Buttons 
dialog by pressing F3, S. When the Settings dialog opens Buttons 
should already be selected in the list view. If so, press ENTER.  

If not, press the SPACEBAR to select it and then press ENTER. 

The Buttons dialog opens with the Program Buttons page. The list 
view, which has the eight hotkey commands and default programs, 
is active.  

You select a hotkey command by moving up or down with the 
cursor cross, then you press TAB (DOTS 4-5 CHORD) to move to 
the Button Assignment combo box. Use the arrow keys to move 
through the list and select a program you want to associate with 
the hotkey command.  

To assign the next program to a hotkey, press SHIFT+TAB (DOTS 
1-2 CHORD) to move back to the list view. Press DOWN ARROW 
to move to DOTS 3-4 CHORD, DOT 2. By default this button is set 
to Contacts. To change the program, repeat the steps discussed 
above.  

In addition to assigning programs to hotkey commands, you can 
assign commands for scrolling. These options are also listed in the 
Button Assignment combo box.  
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Connecting the PAC Mate 
There are several ways to connect your PAC Mate to the Internet 
or other computers.  

• Use a USB cable or infrared with ActiveSync to connect your 
PAC Mate to a computer and share information or files. 

• Use a modem or Ethernet card to connect to the Internet or a 
local network, where you can browse Web pages, 
send/receive e-mail, or share files. 

• Use the serial port with a 9-pin socket to 25-pin plug null 
modem cable to output to a Blazer embosser.  

• Beam information to another device using the infrared port. 

Cables and Adaptors 
You can use one of several methods to connect your PAC Mate to 
other computers or the Internet. 

An Ethernet card connects the PAC mate directly to a network or a 
high-speed Internet connection such as a cable or DSL modem. 
Some Ethernet cards must be plugged into the PC card slot on the 
right side of the PAC Mate, while others can be inserted in the 
Compact Flash slot on the left side. 

A modem is a device that connects the PAC Mate or a computer to 
a telephone line and allows you to dial into a network or service 
that provides access to the Internet. Like Ethernet cards, modems 
are available for the PC card slot or the compact flash slot. The 
serial port may also be used to connect the PAC Mate to an 
external modem. 

A null modem is used to connect two computers together. It does 
not allow for dialing through a phone line. 

Currently, PAC Mate supports the Socket Low Power Ethernet 
card, the Socket 56K Modem CF card and the Socket Type I PC 
Adapter card. Both the Ethernet and 56K Modem CF cards are 
interchangeable and work in the PAC Mate’s compact flash slot. 
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The PC card slot is also available for use with either of these cards 
provided that you use the Type I PC Adapter card.  

Note:  The Adapter card must be inserted label side down. 
Compact Flash cards must be inserted label side up. 
For more help on how to insert these cards, please 
see PAC Mate Hardware, Ports and Switches. 

The serial port allows you to connect your PAC Mate to other 
devices or an external modem. 

The USB port allows you to connect your PAC Mate to other 
devices and share files or information using ActiveSync. 

The infrared port allows you to share information and files with 
other devices that have an infrared port by aligning the ports so 
that they are facing each other. When you use infrared, you do not 
need cables to connect your PAC Mate to the other device. 

Using an Ethernet Card 
Since the Socket Low Power Ethernet card can use the basic 
NE2000 drivers that come pre-installed on the PAC Mate, it is 
not required that you install its drivers from the Companion CD. 
To read more about Socket’s Low Power Ethernet card, please 
see Socket Low Power Ethernet Card User's Guide.doc located 
in the Docs Folder on the User’s Documentation CD. 

The first time you insert the Ethernet card, the PAC Mate 
automatically detects the new hardware and will launch a 
Network Adapters dialog so you can enter specific IP address 
information required to connect to the network.  

Every computer on a network has an Internet Protocol (IP) 
address. Most hosts use Dynamic Host Configuration Protocol 
(DHCP), which supplies IP address so you may not need to 
enter any settings in this dialog. If you do not have a 
preassigned IP address, check "Use server-assigned IP 
address". If you have a preassigned IP address, check "Use 
specific IP address," press TAB, and type in your IP address.  

If you need to enter specific server information, press DOTS 5-6 
CHORD to move to the Name Servers page. Enter your server 
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information in the appropriate fields and press ENTER to close 
the dialog and return to the Network Adapters dialog. 

Note:  If you have connected an Ethernet card previously 
and need to change settings or if the Network 
Adapters dialog does not appear, go to the Start 
Menu (F3) and choose Settings (S). Next, press 
DOTS 5-6 CHORD to move to the Connections 
page. From here, press N to choose Network 
Adapters and press ENTER. Use the cursor cross to 
select the appropriate adapter and then press TAB 
to move to the Properties button and press 
SPACEBAR. Unless you need to enter a specific IP 
address, press ENTER to close this dialog. 

After returning to the Settings Dialog, select Connections and 
press ENTER. PAC Mate says, "When needed, automatically 
connect to the Internet using these settings," and opens a 
combo box containing the available settings. PAC Mate includes 
settings that have been configured to provide access to a 
network or the Internet. Press UP or DOWN ARROW to select 
Work Settings to connect to a network or Internet to connect to 
the Internet. Press ENTER to close the dialog and return to the 
Settings Dialog, or press TAB until you reach the Modify or 
Connect button and press SPACEBAR. 

When you start using one of the following programs, your PAC 
Mate will automatically begin connecting. Once connected, you 
can: 
• Send and receive e-mail with Inbox. For specific instructions, 

see Inbox Help. 
• Visit Internet or intranet Web pages with Pocket Internet 

Explorer. For specific instructions, see Pocket Internet 
Explorer. 

• Synchronize. For more information, see Set Up Remote 
Synchronization. 
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Using a Modem 
To connect your PAC Mate to the Internet using a modem, there 
are several steps you must complete. To read more about 
Socket’s 56K Modem, please see Socket 56K Modem Quick 
Start Guide.doc located in the Docs Folder on the User’s 
Documentation CD. 
• Install the modem drivers 
• Set Dialing Location defaults 
• Create the new Connection 

Installing Modem Drivers 
Generally, installing the modem drivers is done with ActiveSync 
on the desktop or laptop computer.  
1. Connect your PAC Mate to your PC, and ActiveSync 

starts.  
2. Create a partnership if one is not already created.  
3. Insert the modem installation disks/CD, run the Setup 

program, and follow the prompts.  
4. ActiveSync installs the modem drivers to the PAC Mate. 

Note:  These are general instructions and may not apply to 
all modems. Refer to your modem documentation for 
specific installation information. 

Setting Dial Location Defaults 
You need to set the Dialing Location defaults so the PAC Mate 
knows when to dial an area code, when a call is long distance, 
and whether or not to disable call waiting. 
1. Press F3, S for Settings. 
2. Press DOTS 5-6 CHORD to move to the Connections 

page.  
3. Press TAB once to move into the list view, then press C to 

select Connections and press ENTER to open the 
Connections dialog. 
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4. Press DOTS 5-6 CHORD to move to the Dialing Locations 
page. 

5. Select the location you want to modify. If you use the Work 
location, a 9 is dialed before the phone number. Changes 
you make only affect the selected Dialing Location. 

6. Press TAB until you hear “Area Code.” In this edit field 
type your area code. 

7. Unless you need to fill in more information, press DOTS 2-
3 CHORD to return to the Connections page of the dialog.  

Creating a New Connection 
You use Connections page to set the parameters required to 
connect to your ISP. 
1. In the combo box labeled, “When needed, automatically 

connect to The Internet using these settings,” use the 
cursor cross to select New Connection. 

2. Press TAB to move to the New button and press ENTER. 
3. Type the name of the connection. (You may want to call it 

the name of your service provider to avoid confusion.) 
4. Press ENTER. You are returned to the Connections page. 

The new Connection created is selected in the combo box.  
5. Press TAB to move to the Modify button, and press 

ENTER. 
6. Press DOWN ARROW to select New and press ENTER. 
7. Press TAB to move to the list of modems and select your 

modem. If your modem is not listed, make sure it is 
connected to your PAC Mate and that you have installed 
the driver. 

8. Press TAB and set your BAUD rate to 57600 for a 56K 
modem. 

9. TAB to move to the Next button and press ENTER. 
10. Type the connection phone number of your service 

provider here. You may want to press SHIFT+TAB to 
move to the previous field to make sure the correct area 
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code is reflected. The area code is automatically set to the 
area code set in the Dialing Locations page of the 
Connections dialog. 

11. Press TAB to move to the Next button and press ENTER.  
12. This next page contains several options that usually do not 

need to be changed. Press TAB to explore each option or 
press SHIFT+TAB to move to the Finish button and press 
ENTER. 

13. Press F1 to close the New Connection Wizard. 

You are now ready to connect. Press TAB to move to the 
Connect button. When you press ENTER on this button, you are 
prompted for your user name and password. You can also save 
your password. From this point, the PAC Mate will automatically 
connect as needed while you use Pocket Internet Explorer and 
Inbox. If you have not yet configured your e-mail service within 
Inbox, you will need to do so before you can send or receive e-
mail. 

Connecting to a Network 
You can access information on a company or home-based network 
with a compact flash network card or, if you have a remote access 
server (RAS) account, using a compact flash modem card. See the 
section discussing setting up an Ethernet or modem connection for 
instructions on connecting your PAC Mate to a network. 

Connecting to the Internet 
An Internet service provider (ISP) is a network that gives you 
access to information and files stored on computers all over the 
world. You can connect to an ISP such as Earthlink or MSN 
using a modem to dial in; or you can connect directly to an ISP 
such as Roadrunner or Comcast that provides high-speed 
access using a cable modem and an Ethernet card. 

If you have a dial up account, use a modem and information 
from your service provider to set up your connection. If you have 
broadband cable Internet service, you may be able to connect 
your cable modem to your PAC Mate through a PC or compact 
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flash network card. Not all cable Internet providers use external 
cable modems that connect via a network card, so check with 
your provider. 

Internet service providers use servers to send information over 
the Internet. When you set up your connection, you must have 
information from your service provider, such as the incoming 
and outgoing server name and your user name and password.  
Additional configuration information may also be required. You 
can get this information by contacting a representative from your 
ISP. 

Setting Up Your E-mail Account 
Before you begin this procedure you will need the following 
information from your ISP.  
• Your e-mail address  
• Your user name  
• Your password  
• Service type: POP3 or IMAP4  
• Server Information: Incoming mail, Outgoing mail, Domain 

(optional) 

To create a POP3 or IMAP4 E-mail Service:  
1. Enter the Start Menu (F3) and press ENTER (DOT 8) on 

Inbox. 
2. Press F2, move to Services, and press ENTER. 
3. Press DOWN ARROW to move to New Service and press 

ENTER again. 
4. Follow the directions in the E-mail Setup Wizard. 
5. Enter the e-mail address provided by your ISP or network 

administrator, such as username@servername.com or 
username@servername.net. Use DOT 4-7 to enter the @ 
symbol. 

6. Press SPACEBAR on the Next button. 
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Auto configuration attempts to connect to your e-mail server and 
download the settings so that you do not need to enter them 
manually. If Auto configuration is successful, press SPACEBAR 
on the Next button.  

If Auto configuration is unsuccessful, contact your ISP or 
network administrator for the following information:  
• Server type  
• POP3 or IMAP4 server name  
• Domain name (for network connections only) 

Once you have the above information, continue with the New 
Service wizard.  
1. In the Your Name edit field, enter the name that you want 

people to see when you send them e-mail. Press TAB 
(DOTS 4-5 CHORD) to move to the next edit box. 

2. In the Username edit field, enter the user name assigned 
to you by your ISP or network administrator. This is often 
the same user name you use to sign into your ISP or 
network. This edit box is pre-populated with the 
information you entered in step 5. If the information is 
different, type in the correct information. 

3. In the Password edit field, enter your password and press 
SPACEBAR to check the Save password check box. 
Press SPACEBAR on the Next button. 

4. From the Server type list field, use the cursor cross to 
select POP3 Mail or IMAP4 Mail. 

5. In Name, enter a unique name for the service, such as 
Work or Home. This name cannot be changed later. Press 
SPACEBAR on the Next button. 

6. In the Incoming mail edit field, enter the name of your e-
mail server, then press TAB (DOTS 4-5 CHORD).   

7. In the Outgoing mail edit field, enter the name of your 
Simple Mail Transfer Protocol (SMTP) host, then press 
TAB (DOTS 4-5 CHORD).    
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8. If you are using a network connection, enter your domain 
name in the Domain edit field. Press TAB (DOTS 4-5 
CHORD) to move to the Finish button and press 
SPACEBAR or access additional settings (see E-mail 
Settings Optional) by pressing SPACEBAR on the 
Options button. Additional settings include:  

• Change the time intervals for downloading new messages. 
• Download attachments.  
• Limit the amount of messages downloaded.  

When you are finished with the E-mail Setup Wizard, you are 
returned back to the Inbox list view. You are now ready to 
download your e-mails by pressing F2 and selecting Connect 
from the menu. 

E-mail Settings (Optional) 
When you press SPACEBAR on the Options button, the E-mail 
Setup Wizard adds three additional dialogs.  

The first dialog changes the amount of time Inbox waits to check 
for new messages. Press TAB (DOTS 4-5 CHORD) to move to 
the minutes box and enter a new number of minutes.  

In this same dialog, press TAB if your outgoing mail server 
(SMTP) requires authentication, press SPACEBAR to enter a 
check in the "Outgoing e-mail server requires authentication" 
check box. Inbox will automatically pick the correct connection 
to use for the e-mail service you created. If, for some reason, 
you want to use a specific connection, press TAB to move to the 
Connection list box and use the cursor cross to select the 
connection. When you are done with the settings in this dialog, 
press SPACEBAR on Next button to go to the next dialog. 

The next dialog allows you to choose between downloading only 
message headers or the whole message. To automatically 
download the whole message, from the list, use the cursor cross 
to select "Get full copy of messages." You can also select to 
limit the size of messages by pressing TAB, then SPACEBAR 
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to check the Include check box, press TAB again and enter the 
size of each message downloaded.  

When using IMAP4, Inbox does not download attachments. To 
download attachments, press TAB and press SPACEBAR to 
check the "When getting full copy, get attachments" check box. 
You can also select to limit the size of attachments downloaded 
to your PAC Mate by pressing TAB, then SPACEBAR to check 
the "Only if smaller than" check box and in the edit field enter a 
number in Kilobytes.  

The last dialog lets you control the number of e-mails 
downloaded to your PAC Mate. In this dialog, the "Only display 
messages from the last" check box is checked by default. Press 
SPACEBAR to uncheck this box or TAB to move to the edit 
field and enter a number to specify how many days of e-mail 
you want downloaded. 

Press SPACEBAR on the Finish button as this completes the E-
mail Setup Wizard. 

Connecting to a PC with ActiveSync  
ActiveSync lets you coordinate information on your PAC Mate with 
information on your computer. You can synchronize Internet 
Favorites, Outlook e-mail, contacts, appointments, tasks, and even 
files. Once the information is synchronized, disconnect your PAC 
Mate and go on that business trip or to that important meeting. 
Work with the information on your PAC Mate, add contacts, read, 
respond to, and delete e-mails. Even set appointments. When you 
later reconnect to your PC, contacts are added, e-mails and 
appointments are sent, and e-mails, marked as read, are deleted 
on your PC.  

ActiveSync is also used to back up or directly explore the 
information on your PAC Mate and to install programs from your 
PC onto your PAC Mate. 

You can connect to another PAC Mate or other PDA through 
infrared to quickly share files or contacts. Quickly transfer contact 
information to colleagues at important meetings. Share important 
files, such as sales quotes, reports, or articles. 
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Microsoft® ActiveSync® 3.5 is included in the PAC Mate software 
package. It is already installed on your PAC Mate, but you must 
install it on your PC. If you want to synchronize Inbox, Calendar, 
Appointments, Contact, and Tasks on your PAC Mate with your 
computer, you must first install or make sure you have Outlook® 
2000, or 2002 on your computer. If you do not have Outlook® 
2000, or 2002 on your computer, you can download it from the 
Pocket PC Companion CD. 

Installing ActiveSync on Your Computer 
Insert the Pocket PC Companion CD into the CD-ROM drive of 
your computer. The Install program should start automatically. 

Note: If the CD does not automatically load the install 
program, open the Start Menu and select Run. Use 
the browse button to move to D:\MS\Actsync\Main. 
Go to the Setup.exe file and press ENTER to start 
installation. If your CD drive is not the D: drive, 
substitute the appropriate letter when browsing. 

1. Once you have started the installation, follow the 
instructions, select your preferences, and then TAB to the 
Start Here button. Press SPACEBAR, and follow the 
directions. The installation program will walk you through 
the software installation.  

2. Once ActiveSync is installed on your PC, the ActiveSync 
Setup Wizard launches and prompts you to connect and 
create a partnership. Cancel this wizard and exit 
ActiveSync. 

3. Install the PAC Mate USB driver. 

Note:  For more information about using ActiveSync, refer 
to the ActiveSync help topics on your PC. 

Installing PAC Mate’s USB Driver 
1. Connect the PAC Mate to the USB port on your computer 

using the USB cable. 
2. Follow the directions in the “Add New Hardware Wizard.” 

When you arrive on the page that asks, “What do you 
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want Windows to do?” select the “Search for the best 
driver for your device (Recommended)” radio button. 
Press TAB to move to the Next button and press 
SPACEBAR. 

3. If the above procedure does not work on your PC, move to 
the Back button and press SPACEBAR. Select the radio 
button, “Specify a Location.” The USB driver is in the root 
of the Companion CD, so if your CD-ROM drive is drive D, 
type "D:\" in the location edit field. 

4. On the next page of the Wizard, move to the "CD-ROM 
drive" check box and press the SPACEBAR to check this 
box. 

5. Restart ActiveSync, and set up the partnerships that allow 
you to synchronize information. 

Creating a Partnership 
1. With the New Partnership Wizard open on your desktop, 

select the “Standard Partnership” radio button and press 
ENTER. 

2. When the next page of the Wizard opens, the default 
selection is the “Synchronize with this desktop computer” 
radio button. Press ENTER on the Next button. Unless 
you want to connect to a MS Mobile Server, skip over to 
step 5. 

3. (Optional) To specify that you want to synchronize data 
with Microsoft Mobile Information Server, press DOWN 
ARROW and select the “Synchronize with Microsoft 
Mobile Information Server and/or this computer” radio 
button. Then press ENTER 

4. (Optional) Type in the requested information, pressing 
TAB to move to the next edit field. If you want to save your 
password so you do not have to retype it, press 
SPACEBAR to check the “Save Password” check box. 
After entering your information, press ENTER. 

5. Type in the edit field, “PACMate.” 
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6. To control how much information gets synchronized, move 
to the item in the list view, and press SPACEBAR to 
check the item. The three items in the list view are 
Calendar, Contacts, and Inbox; however, only Calendar 
and Inbox can be customized.  

7. After checking an item, press TAB to move to the Settings 
button and press SPACEBAR. 

8. Choose the parameters you want for synchronization, and 
press SPACEBAR on the OK button to close the 
“Synchronization Settings” dialog. 

9. Press TAB to move to the Next button and press 
SPACEBAR. 

10. In the Edit field, type PACMate as one word. 
11. Press TAB to move to the Next button and press 

SPACEBAR. 
12. This dialog is similar to the “Inbox Synchronization 

Settings” dialog in that it has items with check boxes in a 
list view. The items are AvantGo, Favorites, Files, Notes, 
Pocket Access, and Tasks. In this list view only Favorites, 
Files, and Tasks can be customized for synchronization.  

13. Press the SPACEBAR to check the item, then press TAB 
to the Settings Button and press SPACEBAR. 

14. Choose the parameters you want for synchronization and 
when you are done, press SPACEBAR on the OK button 
to close the “Synchronization Settings” dialog. 

15. Press TAB to move to the Next button and press 
SPACEBAR. 

16. Press ENTER again to exit the New Partnership Wizard. 
ActiveSync automatically starts synchronizing. 

You can also synchronize remotely with a server, without a PC, 
by setting up a connection with ActiveSync on your PAC Mate. 
To do this you will need an Ethernet Card or a 56 K Modem 
Compact Flash Card.  
1. In ActiveSync on the PAC Mate, press F2, press ENTER 

on Tools, then press ENTER on Options.  
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2. Press SHIFT+TAB until PAC Mate says, “PC tab,” then 
press RIGHT ARROW to move over to the Server tab. 

3. Press TAB to move to the list view of information types: 
Calendar, Contacts, or Inbox. Use the cursor cross to 
move to each item and press the SPACEBAR to check 
the item that you want to synchronize with the server.  

4. To change synchronization settings, such as the amount 
synchronized, select the type of information in the list 
view. 

5. Press TAB to move to the Settings button and press 
SPACEBAR. You can choose settings for each 
information type except Contacts. 

6. Press ENTER to return to the Server page. 
7. On the Server page, press TAB to move to the Server 

Name edit box and type the name of the server to which 
you are connecting.  

8. Press TAB to move to the Advance button, and then press 
SPACEBAR. 

9. On this page, enter your user name, password and 
domain. 

If items change on both your device and server, conflicts will 
arise during synchronization.  
1. To change the rules for conflicts, press the RIGHT 

ARROW to move to the Rules tab.  
2. Select “Always replace the item on the server” radio 

button. 
3. Press ENTER to return to the Server tab. 
4. To set the schedule for synchronization, move to the 

Schedule tab and choose the parameters you want for 
synchronization (optional). 

5. Press ENTER to close this dialog and return to 
ActiveSync. 

6. Your PAC Mate begins to synchronize automatically 
provided that it is connected to the server via a PC 
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modem/Ethernet card or Compact Flash modem/Ethernet 
card. 

Using Infrared with ActiveSync 
Follow the instructions in ActiveSync Help on the PC for setting 
up your PC.  

Line up the infrared (IR) ports on the devices so that they are 
unobstructed and within a close range. On the PAC Mate, the IR 
port window is to the left of the battery pack. To help orient the 
PAC Mate IR port, there is a ridge on the top surface of the PAC 
Mate, near the F1 key. 
1. Press F3 on the PAC Mate to go to the Start Menu. 
2. Select ActiveSync. 
3. Press F2 and press ENTER on Tools. 
4. Select Connect via IR. Synchronization will begin. 

You can beam a file using infrared to and from a PC with the 
following applications: 
• Pocket Word 
• Tasks 
• Contacts 
• File Explorer 

To connect to a PC using infrared, follow the instructions in the 
topic, "Connect to ActiveSync Using infrared," in the book, 
"Connecting a Mobile Device to Your Computer," in ActiveSync 
Help on the PC. 

To end a connection with infrared, move the PAC Mate away 
from the PC. 

Beaming Information 
You can beam information to another PAC Mate, PDA, or 
computer using the infrared port. If an IR port is installed on your 
PC, you can send and receive information and files between 
your PAC Mate and PC.  
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For information about beaming specific information within a 
program, see Help on your PAC Mate for that program.  

If you are unable to beam information, try the following:  
• Transfer only one file, or no more than 25 contact cards, at a 

time. 
• When using IR, make sure nothing is between the two IR 

ports.  
• Adjust the room lighting or move to another location (some 

types of light interfere with beaming).   

Receiving a Beam on the PAC Mate 
1. Press F3 to open the Start Menu. 
2. Move to Programs and press ENTER. 
3. Move to Infrared Receive and press ENTER again. 

Deactivating the Infrared Port 
The infrared port is active by default. In certain situations you 
may want to deactivate it. 
1. Press F3 to go to the Start Menu. 
2. Select Settings. 
3. Press the TAB key once, then use the right arrow key to 

move to the Connections tab. 
4. Move to Beam and then press ENTER. 
5. Press TAB to move to the Receive all incoming beams. 
6. Select discoverable mode check box and press the 

SPACEBAR to clear the box. 
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Using PAC Mate Programs  
This section begins with a discussion on features and procedures 
common among Microsoft’s programs and then introduces you to 
all of PAC Mate’s programs discussing the key features in each. 

When you start using PAC Mate regularly, you will notice that one 
of the items common among all Microsoft programs is the list view. 
The list view lists the files you have created in a particular program 
and is seen whenever you open a program or close a file. In the list 
view, you always have the Context Menu (F2 CHORD) available. 
This Context Menu offers a quick way of performing actions such 
as cut, copy, delete, rename, move, select all etc. To perform an 
action on an item(s), use the DOWN ARROW to select an item or if 
you want to select multiple items press DOWN ARROW CHORD. 
Then, press F2 CHORD on the selected item(s). From the Context 
Menu select an action and press ENTER. 

Of course, you can always use the equivalent PAC Mate 
commands as well. 

A feature common to Pocket Word, File Explorer, Calendar, 
Contacts, Tasks and Notes is the Infrared Beaming feature.  

To use the beaming feature align the IR ports so that they are 
unobstructed and within close range. On the PAC Mate, the IR port 
window is to the left of the battery pack. To help orient the PAC 
Mate IR port, there is a ridge on the top surface of the PAC Mate, 
near the F1 key. 

Go into the program’s list view, use the DOWN ARROW to select 
an item or if you want to select multiple items, press DOWN 
ARROW CHORD and then press F2 CHORD. On the Context 
menu, select Beam… and press ENTER.  

Tip:  You can beam an FSEdit file to another PAC Mate 
using the Beam Feature in File Explorer. 

Another common feature among Microsoft programs is 
synchronization; however this feature does work differently in some 
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programs. For information on synchronization with those programs, 
please refer to their sections in this chapter. 

For Contacts, Calendar and Tasks synchronization works the same 
way and is automatic. If you do not want automatic synchronization 
of these programs, then open ActiveSync on your PC, go to the 
Tools Menu (ALT+T) and select Options. In the list view remove 
the check in the box next to these programs. 

In addition, any related contacts, tasks, and appointments can be 
grouped into categories to quickly display only the information you 
want. You can also create your own categories, such as "Vacation 
Planning" to group your trip planning tasks, and "Family" to group 
your relatives' contact information.  

7. From the list view, open the contact, task, or appointment 
by pressing ENTER.  

8. Next, press F2, and press ENTER on Edit.  
9. Press TAB until you hear, “Category button” and press the 

SPACEBAR to activate it. 
10. Use the cursor cross to select the category. Then check 

the accompanying box with the SPACEBAR.  
11. To create a new category, press DOTS 5-6 CHORD until 

to move to the Add/Delete page. 
12. In the edit box, type the category name, and then TAB to 

the Add button and press SPACEBAR. The new category 
is automatically selected in the Select page. 

To find a contact or task not assigned to a category, in the list view, 
press F2 and select Show By. On the Show By menu, choose No 
Categories. 

To find an appointment assigned to a category, in the list view 
press F2, move to Tools and press ENTER. Move to Categories 
and press ENTER again. Then select the type of appointment you 
want displayed. 
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Pocket Outlook 
In other versions of Windows, Outlook opens as a single program 
with links to sub-programs that appear on the Folders List. On the 
PAC Mate, these programs appear as separate programs in the 
Start Menu and include: Inbox, Contacts, Tasks, Calendar, and 
Notes. 

Inbox 
The Inbox on your PAC Mate receives e-mail messages sent 
through your Internet Service Provider (ISP) or a local area 
network (LAN). To connect to your ISP or LAN, you can use a 
compatible modem, network card or ActiveSync via USB or 
serial cable. 

There are several methods to send and receive e-mail: 
synchronize your PAC Mate with your PC using ActiveSync, 
connect to a Post Office Protocol 3 (POP3), or connect to an 
Internet Message Access Protocol 4 (IMAP4) mail server. For 
POP 3 and IMAP 4 you will need to set up an e-mail service. For 
more information about setting up an email service, see 
Connecting the PAC Mate, Setting Up Your E-Mail Account. 

The following table lists the commands that can be used in 
Inbox.  

Description Command 
Shortcut to Contacts SH CHORD, C 
Show By SH CHORD, W 
Sort By SH CHORD, Y 
Send Message 
(when creating a new message)

SH CHORD, S 

New Message SH CHORD, N 
Expand/Collapse Message 
Headers 

SH CHORD, H 

My Text Messages  SH CHORD, M 
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Delete E CHORD, D 
Rename SH CHORD, R 
Services  SH CHORD, V 
Next Message N CHORD 
Prior Message P CHORD 
Read Message Body M CHORD 
Translate and Send SH CHORD, T 

Downloading E-mail Messages  
If you have more than one service established for Inbox, press 
F2, move to Show By, and press ENTER. Make sure that the 
service is selected.  

To download your e-mail messages, press F2 move to Connect 
and press ENTER. The messages on your PAC Mate and mail 
server are synchronized. This means that new messages are 
downloaded to the PAC Mate Inbox folder, while messages in 
the PAC Mate Outbox folder are sent. Also, messages that have 
been deleted from the server are removed from the PAC Mate 
Inbox.  

Reading Messages 
To open a message press ENTER on the message in the 
message list. With the message, you can press M CHORD to 
skip over the e-mail heading information and move directly to 
the body of the message.  

If you read a message and decide that you need the full copy, 
press F2, and press ENTER on Edit and select Mark for 
Download. Or while in the message list, press F2, move to 
Services, and press ENTER. Move to Mark for Download and 
press ENTER again. This will also download message 
attachments if you selected those options when you set up the 
mail service. You can also choose to download full copies of 
messages by default.  
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When finished, press F2, move to Services, and press ENTER. 
Then move to Disconnect and press ENTER again. 

Synchronizing Inbox 
In order for e-mail to be synchronized in Pocket Outlook’s Inbox, 
you must select Inbox in the Options dialog of ActiveSync on 
your PC.  

After selecting Inbox for synchronization in ActiveSync, e-mail 
messages are synchronized as part of the general 
synchronization process. During synchronization: Messages are 
copied from the Inbox folder of Exchange or Outlook on your PC 
to the ActiveSync folder in Inbox on your PAC Mate. By default, 
you’ll receive messages from the last five days only, the first 100 
lines of each new message, and file attachments of less than 
100 KB in size.  

Messages in the Outbox folder on your PAC Mate are 
transferred to Exchange or Outlook and then sent from those 
programs.  

The messages on the two computers are linked. When you 
delete a message on your PAC Mate, it’s deleted from your PC 
the next time you synchronize.  

Messages in subfolders in other e-mail folders in Outlook are 
synchronized only if they have been selected for 
synchronization in ActiveSync. 

Checking Inbox status 
In the message list, press F2, move to Tools and press ENTER. 
Move to Status and press ENTER again. You can view details 
such as the number of messages to be sent, deleted, and 
copied, and the number of attachments to be downloaded.  

Composing and Sending a Message 
1. In the e-mail message list, press F2 and select New.  
2. To select a service, press the F2, move to Expand Heads 

and press ENTER to display more header information. 
Press TAB to move to about the Header area. If you have 
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more than one Service option, use the cursor cross in the 
Service list to select your e-mail service.  

3. Press TAB to enter the message area. Type in your 
message or quickly add common messages by pressing 
F2, selecting the Edit menu, and in the menu enter on Edit 
My Text Messages. 

4. Use the cursor cross to select the desired message. When 
done press ENTER to move back to the message. 

5. To read the message that you composed, press DOTS 4-
5-6-8 CHORD. 

6. Press TAB to move to the Send button and press 
SPACEBAR. If you are working offline, the message is 
moved to the Outbox folder and will be sent the next time 
you connect.  

Depending on the e-mail address options that you select, you 
can use a directory service such as 411, Bigfoot.com etc., in 
addition to your contacts list to verify names. 

Replying or Forwarding a Message 
Open the message, press F2, move to Action and press 
ENTER. In the menu select and press ENTER on the action you 
want to perform (Reply, Reply All, or Forward).  

In the message area type in your response or you can quickly 
add common messages by press F2, moving to Edit and 
pressing ENTER. Then select Edit My Text Messages and use 
the cursor cross to choose a prewritten response. Press ENTER 
when you have made a selection. 

When you are done press F2, move to send and press ENTER. 

Note:  Selections in the Message tab found under the Tools 
Menu in Options determine whether the original text 
is included. 

To see more header information, press F2, move to Expand 
Header, and press ENTER.  Press it again to collapse the 
header area. 

80 440060-001 Rev. A 



 

Attaching a File to an E-mail Message 
With the message open, press F2, move to Edit, and press 
ENTER. In the Edit menu, press ENTER on Add Attachment. 
Then, select the file you want to attach. OLE objects cannot be 
attached to Inbox messages.  

Receiving Attachments 
If your e-mail is set to get message headers only, then before 
you can recognize that e-mail has an attachment, you must 
download the whole e-mail message. To do this from an open 
message, press F2, move to Edit, and press ENTER. Move to 
Mark for Download and press ENTER again. Or while in the 
message list, press F2, move to Services, and press ENTER. 
Move to Mark for Download and press ENTER again. 

An attachment sent with an e-mail message or downloaded from 
the server is indicated with the following text at the bottom of the 
message, “Message truncated. Press F2, move to Edit and 
press ENTER. Select Mark for Download and press ENTER 
again to get remaining portion.” You can mark an attachment for 
downloading (IMAP4 service only) the next time you connect.  

If you receive messages through synchronization, in ActiveSync 
on your PC, go to Tools (ALT+T) and press ENTER on Options. 
Then, press TAB to move to the Settings button, and press 
SPACEBAR. In the Mail Synchronization dialog, press TAB to 
move to the “Include File Attachments check box” and press the 
SPACEBAR to check it.  

If you receive messages through a remote mail server using the 
IMAP4 or POP3 mail protocol, you will need to configure your e-
mail service to download attachments. To do this, press F2, 
move to Tools and press ENTER. From this menu, select 
Options and press ENTER. In the Options dialog, press the 
DOWN ARROW to select the service you want to change the 
settings and press ENTER. This opens the E-mail Setup 
Wizard. Move forward through the Wizard until you reach the 
Server Information page. On this page, press TAB to move to 
the Options button and press SPACEBAR.  

440060-001 Rev. A  81 



 

Note:  Embedded images and OLE objects cannot be 
received as attachments. 

An embedded message can be viewed as an attachment when 
using IMAP4 to receive e-mail. However, this feature does not 
work if Transport Neutral Encapsulation Format (TNEF) is 
enabled so that you can receive meeting requests. 

Receiving Meeting Requests 
If you receive your e-mail messages through ActiveSync, you 
will automatically receive meeting requests. If you connect 
directly to a mail server, the server must be running Microsoft 
Exchange Server 5.5 or 2000 in order for you to receive meeting 
requests. If you are running Microsoft Exchange Server 2000, 
you will automatically receive meeting requests in your Inbox.  

Receiving Meeting Requests on Microsoft 
Exchange Server 5.5  
Ask your systems administrator to activate Rich Text Format 
and TNEF support for your account. If TNEF is enabled, you will 
not receive messages that are included in other messages as 
attachments, and you will not be able to tell if a message has an 
attachment until you get the full copy. In addition, download time 
may take longer.  

While setting up your mail service, select Get file attachments.  

After you are set up to receive meeting requests.  

If you connect directly to a mail server and only receive 
message headers and/or a limited number of lines per message, 
select the message that you think is a meeting request and then 
press F2, move to Services, and press ENTER. Move to “Mark 
for Download” and press ENTER again.  

Open a Meeting Request 
Meeting requests that you synchronize with ActiveSync appear 
on the Today Screen as an appointment. Use the cursor cross 
to move to Appointments and press ENTER. If you want, you 
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can include a written message with your response. The 
response will be sent the next time that you synchronize or 
connect to your mail server, and your PAC Mate Calendar will 
be updated.  

About Folders 
Each e-mail service has its own folder hierarchy with five default 
folders: Inbox, Outbox, Deleted Items, Drafts, and Sent Items. 
The messages you receive and send through the mail service 
are stored in these folders. You can also create additional 
folders within each hierarchy. The Deleted Items folder contains 
messages that have been deleted on the PAC Mate. The 
behavior of the Deleted Items and Sent Items folders depends 
on the Inbox options you have chosen.  

The behavior of the folders you create depends on whether you 
are using ActiveSync, POP3, or IMAP4.  

If you use ActiveSync, e-mail messages in the Inbox folder in 
Outlook will automatically be synchronized with your PAC Mate. 
You can select to synchronize additional folders by designating 
them for ActiveSync. The folders you create and the messages 
you move will then be mirrored on the server. For example, if 
you move two messages from the Inbox folder to a folder named 
Family, and you have designated Family for synchronization, the 
server creates a copy of the Family folder and copies the 
messages into that folder. You can then read the messages 
while away from your PC.  

If you use POP3 and you move e-mail messages to a folder you 
created, the link is broken between the messages on the PAC 
Mate and their copies on the mail server. The next time you 
connect, the mail server will see that the messages are missing 
from the PAC Mate Inbox and delete them from the server. This 
prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages 
that you move to folders created from anywhere except the PAC 
Mate.  

If you use IMAP4, the folders you create and the e-mail 
messages you move are mirrored on the server. Therefore, 
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messages are available to you anytime you connect to your mail 
server, whether it is from your PAC Mate or PC. This 
synchronization of folders occurs whenever you connect to your 
mail server; create new folders, or rename/delete folders when 
connected.  

For all services except ActiveSync, you can access folder 
options by pressing F2, moving to Tools, and pressing ENTER. 
Then move to Manage Folders and press ENTER again.  

Creating a Folder 
1. Select the service by pressing F2, move to Show By and 

press ENTER. Select the correct service.  
2. Press F2 move to Tools and press ENTER. On Manage 

Folders press ENTER again.  
3. Press F2 and select New to create a new folder under the 

folder that is currently selected.  

Renaming a Folder 
With a folder selected Press F2, move to Rename and press 
ENTER. In the Rename dialog, type in the new name. Default 
folders, such as Inbox, cannot be renamed.  

Deleting a Folder 
With a folder selected Press F2, move to Delete and press 
ENTER. In the Delete dialog, press SPACEBAR on the Yes 
button to delete the folder and its contents.  

Note:  You must be online and connected to delete or 
rename an IMAP4 folder. 

Default folders (Drafts, Outbox, Inbox, Deleted Items, and Sent 
Items) cannot be deleted. 

Sorting the Message List View 
If you have a long list of messages, sorting the list can help you 
quickly find the item you want.  
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1. In the message list, press F2, move to Sort By and press 
ENTER.   

2. Select the option you want to sort by.  
3. Select the option again to reverse the sort order 

(ascending to descending). 

Moving Messages 
In the message list, select the message and press F2 CHORD. 
To select multiple messages, press SPACEBAR+DOWN 
ARROW. Then, press F2 CHORD on the selected messages.  

On the menu, select Move to and then select the folder you 
want to move the messages.  

Caution:  When you move a message that you have received 
through POP3 or synchronization to a folder you 
created on your PAC Mate, the copy of the message 
on the server is deleted the next time you connect. 
This prevents duplicate copies of messages. 
Although the complete message is moved, message 
attachments will be deleted if you have not selected 
the option to download attachments. Once the 
message is moved, you will be able to access the 
message only from your PAC Mate. 

Deleting Messages  
To delete a message in the message list, select the message. 
To select multiple messages, press SPACEBAR+DOWN 
ARROW. Then, press F2, move to Tools and press ENTER. On 
the menu, move to Delete. Messages are moved to the Deleted 
Items folder and deleted according to the option that you have 
selected in the Message tab. Press F2, move to Tools and press 
ENTER. Move to Options and press ENTER again. Press TAB 
until you hear "Services tab," then press the RIGHT ARROW to 
move to the Message tab.  

Note:  If you are working offline, messages that have been 
deleted from the server will be deleted from the PAC 
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Mate the next time you connect or according to the 
options you have selected. 

To permanently delete messages in the Deleted Items folder, 
press F2, move to Tools and press ENTER. Move to Empty 
Deleted Items and press ENTER again. 

Clearing Messages and Folders 
When receiving e-mail messages from a POP3 or IMAP4 
server, select the service on the PAC Mate containing the 
folders and messages you want to clear, and then press F2, 
move to Services and press ENTER. Move to Clear All and 
press ENTER again. All messages and folders that are linked to 
the selected service are cleared, and memory space is 
expanded on the PAC Mate without deleting messages on the 
server. The next time you connect, the messages and folders 
are downloaded again.  

You cannot clear messages and folders from the ActiveSync 
folder.  

Changing Message Options 
In the message list, press F2, move to Tools and press ENTER. 
Move to Options and press ENTER again. Press TAB until you 
hear "Services tab," then press the RIGHT ARROW to move to 
the Message tab.  

To place a copy of the original message beneath your response 
text, press the SPACEBAR to check “When replying, include 
body” check box.  

By default, e-mail messages you send are not saved on your 
PAC Mate. This helps conserve memory space. If you want to 
keep copies of sent e-mail messages, press the SPACEBAR to 
check “Keep copy of sent mail in Sent folder” check box.  

Changing Storage Options 
In the message list, press F2, move to Tools and press ENTER. 
Move to Options and press ENTER again. Press TAB until you 
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hear "Services tab," then press the RIGHT ARROW to move to 
the Storage tab.  

To store attachments on a storage card rather than internal 
RAM, press the SPACEBAR to check the “Store attachments 
on storage card” check box. All attachments will move to the 
selected card.  

Changing Address Options 
Many mail servers, including servers running Exchange Server, 
can verify names with an online directory service address book 
using LDAP (Lightweight Directory Access Protocol). When you 
create a mail service, your mail server's directory service is 
added to the Address tab, and you are given the option to 
enable it. After it is enabled, Inbox checks your contacts list and 
then the directory service to verify names that you enter in the 
To, Cc, and Bcc fields. If you did not enable directory service or 
if you want to use additional services, follow these steps:  
1. If you are adding a new service, ask your network 

administrator for the correct server name.  
2. In the message list, press F2, move to Tools and press 

ENTER. Move to Options and press ENTER again. Press 
TAB until you hear "Services tab," then use the RIGHT 
ARROW to move to the Address tab.  

3. In the “In Contacts, get addresses from:” list box, use the 
cursor cross to select the e-mail address to check in 
Contacts. Contacts will be checked first unless you select 
None.  

4. Press TAB to move to mail server list, if your mail server is 
listed use the cursor cross to select the mail server’s 
directory service, then press the SPACEBAR to enable it. 
Last, press ENTER.  

Note:  To delete a service, use the cursor cross to select 
the service and press F2 CHORD. On the menu, 
select Delete. 

5. If your mail service is not already listed, press TAB to 
move to the Add button and press SPACEBAR.  
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6. Press TAB. In the Directory name and Server edit boxes, 
enter the LDAP directory and server names.  

7. Ask your network administrator if authentication is 
necessary for your server. If so, press TAB and then 
SPACEBAR to check the “Authentication is necessary on 
this server” check box, and enter your user ID and 
password.  

8. To have Inbox check this service, press TAB and the 
SPACEBAR to check the “Check name against this 
server” check box.  

9. When you are done, move to the OK button and press 
SPACEBAR. 

While sending and receiving messages through synchronization, 
disable any directory services you have installed. This helps 
avoid getting error messages when Inbox tries to verify names 
against the service that are not connected. 

Contacts 
Maintain a list of your family, friends, and colleagues so you can 
easily find the information and stay in touch, regardless of where 
you are. You can enter both personal and business information.  

Creating or Editing a Contact 
To create a contact, press F2, move to New, and press ENTER. 
On the Contact Information dialog, fill in the information about 
the person or organization.  

To add additional information about your contact, like when is it 
an appropriate time to call etc., press TAB (DOTS 4-5 CHORD) 
until you hear, “Notes button,” then press SPACEBAR to open 
the Notes page. When finished, press F1 to return to the contact 
list.  

Tip:  If you are close to the top of the Details page, press 
SHIFT+TAB, instead of TAB, until you hear, “Notes 
button.” 
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To edit contact information, press ENTER on the name in the 
contact list, and then press F2, move to Edit, and press ENTER. 
When finished making changes, press ENTER to return to the 
contact list.  

Note:  If you enter a name with more than 2 words, the 
middle word will be recorded as a middle name. If 
your contact has a double first or last name, SH 
CHORD, F in the Name edit combo box and enter 
the names in the proper fields. 

New contacts are added to the category that is currently 
displayed. 

Viewing Contacts 
The contact list displays the contact name and the first primary 
phone number or e-mail address specified for that contact. 
Contacts are ordered by last name and then first name or by 
name of company.  

To read the contact summary, in the Contact List select the 
contact and press ENTER. This will open a window with a 
summary of the contact’s information. To read the notes or add 
notes about your contact, press TAB once to open the Notes 
page. When you are done, press F1 to return to the Contacts 
List. 

If you want to quickly switch views of the Contact List, press SH 
CHORD, W to activate the Show By Menu. Then select the view 
that lists the contact you are trying to find. 

To see a list of available actions for a contact, select the contact 
and press F2 CHORD.  

To see a list of contacts employed by a specific company, press 
F2, move to View, and press ENTER. Move to By Company and 
press ENTER again. Then, select and press ENTER on the 
desired company name. 

Note:  You can change the appearance of the contact list 
by pressing F2, move to Tools, and press ENTER. 
Move to Options, and press ENTER again. Use the 
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SPACEBAR to place a check in the appearance 
type you want. 

 

E-mailing a Contact 
In the contact list, select the contact and press F2 CHORD. On 
the menu, press ENTER on “Send E-mail to Contact.”  

Finding a Contact 
There are three ways to find a contact:  
• Use the Find Feature in the Start Menu or in the contact list, 

press F2, and select Show By. Select the type of contact that 
you want displayed. To show all contacts again, select All 
Contacts. To view a contact not assigned to a category, 
select No Categories. 

• To view the names of companies your contacts work for, in 
the contact list, press F2 and select View, then select By 
Company. The number of contacts that work for that 
company will be displayed to the right of the company name.  

Tip:  In Find Feature, you can select from a list of 
contacts that you already looked for in the Find edit 
combo box. Use the ARROW keys to expand the 
box 

Change Options 
In the contact list, press F2, move to Tools and press ENTER. 
Move to Options and press ENTER again. Choose the List View 
options of your preference. 

PAC Mate does not support the “Use large font” item.  

The area code and country/region for new contacts are 
automatically entered based on the information in 
Country/Region settings.  
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Tasks  
You can use Tasks to help you organize and set your day’s 
schedule. You can create a list of things to do and prioritize 
them by their importance. Any task that needs to be 
accomplished today is displayed on the Today screen.  

To help you stay on task, ActiveSync automatically 
synchronizes your tasks between your PAC Mate and PC.  

Creating a Task  
1. To create a task with detailed information, such as start 

and due dates, press F2 and press ENTER on New.  
2. On the Task Information dialog fill out the information. Use 

the cursor cross to explore each edit combo box and 
combo box as each has useful items that can save time. 

3. When you move to the “Start” and “Due” items, the 
Calendar View becomes active. For more information on 
the commands associated with the Calendar View, please 
refer to Calendar, Using the Calendar View. 

Note: New tasks are added to the category that is currently 
selected. 

If you find that creating a detailed task is too time consuming, 
you can quickly create a task by pressing F2, moving to Tools 
and pressing ENTER. Then move to and press ENTER on Entry 
Bar. This places an entry bar at the top of your task list where 
you can quickly enter a one-sentence task. To enter the edit 
field, press TAB three times and type in your task. If this is a 
task with importance, then press SHIFT+TAB twice to move to 
the “High Importance” button and press SPACEBAR. From 
here, press TAB once to move to the “Enter task to the list” 
button and press SPACEBAR. 

Editing a Task 
To change a task, select it in the task list, then press F2, and 
select Edit. 
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Tip: You can easily create a task from the Today Screen 
by pressing F2, moving to Task and pressing 
ENTER. When Task Information dialog displays, 
type in your information.  

Setting a Reminder for a Task 
1. From the task list, open the task. Press F2, move to Edit 

and press ENTER.  
2. Press TAB to move to the Due box and set a due date if 

you have not already done so.  
3. Move to the Reminder box and select Remind me. You will 

be reminded at 8:00 in the morning on the due date.  
4. To change the reminder date, move to the date displayed 

and change the date. 

Note: To be automatically reminded of new tasks with a 
due date, in the task list, press F2, move to Tools 
and press ENTER. Move to Options and press 
ENTER again, then check the “Set reminders for 
new items” check box. 

To choose how you are reminded, for example by a sound, go 
to the Start Menu (F3) and select Settings. On the Personal tab, 
use the cursor cross to move to Sounds & Notifications and 
press ENTER. Adjust each control to your preference.  

Adding a Note to a Task 
You can add notes to a task.  
1. In the task list, open the task.  
2. Press F2 and select Edit. Press SHIFT+TAB until you 

hear, “Notes button” and press SPACEBAR.  
3. Type in the additional information you want to include for 

that particular task. 
4. When finished, press F1 to return to the task list. 
5. Later, when you open your task, the additional information 

is available for PAC Mate to read.  
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Making a Task Recurring 
1. From the task list, open the task, and then press F2, move 

to Edit and press ENTER.  
2. Press TAB to move to the Occurs edit combo box, select 

a pattern from the list or create a new pattern by choosing 
Edit pattern from the list. Then follow the steps in the 
wizard. 

Finding a Task 
There are two ways to find a task:  
• Use the Find Feature in the Start Menu.  
• In the task list, press F2, move to Show By and press 

ENTER. In the Show By menu, select the type of task you 
want displayed. To show all tasks again, select All Tasks. To 
view a task not assigned to a category, select No Categories. 

Completing a Task 
To mark a task completed, in the task list, press the 
SPACEBAR to check the box next to the completed task.  

Changing Options 
In the task list, press F2, move to Tools and press ENTER. 
Move to Options and press ENTER again.  
• To see the start and due dates for a task in the task list, 

select Show start and due date.  
• PAC Mate does not support the item “Use large font.”  

Calendar 
Although very similar to Tasks, the Calendar is meant to help 
you with scheduling and keeping your appointments. The 
Calendar View, used for setting each appointment, lets you 
schedule for a day, a week, a month and a year. You can be 
reminded of appointments with a sound or other method. 
Appointments for the day can be accessed on the Today 
screen.  
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The Calendar is easy to access and easy to use. You can 
access the Calendar directly off the Today Screen or directly 
from the Start Menu (F3), press C to move to Calendar and then 
press ENTER. Once you have opened Calendar you are in the 
Appointment list view, which lists the appointments you have 
created. If you have not created any appointments, the list 
displays “No Appointments.” From here you can select any day 
of a particular week by pressing F2.  

When you press F2 in the appointment list view, the following 
menu items are listed: 
• New 
• Tools 
• Calendar View 
• Sunday 
• Monday 
• Tuesday 
• Wednesday 
• Thursday 
• Friday 
• Saturday 

The following table lists shortcuts to change to the appointment list 
for another day in the current week. These commands only work 
when you are in the Appointment list view.  

 Description Command 
Jump to 1st day of week SH CHORD, 1 

(DOTS 1-4-6 CHORD, DOT 2)  
Jump to 2nd day of 
week 

SH CHORD, 2 
(DOTS 1-4-6 CHORD, DOTS 2-3) 

Jump to 3rd day of week SH CHORD, 3 
(DOTS 1-4-6 CHORD, DOTS 2-5) 

Jump to 4th day of week SH CHORD, 4 
(DOTS 1-4-6 CHORD, DOTS 2-5-6) 
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Jump to 5th day of week SH CHORD, 5 
(DOTS 1-4-6 CHORD, DOTS 2-6) 

Jump to 6th day of week SH CHORD, 6 
(DOTS 1-4-6 CHORD, DOTS 2-3-5) 

Jump to 7th day of week SH CHORD, 7 
(DOTS 1-4-6 CHORD, DOTS 2-3-5-6) 

Creating or Editing an Appointment 
1. To create an appointment, go to the Start Menu (F3), 

press the letter C once or use the cursor cross to move to 
Calendar and press ENTER.  

2. In the Appointment list, press F2 and press ENTER on 
New or press F2 CHORD and press ENTER on new 
appointment.    

3. Fill in each field of the Appointment Information dialog. 
The Subject item has an edit combo box. In this field you 
can type in the information or use the cursor cross to 
select an item from the box.  

4. The Start and End items activate the Calendar View. For 
more information on using this feature, please see 
Calendar, Using the Calendar View. 

5. To move about the dialog, press TAB or SHIFT+TAB. To 
activate a button, press the SPACEBAR.  

6. To select a new time, use the cursor cross to select the 
display time or type in the display time. Enter the 
appointment details, and when finished, press ENTER to 
return to the calendar list.  

Note: When entering a time, you can type military and 
abbreviated time forms, such as 2300 (becomes 
11:00 PM), 913pm (becomes 9:13 PM), 911 
(becomes 9:11 AM), and 9p (becomes 9:00 PM). 

To change an appointment, select it in the appointment list and 
press ENTER to open it. Then press F2, move to Edit and press 
ENTER. Change any appointment detail by pressing TAB to 
move to the item. Then enter the new information.  
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Viewing Appointments 
To see a list of available actions for an appointment, select the 
appointment in the appointment list and press F2 CHORD.  

To view the information of an appointment, select it in the 
appointment list and press ENTER to open it.  

Note:  To quickly access your appointments for the day, 
press F3 and press ENTER on Today. 

Creating an All Day Event 
Appointments can span an hour, several hours, all day or even 
all week. Those that span all day or all week are considered an 
All Day Event. Examples include trade shows or training 
seminars. To schedule an all day event, follow the steps above 
to create an appointment or select and open an existing 
appointment from the appointment list. Press F2 and select Edit. 
In this dialog, press TAB until you hear, “Type combo box.” Use 
the cursor cross to select All Day. You can also schedule a 
birthday or anniversary as an all day event. However, for this 
you will want to press TAB to move to the Status combo box 
and use the cursor cross to select Free. This way the time will 
not show as busy in your calendar.  

PAC Mate indicates an All Day Event by announcing it in the 
appointment list.  

Note:  You can create an all day event on the PAC Mate, 
however you cannot create or modify an all day 
event to include attendees on the PAC Mate. To do 
this, you must create all day events with attendees 
on your PC, and use ActiveSync to copy these 
events to the PAC Mate. Then, view them in 
Calendar. To schedule an appointment with 
attendees lasting all day on the PAC Mate, set type 
to Normal, then adjust the date and time 
appropriately. 
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Making an Appointment Recurring 
Appointments that occur on a regular basis, such as a weekly 
team meeting can be entered once and set with a recurring 
pattern. To do this, follow the steps above to create an 
appointment or select and open an existing appointment from 
the appointment list. Press F2 and select Edit. In this dialog, 
press TAB until you hear, “Occurs combo box.” Use the cursor 
cross to select a pattern. If the default patterns in the list are not 
what you need, select <edit pattern…> to create your own 
pattern using the wizard. 

Setting a Reminder for an Appointment  
You can set a reminder for an appointment by following the 
steps above to create an appointment or by selecting and 
opening an existing appointment from the appointment list. Then 
press F2 and select Edit. In this dialog, press TAB until you 
hear, “Reminder combo box.” Use the cursor cross to select 
Remind me. 

You can also change how many minutes before the appointment 
you are reminded. To do this, press TAB again to access the 
Minutes combo box and use the cursor cross to make a 
selection.  

Note:  To set a reminder for all new appointments in the 
calendar, press F2 in the appointment list, move to 
Tools and press ENTER. Press ENTER on Options 
and select “Set reminders for new items.” 

If you want to be reminded about your appointments using a 
distinctive sound, go to the Start Menu (F3) and press ENTER 
on Settings. On the Personal tab select and press ENTER on 
Sounds & Notifications. Press TAB until you hear "Volume tab" 
then use the cursor cross to move to the Notification tab. Press 
TAB until you hear, “Play Sound check box,” then press the 
SPACEBAR to check this box. Last, press TAB again to move 
to the combo box that lists all the sounds available on your PAC 
Mate. 
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Adding a Note to an Appointment 
You can add additional information about an appointment if 
necessary.  
1. To add or edit a note, in the appointment list, select and 

press ENTER on the appointment.   
2. Press F2 and select Edit. Press SHIFT+TAB until you 

hear, “Notes button” and press SPACEBAR.  
3. Type in the additional information you want to include for 

that particular appointment. 
4. Press F1 to close the notes page and return to the 

appointment page. If you are done with filling in the 
appointment details, press F1 again to return to the 
appointment list. 

5. Later, when you open your appointment, the additional 
information is available for you to read.    

Sending a Meeting Request 
Use Calendar to schedule meetings with people who use 
Outlook or Pocket Outlook. When attendees receive a meeting 
request, they can accept or decline the meeting. If they accept, 
the meeting is automatically added to their schedule. In addition, 
their response is sent back to you, and your calendar is 
updated.  

Note:  Before you can send a meeting request, you must 
enter e-mail addresses for the Contacts you want to 
include in the meeting and set up Inbox to send and 
receive messages.  

1. From the Appointment list you can either create a new 
appointment or edit an existing appointment. 

2. In the Appointment page enter or edit the information and 
press TAB until you hear, “Attendees button.” 

3. Press the SPACEBAR to activate the button. 
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4. Use the cursor cross to move to the contact you want to 
invite. (Only those contacts with e-mail addresses will be 
displayed.)  

5. Press the SPACEBAR to select the contact.  
6. When you are done press ENTER to return to the 

Appointment page. To close the Appointment page and 
return to the Appointment list, press F1. 

7. Before you return to the Appointment list, you will be 
asked whether you want to send an e-mail to inform the 
attendees of the meeting. Press SPACEBAR to activate 
either the Yes button or No button.  

Inbox automatically creates a meeting request along with any 
textual notes entered in the Notes tab and sends it to the 
attendees the next time you synchronize with your PC.  

Note:  If you cannot synchronize with a PC, then you can 
send the meeting request through a connection to 
an ISP or the network. Press F2, move to Tools and 
press ENTER. Move to Options and press ENTER 
again. In the “Send meeting requests via,” select the 
service you want to use to send the meeting 
request. 

Finding an Appointment 
There are two ways to find an appointment:  
• Use the Find Feature found in the Start Menu. 
• In the calendar, press F2, move to Tools and press ENTER. 

Move to Categories and press ENTER again. Select the 
category of appointments you want displayed.  

Changing Options 
You can change Calendar options such as the first day of the 
week or when exactly do you want to be reminded of a new 
appointment, etc. To enter the Options dialog, press F2, move 
to Tools and select Options. Choose the settings that you want 
for your Calendar. 
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Note:  PAC Mate does not support Appointment icon 
indicators or “Use large font.”  

Using the Calendar View 
The Calendar View is a traditional style calendar in which you 
can easily check for appointments. The command to open the 
Calendar is SH CHORD, V. 

Description Command 
Back One Day DOT 3 CHORD or LEFT ARROW 
Forward One Day DOT 6 CHORD or RIGHT ARROW 
Back one Week DOT 2 CHORD 
Forward One Week DOT 5 CHORD 
Back one Month DOT 1 CHORD or UP ARROW 
Forward One Month DOT 4 CHORD or DOWN ARROW 
Back one Year DOT 1+UP ARROW 
Forward One Year DOT 1+DOWN ARROW 

When navigating by the smaller date changes, if the month, year 
or day of week changes, that component of the date is spoken. 
The PAC Mate announces when a date has an appointment 
associated with it. 

Press ENTER, TAB, or SHIFT+TAB while in the Calendar View 
to return to the Appointment List on the new date. 

Notes  
With Notes you can quickly capture your ideas and thoughts. In 
the Notes list view you can use the recording feature. You can 
also share your notes with others through e-mail, infrared, and 
synchronization with your PC.  

Note:  To create documents with advanced formatting or 
templates, such as bulleted lists and tabs, use 
FSEdit. 
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The table below lists the commands that are specific to the 
Notes program.   

Description Command 
Show By  SH CHORD, W 
Sort By  SH CHORD, Y 
Record V CHORD, R 
Stop Recording S 
Stop Playing Recording V CHORD, S 
Delete E CHORD, D 

Viewing Notes 
The Note list view displays a list of your notes and recordings. If 
you have a long list, press SH CHORD, Y (Sort By) and select 
the option you want to sort on. To open a note or play a 
recording, press ENTER on it. To see a list of available actions 
for a note or recording, select the note in the list view and press 
F2 CHORD.  

Creating or Editing a Note 
1. To create a note, F2 and press ENTER on New.  
2. Type your note. 
3. When finished, press F1 to return to the Notes list view.  

Note:  You can insert the date in a note. In an open note, 
press F2 CHORD and then select Insert Date. 

Creating a Template 
1. Create a note as you normally would.  
2. In the Notes list view, move to the note with the cursor 

cross and select it with the SPACEBAR.  
3. Press F2 CHORD.  
4. On the menu, select Rename/Move.  
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5. Press TAB move to the Folder list box, select Templates. 
The template is stored in the Templates folder under the 
All Folders list.  

Creating a Note with a Template 
1. Press F2 and choose Show By (labeled All Folders by 

default) and then select Templates.  
2. Press ENTER on the template you want to use and make 

your changes.  
3. Press F1 to close the note.  
4. In the notes list, select the note and press F2 CHORD, 

choose Rename/Move. Enter a new name and location for 
the note.  

Note:  To create a new folder, in the note or document list 
view, press F2 and select Show By, then press 
ENTER on Add/Delete.  

If you want to store the item on a storage card, insert the card 
into your PAC Mate and select Flash FXDisk from the Location 
combo box in the Rename/Move dialog. 

Creating a Recording 
Your PAC Mate has a voice-recording feature that has multiple 
sound and transmission rate settings. These settings reflect the 
quality and size of the recording file. Typically, a high sample 
size (Bit) and rate (Hz) equals a larger file size, which equals 
better fidelity. Since the PAC Mate has 64 MB of RAM, a 
recording set to 44,100 Hz, 16 Bit, Stereo (172 KB/s) is going to 
give the best recording quality, but with the least amount of 
recording time.  

Tip:  This setting is ideal if you are going to use audio 
editing software on the recording. 

You can synchronize recordings between your Pocket PC and 
your desktop PC. If you are unable to play them on your desktop 
PC, it may be due to the setting on your Pocket PC. In this 
situation, it is best to set your voice recording format to "8,000 
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Hz, 8 Bit, Mono (8 KB/s)." This gives you compatibility with your 
desktop sound player, acceptable voice recording fidelity and 
relatively small file sizes.  

Your PAC Mate is also equipped with an internal microphone, 
which is the round prominence above F3 Key. If you are truly 
concerned about recording fidelity, you can also purchase a 
high quality external microphone to fit into the 1/16 inch audio 
input jack. 

You can create a stand-alone recording from the Notes list view, 
using these recording commands.  
1. While in the notes list view, move the PAC Mate's 

microphone near the source of sound.  
2. When you are ready, press V CHORD, R to record. You 

will hear a single beep, which is your signal that recording 
has begun.  

3. When you are ready to stop, press S. You will hear a 
double beep, which indicates the recording has stopped.  

4. To play a recording, press ENTER on the recording in the 
notes list view.  

5. To stop playing the recording, press V CHORD, S.   

Or you can access the recording feature from anywhere on PAC 
Mate with the default hotkey command, ST CHORD, DOT 1. No 
other commands are necessary as this immediately starts the 
stand-alone recording. When you want to stop the recording 
press any key. Your recording is then saved in the Notes list 
view. To play the recording, just select it and press ENTER. To 
learn more about hotkey commands, please see Setting Up 
PAC Mate, Buttons. 

Finding a Note 
You can find a note by using the Find Feature or by pressing F2 
and choosing Show By. Then select and press ENTER on the 
folder you want displayed. To show all folders again, select All 
Folders. For more information on the Find Feature, please see 
Using Windows CE with PAC Mate, Using File Explorer. 
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Attaching a Note to E-mail 
In the Notes list view; select the note or recording and press F2 
CHORD. To select multiple notes or recordings, use the 
SPACEBAR+UP/DOWN ARROW. Then, press F2 CHORD. 
From the Context Menu, choose Send via E-mail.  

A new e-mail message is created with the note attached.  

If you are working offline, the message with the attached note is 
moved to the Outbox folder and will be sent the next time you 
connect.  

Synchronizing Notes 
Notes can be synchronized between your PC and PAC Mate 
either through notes synchronization or file synchronization. 
Notes synchronization synchronizes the notes on your PAC 
Mate with Outlook Notes on your PC. While File synchronization 
synchronizes all notes on your PAC Mate with the PACMate My 
Documents folder on your PC.  

To synchronize your notes through notes synchronization, first 
select the Notes information type for synchronization in 
ActiveSync. The next time you synchronize, all notes in My 
Documents and its subfolder on your PAC Mate will appear in 
Outlook Notes on your PC. Notes that contain only text will 
appear as regular notes in Outlook on your PC. In addition, all 
notes in the Notes group in Outlook on the PC will appear in 
Notes on the PAC Mate.  

To synchronize your notes as files, in ActiveSync, select the 
Files information type for synchronization and clear the Notes 
information type. When you select Files, the PACMate My 
Documents folder is created on your PC's Today Screen. All 
.pwi files placed in the My Documents folder on your PAC Mate 
and all .doc files placed in the PAC Mate My Documents folder 
on your PC will be synchronized. Password-protected files 
cannot be synchronized.  

ActiveSync converts documents during synchronization.  
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Note:  When you delete or change an item on either your 
PC or device, the item is changed or deleted in the 
other location the next time you synchronize. 

If you synchronize your notes using file synchronization and 
then later decide to use notes synchronization, all of your notes 
will be synchronized with Outlook on your PC and will no longer 
be stored in the PACMate My Documents folder. 

Pocket Internet Explorer 
The World Wide Web has a lot to offer. On any given day, at any 
given moment you can connect to the web and find interesting 
articles about any subject, you can buy almost anything and you 
can visit nearly every country. With Pocket Internet Explorer, you 
can download files, post to a listserv, access multimedia files, and 
even share resources and ideas with people who are located at 
opposite ends of the world. 

To open Internet Explorer, go to the Start Menu (F3), press I 
(DOTS 2-4) twice and then press ENTER (DOT 8). When Internet 
Explorer opens, PAC Mate begins reading your home page. To 
silence speech, press DOTS 6-8. Your initial home page is a 
default page, which has links to Pocket Internet Explorer’s Online 
Help, PocketPC.com, FreedomScientific.com, MSN Mobile and 
AvantGo. To move about links on a page, press TAB (DOTS 4-5 
CHORD) or SHIFT+TAB (DOTS 1-2 CHORD) and to open a page, 
press ENTER on the link.  

The following table lists General PAC Mate commands available 
for Pocket Internet Explorer. Many of these commands are layered 
so you can press the second command repeatedly without re-
pressing the initial command.  

Description Command 
Read Address Bar  A (DOT 1) 
Go To Address Bar G (DOTS 1-2-4-5) 
Back DOTS 2-4-6 CHORD 
Refresh Page  SH CHORD, R 

(DOTS 1-4-6 CHORD, DOTS 1-2-3-5) 
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Home Page SH CHORD, H 
(DOTS 1-4-6 CHORD, DOTS 1-2-5) 

Adjust HTML Settings H CHORD, V 
(DOTS 1-2-5 CHORD, DOTS 1-2-3-6) 

Favorites SH CHORD, F 
(DOTS 1-4-6 CHORD, DOTS 1-2-4) 

Hide Pictures  SH CHORD, P 
(DOTS 1-4-6 CHORD, DOTS 1-2-3-4) 

Reading and Moving through Web Pages 
PAC Mate can provide information about the structure and 
organization of web pages. Tables, headings, and alternate text 
for images are announced. This information helps you locate 
what you need quickly and take full advantage of web features. 

Text 
When you open a web page, PAC Mate announces the 
presence of frames, links, and headings then it begins speaking 
the text on the screen. Reading and moving through web based 
text uses the same reading commands as those used for text in 
a document. For more information on moving and reading text, 
please see PAC Mate Basics, Working with Text. 

Note:  If you start reading before a page completely loads, 
some of the page may not be available. 

Links  
Links allow you to move from one portion of a document to 
another or from one document to another. When reading a web 
page with the Virtual Cursor, PAC Mate places each link on its 
own line, even if Internet Explorer visually presents the link on a 
line with other text or additional links. 
• To move through the links on the page, press DOTS 4-5 

CHORD for the next link, and DOTS 1-2 CHORD for the prior 
link. 

• To open a link, press ENTER. 
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• To skip past a series of links, press H CHORD, T. PAC Mate 
moves to the first text of at least 25 characters that is not a 
link. 

When you move to a link with the Virtual Cursor, PAC Mate 
announces the type of link and the text of the link. PAC Mate 
announces the type of link as follows: 
• Link: This indicates a link that has not been visited. 
• Visited Link: This indicates a link that has been visited. 
• This Page Link: This indicates a link that moves you to 

another location on the same page. 
• Send Mail Link: This indicates a link that opens a new e-mail 

message using your default e-mail program. The To field of 
the new e-mail is already filled out, and the Subject field is 
sometimes filled out as well. 

• FTP Link: This indicates a link that points to an FTP (File 
Transfer Protocol) server. Usually, these links are to files, 
and when you select them, Internet Explorer displays a dialog 
asking if you want to save the file to your computer. 

PAC Mate announces when a graphic is used as part of a link. 
Image Map Links are also announced. Image map links are part 
of an image. A small section of the image is mapped out to 
represent a "hot spot" that is normally clicked with the mouse. 
PAC Mate moves to image map links the same way it does to 
other links. 

PAC Mate provides configuration settings for links, so you can 
determine what information and how much information you wish 
to hear: 
• By Default, PAC Mate speaks the on screen text of a link, but 

you can set PAC Mate to instead speak Title text, assigned 
by the page author within the HTML code. Title text normally 
provides supplemental information about the link. 

• By default, PAC Mate announces the link type, but you can 
disable this, so PAC Mate announces same page links, send 
mail links, and ftp links as "link," or "Visited Link." 
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To change these settings temporarily, press H CHORD, V. To 
change them permanently, press F3, S to open the Settings 
Dialog, and change the HTML settings as appropriate. 

Use the Links List dialog to quickly locate and select links on a 
web page. Press H CHORD, S to open the Links List. Press UP 
ARROW or DOWN ARROW, or the first letter of a link's text to 
move through the list of links, and press ENTER to open a link. 

You can also move through the controls in this dialog by 
pressing TAB. There are buttons to move to the location of a 
link on the page or to open a link. There are radio button groups 
to filter and sort the links that display in the list. 

Below is a table that lists the commands available for navigating 
links. 

Description Command 
Next Link DOTS 4-5 CHORD 
Prior Link DOTS 1-2 CHORD 
Link List H CHORD, L 

(DOTS 1-2-5 CHORD, DOTS 1-2-3) 
Move to Next 
Non-Link Text 

N (DOTS 1-3-4-5) 

Headings 
IN HTML, headings are used to indicate the start of sections and 
subsections of a page so that the relationship between 
information within sections and subsections is clear when 
reading the page. When viewing all headings on a page, if the 
headings are used properly, the hierarchy of the heading levels 
indicates how the page is structured. This makes it easier to find 
information and understand the relationships within the 
information. Below is a table that lists the commands used to 
move by headings. 

Description Command 
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List Headings H CHORD, H 
(DOTS 1-2-5 CHORD, DOTS 1-2-5) 

Next Heading H (DOTS 1-2-5) 
Prior Heading DOTS 1-2-5-7 
First Heading H CHORD, UP ARROW 
Last Heading H CHORD, DOWN ARROW 

PAC Mate recognizes headings at levels 1 through 6 and 
announces them as you move through the page or read using 
Say All. Press H CHORD, RIGHT ARROW to move to the next 
heading, or press H CHORD, LEFT ARROW to move to the 
prior heading. To move to the first heading on the page, press H 
CHORD, UP ARROW. To move to the last heading, press H 
CHORD, DOWN ARROW. 

The Headings List dialog lists headings on the current page and 
indicates the heading level. Press UP or DOWN ARROW to 
move through the list. Press ENTER to move to the location of 
the selected heading on the web page. 

Headings are announced as you navigate through a web page, 
but if you want, you can turn this announcement off. To 
temporarily turn off heading announcement, press H CHORD, V 
to open the Verbosity dialog and move to Indicate Headings. 
Press SPACEBAR to turn off this setting. 

To permanently change this setting: 
1. Press F3 to open the Start Menu. 
2. Press S to open the Settings Dialog. 
3. Press TAB until you reach the combo box labeled 

"Headings Verbosity." 
4. Press UP or DOWN ARROW to select the setting you 

want. 
5. Press ENTER to close the HTML Settings Dialog. 

The HTML heading navigation features are extremely useful on 
pages that use headings as they are intended. However, many 

440060-001 Rev. A  109 



 

web pages are written that do not properly use headings. The 
heading navigation features may not be as useful on these 
pages. 

Tables 
PAC Mate provides commands that allow you to move within 
tables. In addition, when you use table navigation commands 
you can get information about the position of table cells and the 
structure of tables on a page. The following table lists the 
commands used to navigate tables in Pocket Internet Explorer. 

Description Command 
Read Current Cell H CHORD, C 
Next Cell DOT 8+RIGHT ARROW 
Prior Cell DOT 8+Left ARROW 
Cell Above DOT 8+UP ARROW 
Cell Below DOT 8+DOWN ARROW 
First Cell DOTS 1-3-8 
Last Cell DOTS 4-6-8 

When you move through a web page, PAC Mate announces the 
start of tables, and the number of columns and rows, and reads 
the summary, if a summary is available.  

A table summary provides information about the purpose of the 
table. If a summary is provided, PAC Mate says, "Summary," 
and reads the summary text. 

When you navigate tables using standard reading commands, 
PAC Mate reads the cells in order from left to right and behaves 
as if each table cell begins on a new line. PAC Mate does not 
identify table headers or provide information about table 
structure when you navigate in this manner. 

To hear information about the current table cell, press H 
CHORD, C. PAC Mate announces the row and column position, 
the current row and column headers, and the contents of the 
cell. 
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When you move to the next or prior cell in the same row using 
table navigation commands such as DOT 8+RIGHT ARROW or 
DOT 8+LEFT ARROW, PAC Mate reads the column header, 
the data in the cell, and the column number. 

To move to the cell above or below the current cell, press DOT 
8+UP ARROW or DOT 8+DOWN ARROW. PAC Mate reads 
the row header, the data in the cell, and the row number.  

Note:  PAC Mate does not identify row or column headers 
when you navigate tables using standard reading 
commands with the Virtual Cursor or when using 
Say All. 

Forms 
HTML forms on web pages allow you to enter information and 
send it to another computer. Examples of forms include 
shopping carts, feedback forms, and web-based e-mail and 
bulletin boards. 

Forms are collections of controls such as check boxes, combo 
boxes, edit fields, and radio buttons. The following table lists 
PAC Mate commands used to move through form fields on a 
web page. The following table lists the commands used to 
navigate forms in Pocket Internet Explorer. 

 

Description Command 
Next Field F (DOTS 1-2-4) 
Prior Field DOTS 1-2-4-7 
First Field DOT 7+UP ARROW 
Last Field DOT 7+DOWN ARROW 

To enter text into a form field, move the Virtual Cursor to a form 
field, and press ENTER to switch to Forms Mode. PAC Mate 
says, "Forms Mode On," the information and the name of the 
control you are on. When you press ENTER to go into Forms 
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Mode, the PC cursor is activated on the current control. If the 
field is an edit field, the cursor is placed at the top of the field. 

To navigate within an edit field while in Forms Mode, use the 
UP, DOWN, LEFT and RIGHT ARROW as you normally would. 
To move to the next form field while in Forms Mode, press TAB. 
To move to the previous field, press SHIFT+TAB. 

To exit Forms Mode, press X CHORD. 

To check a check box or radio button on a form, press ENTER 
when the Virtual Cursor is on the item. If you are on a check 
box, the state of the check box is toggled. If you are on a radio 
button that is unchecked, the radio button is checked, however, 
if it was already checked, it remains unchanged. 

If you enter Forms Mode in a Combo box, the first item is 
selected. To change the selection, press UP or DOWN 
ARROW. 

Tip:  In some forms, changing the selection in a combo 
box opens a new page automatically. To work with 
these combo boxes, press DOT 7+DOWN ARROW 
to open the list of choices. Then move to an item 
and press ENTER to make your selection. 

PAC Mate attempts to associate each form field with a textual 
prompt. PAC Mate can identify when a prompt is specifically 
associated with a control, and speaks the correct prompt when 
you move to that control. If no prompt is specifically associated 
with a control, PAC Mate attempts to identify text positioned 
near the control as the prompt. This is most accurate when the 
text is directly to the left or right of the form control. 

Forms on some web pages are not written with accessibility in 
mind, and PAC Mate cannot obtain enough information to read 
the form controls properly. If PAC Mate does not read form 
controls correctly while you are in Forms Mode, reading the form 
with the Virtual Cursor may provide additional helpful 
information. Press ENTER to turn Forms Mode on and fill in a 
form field. Then press X CHORD to exit Forms Mode and 
continue reading the form with the Virtual Cursor. 
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Changing Your Home Page 
If you want another web page as your home page, press G to 
move to the Address Bar and type in the address of the page. 
When you are done, press ENTER to go to that page. 

Next, press F2 to open the menu, and press ENTER on Tools. 
With the Tools Menu open, press ENTER on Options. The first 
controls in the Options dialog are two buttons, one labeled Use 
Current and one labeled Use Default. To have the web page 
currently opened as your home page, press ENTER (DOT 8) on 
the Use Current button.  

Changing Security Options 
Pocket Internet Explorer supports the security protocols used by 
secure pages. When accessing a secure page, you can send 
personal information safely. To determine if a page is secure, 
press F2, move to View and press ENTER. Select Properties.  

To change security settings, press F2, move to Tools, and press 
ENTER. Go to Options and press SHIFT+TAB (DOTS 1-2 
CHORD) to move to the General tab, then press the RIGHT 
ARROW to move over to the Advanced page.  

Cookies contain information about your identity and preferences 
so that a page can tailor information to your needs. To prevent 
Pocket Internet Explorer from accepting cookies, use the 
SPACEBAR to uncheck the Allow cookies check box. 

Synchronizing Favorite Links 
In ActiveSync on your PC, press ALT+T to open the Tools 
Menu. Press ENTER on Options. In the Options dialog list view, 
move to Favorite and place a check in the box.  

In Internet Explorer on your PC, save or move favorite links to 
the Mobile Favorites subfolder in the Favorites list.  

Connect your mobile device to your PC. If synchronization does 
not start automatically, in ActiveSync on your PC, press ALT+F 
and press ENTER on Synchronize.  
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Note:  If you add or delete a favorite link in the Mobile 
Favorites folder on your device, the next time you 
synchronize, the same change is made on the PC. 

Viewing Favorites 
If favorite pages are not synchronized using a schedule for 
synchronization, in Internet Explorer on your PC, go to Tools 
(ALT+T) and select Synchronize.  

On PAC Mate, press F2, move to Favorites, and press ENTER.  

Use the cursor cross to select the page that you want to view 
and press ENTER.  

Note:  If you get a message that the page is not available, 
you must download the page to your device through 
synchronization or connect to the Internet. 

To quickly stop pictures and sounds from downloading, press 
F2, move to Hide Pictures, and press ENTER.  

Adding/Deleting a Favorite Link 
Go to the page you want to add. Press F2 and press ENTER on 
Favorites. Press SHIFT+TAB to move from the Open Favorites 
page to the Open Favorites tab. Next, press the RIGHT 
ARROW to move to the Add/Delete tab. Press TAB to move to 
the Add button and press ENTER. When the next page opens, 
press ENTER on the Add button again. 

Note:  To add a new folder, go to the Add/Delete page, 
press ENTER on the New Folder button. Enter a 
name for the folder, and press ENTER the Add 
button again. 

To delete a link, the steps are the same except that you first 
select the link that you want to delete in the Add/Delete page, 
then move to the Delete button and press ENTER. The link is 
then deleted. 

Note:  Only the link to the page is deleted, not the page 
content stored on your device. To delete the page 
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itself, press F2 move to Tools, and press ENTER. 
Select Options. On the General tab press ENTER on 
the Delete Files button. 

FSEdit 
FSEdit is a word processing application that you can use to create 
and edit documents. Unlike Pocket Word or Notes, FSEdit was 
created specifically for the blind user. Among its friendly and 
convenient features, you will find FSEdit allows you to work with 
Grade 2 Braille files, provides a robust editing environment 
complete with a spell checker, and offers the facility to not only 
print, but emboss as well. 

The default location for FSEdit is the Programs submenu (F3, P, F, 
F, F). When you open FSEdit for the first time or when you create a 
new document, you are asked, “Would you like to make your new 
file a Grade 2 Braille document?” If you choose No, your file is then 
a Computer Braille document. Once you create a Computer Braille 
file, you cannot change it to Grade 2 Braille or vice versa. Instead 
you must create a new file and choose Yes when asked, “Would 
you like to make your new file a Grade 2 Braille document?” This, 
however, does not mean you cannot change how your document is 
embossed. Please see FSEdit, Computer Braille vs Grade 2 Braille 
for more information. 

The table below lists all the commands available in FSEdit. 
File Menu Shortcuts 
Open File SH CHORD, O 

(DOTS 1-4-6 CHORD, DOTS 1-3-5) 
Save File SH CHORD, S 

(DOTS 1-4-6 CHORD, DOTS 2-3-4) 
Edit Menu Shortcuts 
Set Mark E CHORD, M 

(DOTS 1-5 CHORD, DOTS 1-3-4) 
Select to Mark E CHORD, S 

(DOTS 1-5 CHORD, DOTS 2-3-4) 
Switch Cursor and E CHORD, W
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Mark Positions (DOTS 1-5 CHORD, DOTS 2-4-5-6) 
Select Word Q CHORD, W 
Select Sentence Q CHORD, S 
Select Line Q CHORD, L 
Select Paragraph Q CHORD, P 
Find E CHORD, F 

(DOTS 1-5 CHORD, DOTS 1-2-4) 
Replace E CHORD, R 

(DOTS 1-5 CHORD, DOTS 1-2-3-5) 
Insert Menu Shortcuts 
Insert Date and Time I+DOT 8, D 

(DOTS 2-4-8, DOTS 1-4-5) 
Insert Numbering I+DOT 8, N 

(DOTS 2-4-8, DOTS 1-3-4-5) 
Spelling 
Spell Check CH CHORD, S 

(DOTS 1-6 CHORD, DOTS 2-3-4) 
Read Word in Context CH CHORD, C 

(DOTS 1-6 CHORD, DOTS 1-4) 
Read Mistake and 
Suggestion 

CH CHORD, R 
(DOTS 1-6 CHORD, DOTS 1-2-3-5) 

Saving a Document 
If the file you want save has the correct name, is in the correct 
file format, and in the correct folder, you can simply press SH 
CHORD, S and your file will be saved. 

If, however, you want to save the file with another name, with a 
different file format, or in another folder, you will have to open 
the File Menu (SH Sign, F) and select Save As. In the Save As 
dialog you can change any parameter of the file. Use the TAB 
command to navigate this dialog. Below lists the options 
available in each combo box in the Save As dialog. 
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Folder combo box: The default is None, which means that you 
file will be saved in the default folder, My Documents. The other 
folder options, listed below, are subfolders of the My Documents 
folder. 
• None 
• Business 
• Personal 
• Templates 

File Type combo box: FSEdit offers a nice variety of file types 
that easily match your working needs. In addition, FSEdit’s own 
the default file type, .fsd, allows for synchronization to your PC, 
storage of additional information such as Grade of Braille, cursor 
location, mark location, and Grade 2 back translation for easy 
conversion between the other file types supported by FSEdit.  
• *.fsd 
• *.brl 
• *.brf 
• *.rtf 
• *.psw 
• *.txt 

Location combo box: 
• Main Memory 
• Internal FlashDisk 
• Storage Card 

Revert To Saved  
This menu item reloads the last saved version of the document 
and discards any succeeding editorial changes. 

Opening a Document  
1. To launch the Open File dialog, press SH CHORD, O. 
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2. Press SHIFT+TAB to move into the list view of files, and 
then use the arrow keys to make your selection. 

3. When find the file you want, press TAB to move over to 
the OK button and then press ENTER. 

4. If the file is not stored in the current folder, press TAB until 
you hear, “Folder list box,” then use the arrow keys to 
choose the folder in which the file is stored. 

5. If the folder is not in the current location, press TAB until 
you hear, “Location list box,” then use the arrow keys to 
choose the location in which the folder is stored. 

6. If the file is of another file type, press TAB until you hear, 
“Type list box,” then use the arrow keys to choose the file 
type.  

Connecting to an Embosser 
Before you can emboss a document, you must first select your 
embosser type in the Properties dialog, which is accessed from 
the Emboss dialog.  

When you select your embosser, many of the fields in the 
Properties dialog automatically populate with your embosser’s 
default settings. This means you can immediately begin 
embossing your document or you can change the embossing 
settings.  

To launch the Properties dialog: 
1. Press SH CHORD, F to open the File Menu. 
2. Use the arrow keys to move to Emboss and press ENTER 

to launch the Emboss dialog.  
3. Use TAB to move to the Properties button and press 

ENTER to open the Properties dialog. 
4. When this dialog opens, press TAB once to place your 

cursor in the Embosser combo box. This combo box lists 
embossers that are compatible with FSEdit. Use your UP 
or DOWN ARROW keys to select your embosser. 

5. If you are satisfied with the automatic settings of your 
embosser, you can press ENTER to return to the 
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Embosser dialog. If not, press TAB to move to each field 
and adjust the setting. When you are done, move to the 
OK button and press ENTER. 

6. In the Embosser dialog, press TAB until you hear, 
“Connection button” and press ENTER. 

7. Use your UP or DOWN ARROW keys to select the port 
connecting your embosser.  

8. If you select Windows Device, press TAB to move to the 
Location edit box. Type in the network path of the 
embosser. For example: \\server\my embosser. 

9. Press ENTER or select the Ok button to return to the 
Emboss dialog. 

Embossing a Document 
Embossing a document is initiated from the Emboss dialog. To 
launch the Emboss dialog you must open the File Menu (SH 
CHORD, F) and select Emboss (E). With the Emboss dialog 
open, you have several controls that allow you to change the 
way your document is embossed. If you do not want to change 
any of the parameters and are ready to emboss, press TAB until 
you reach the Ok button and then press SPACEBAR. 

Number of Copies 
Unless you specify the number of copies embossed, FSEdit will 
only emboss one copy of a document.  

To emboss more than one copy of a document: 
1. Press SH CHORD, F, E to open the Emboss dialog.  
2. Press TAB until you hear “Number of copies one.”  
3. Type in the number of copies to be embossed. 
4. Once you have selected your number, you can change 

more emboss parameters or press TAB to move to the Ok 
button. Press ENTER to print your document. 
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Emboss Settings 
Depending on your needs, you may want to emboss on different 
size paper. Changes made to the embossing settings are 
retained until you change them or reset them to their defaults. 

For 8.5 x 11 inch paper, use the following settings:  

Cell Per Line: 34 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 34 
Max Lines Per Page of Embosser: 27 

For 11.5 x 11 inch paper, use the following settings:  

Cell Per Line: 40 
Lines Per Page: 25 
Top Margin in lines: 0 
Max Cells Per Line of Embosser: 42 
Max Lines Per Page of Embosser: 27 

Changing Emboss Settings 
1. Press SH CHORD, F, E to open the Emboss dialog.  
2. Use TAB to move to the Properties button and press 

ENTER to open the dialog. 
3. Press TAB to move to the Set Cell Per Line To edit box. 

Type the number of Braille cells you want in each line. 
4. Press TAB to move to the Set Lines Per Page To edit box. 

Type the number of lines you want on each page.  
5. Press TAB to move to the Set Top Margin in lines to edit 

box. Type the number of lines you want to set for your top 
margin.  

6. Press TAB until you hear, “Max Cells Per Line of 
Embosser edit box.” Type the absolute maximum number 
of cells you want on each line.  

7. Press TAB to move to the Max Lines Per Page of 
Embosser edit box. Type the absolute maximum number 
of lines you want on each page.  
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8. Press TAB to move to the Margins for Interpoint check 
box, use the SPACEBAR to place a check in the box. 

9. Press TAB to move to the Pages for Interpoint check box, 
use the SPACEBAR to place a check in the box. 

10. Press ENTER on the Ok button to emboss your document. 

Resetting the Embosser’s Default Settings 
1. Press SH CHORD, F, E to open the Emboss dialog.  
2. Use TAB to move to the Properties button and press 

ENTER to open the dialog. 
3. When this dialog opens, press TAB once to place your 

cursor in the Embosser combo box. Use your UP or 
DOWN ARROW keys to select another embosser. 

4. Reselect your embosser. The default settings will 
repopulate each field. 

5. Press ENTER on the Ok button to return to the Emboss 
dialog. 

Computer Braille vs. Grade 2 Braille 
Regardless of whether you created a Computer Braille or Grade 
2 Braille file, FSEdit’s default setting sends text to your 
embosser in Grade 2 Braille. If necessary, you can emboss a 
Computer Braille file in Computer Braille. You cannot, however, 
emboss a Grade 2 Braille file in Computer Braille. 

To emboss a Computer Braille file in Computer Braille: 
1. Press SH CHORD, F, E to open the Emboss dialog.  
2. Press TAB until you hear, “Grade 2 checked.” A check in 

this box means the document will emboss in Grade 2 
Braille. To emboss in Computer Braille, press SPACEBAR 
to uncheck this box. 

3. Once you have selected the Braille language, you can 
change more emboss parameters or press TAB to move 
to the Ok button and then press ENTER to emboss your 
document. 
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Printing in FSEdit 
In this release of FSEdit, the ability to print from PAC Mate 
directly to a printer is not implemented. Instead, you must 
synchronize your FSEdit documents to a desktop computer or 
laptop and then print your documents on their printer. Included 
on the User’s Documentation CD is WinPrint.exe. This program 
uses whatever printer is installed on the PC to print out .brl files 
as text files. WinPrint recognizes all format characters 
documented.  

To use WinPrint: 
1. Transfer your .brl file to the PC with ActiveSync. 
2. Select and open the .brl file – WinPrint automatically 

launches. 
3. Press CTRL+P to print the file. 

Mark Emphasis Text 
Emphasis text is text that is bold, underlined and/or in italics. 
This item (enabled by default and only available when 
embossing in Grade 2 Braille) indicates when text has 
emphasis.  

Disabling Mark Emphasis Text 
1. Press SH CHORD, F, E to open the Emboss dialog.  
2. Press TAB until you hear, “Mark Emphasis Text.” 
3. A check in this box means bold, underline and/or italic text 

is marked.  
4. If you want to emboss without marking Emphasis Text, 

press SPACEBAR to uncheck this box. 
5. To emboss your document, press TAB to move to the Ok 

button and then press ENTER.  

Selecting Text vs. Marking Text 
While these two features, selecting text and marking text, use 
very different approaches, they do perform virtually the same 
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function. The difference, however, is that with Marking Text you 
can accurately mark text and have the added advantage of 
being able to freely read your document until you find the 
word(s) you want to mark inclusively. Whereas when you select 
text, you must move linearly in a fixed increment until the block 
of text you want is selected. This may result in more editing, as 
some unwanted text might get selected. 

Marking Text 
1. Set the mark at the location of the cursor by opening the 

Edit Menu and pressing ENTER on Set Mark or by 
pressing E CHORD, M. 

2. Move the cursor to a different location in the document. 
3. Choose Select to Mark from the Edit Menu or press E 

CHORD, S to select all the text between the mark and the 
cursor. 

Switching Mark and Cursor Positions 
On occasion you may find it helpful to review the information 
you have selected. Or you may find that you want to select text 
that is beyond the marked end. To do this easily, swap the 
position of the mark and cursor. You can find this feature in the 
Edit Menu or simply press E CHORD, W. 

Selecting Text 
In addition to all the selecting commands available in PAC Mate, 
FSEdit has its own Quick Select commands. The Quick Select 
commands let you select text in five different increments. You 
can find these options in the Edit Menu under the Quick Select 
submenu or you can press the following shortcut commands.  

Word Q CHORD, W 

Sentence Q CHORD, S 

Paragraph Q CHORD, P 

Line Q CHORD, L 

Entire Document Q CHORD, D 
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Find 
The Find feature is a very handy tool that lets you search for a 
word or phrase within an open document quickly. When you 
press F CHORD, F, FSEdit launches the Find dialog with the 
cursor in the Find What edit box. Type in the word or phrase you 
want to find. Use the TAB key to navigate the dialog. Other 
controls in this dialog that are available are Find Whole Words 
Only, Match Case, and Search Direction.  

When you are ready, press ENTER on the Find Next button.  

Replace  
The Replace menu item (F CHORD, R) is similar to the Find 
feature in that it searches for words or phrases within a 
document, but it has the additional feature of replacing words or 
phrases with alternative text. Its dialog is similar to the Find 
dialog but has two additional buttons. The Replace button, 
which replaces one instance of the word or phrase and the 
Replace All button, which replaces all instances of the word or 
phrase in the document.  

Formatting a Document 
In FSEdit makes formatting a document very easy. Most 
formatting options available can be directly accessed from the 
two submenus in the Format Menu.  

To format a document: 
1. Press F2, then F twice to move the Format menu and 

press ENTER to open the Format menu. 
2. On the Format menu you have two choices: Font and 

Paragraph. Each opens a submenu when you press 
ENTER. 

3. The Font submenu options include: bold, italic, underline, 
strikethrough, and more options. In order to use the bold, 
italic, underline and strikethrough options you must first 
select the text using one of the three method available: 
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• Windows standard. Hold down the Shift key and press 
the arrow keys (or equivalent Braille keystroke). 

• Select specific unit. Choose one of the following items 
from the Edit/Select submenu: Word, sentence, 
paragraph, line, and entire document. 

• Mark method. 
4. The Paragraph submenu options include: align left, align 

center, align right, justify, increase indent, and decrease 
indent. 

5. If you select more from the Font submenu you launch a 
Font dialog. From here you can select a different font type, 
font style, font size, and font effect. 

Inserting Text 
The next three items can be found in the Insert Menu (SH sign, 
I). 
• Insert File Text: Lets you grab the text from another file and 

paste it into your FSEdit document. 
• Date/Time Stamp: Lets you insert the date: Time is not 

supported at this time. (I+DOT 8, D) 
• Bullet and Numbering: You must go into the Options dialog in 

the Tool Menu and select a format. (I+DOT 8, N) 

Checking Spelling 
You can check the spelling of a specific word, or of all the words 
in a document. If a word is spelled correctly, but not recognized, 
you can add the word(s) to FSEdit’s online dictionary. To launch 
the Spell Checker dialog, press CH CHORD, S.  

Once the Spell Checker dialog opens, your cursor is in the 
Change To box on a word from the Suggestions List. At this 
point, you have several options to choose from. Use the TAB 
key to navigate the dialog and press ENTER on the control that 
performs the particular action you want. When you encounter 
the Suggestions List box, use the UP or DOWN ARROW keys 
to make your selection.   
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Word Count  
When you want to know the number of words in a document, 
press F2 move to Tool and press ENTER. Then move and 
press ENTER on Word Count  

FSCalc 
FSCalc is a scientific, engineering, and financial calculator. The 
calculator includes functions for statistics, metric units conversions 
and physical properties and constants.  

Entering Equations and Expressions 
You can choose to enter an equation or expression using the 
menu (F2) or by typing it with the keyboard. In either case, you 
must enter variables, operators, and functions in Computer 
Braille. Anytime you solve an equation or expression, you must 
follow conventional math rules such as the order of operations. 
• Parenthesis and Brackets - Simplify the inside of parenthesis 

and brackets before you deal with the exponent (if any) of the 
parenthesis or remove the parenthesis.  

• Exponents - Simplify the exponent of a number or of a 
parenthesis before you multiply, divide, add, or subtract it.  

• Multiplication and Division - Simplify multiplication and 
division in the order they appear from left to right.  

• Addition and Subtraction - Simplify addition and subtraction in 
the order they appear from left to right. 

Variables can be any combination of letters (a-z) and digits (0-
9). Standard operations are entered in the form a+b, with no 
spaces. For example, x=7, y=9, x+y, f+10.  

Operators modify the value stored in a variable. 

Expressions are any combinations of numbers, variables, 
operators and functions.  

Functions consist of a name followed by a comma-separated list 
of arguments enclosed in parentheses. If you choose to type the 
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function instead of selecting it from the menus, be sure that you 
type it without spaces. 

Once you have entered the equation or expression, press 
ENTER for the result.  

If you select a function from the Functions Menu, anything 
selected on the current line is treated as an argument, i.e., 
placed in parentheses.  

When you press ENTER to calculate an operation, PAC Mate 
speaks and selects the result. If you type a new number or 
entry, it replaces the result with the new entry. If you type an 
operator, the result become part of the new operation and the 
insertion point is placed at the end of the operation, ready for 
you to finish your calculation. 

Reviewing the History 
Once you have entered a calculation(s) you can sequentially 
review the steps taken or the equations entered by pressing the 
UP ARROW to move backward or DOWN ARROW to move 
forward. 

Saving the Calculation 
At anytime, while working through a calculation, you can save 
your work as a .txt file. Press SH CHORD, S to save the file in 
the current folder with the current name in the current location or 
open the File Menu and select Save As. Type a new file name, 
use the TAB command to move to the Folder combo box, and 
press the DOWN ARROW to select a folder. Press TAB again 
to move to the Location combo box and press the DOWN 
ARROW to select a location.  

Clearing the Calculator 
With FSCalc you can clear three items in the calculator: clear 
current line (0 CHORD), clear the history (SH CHORD, H), or 
clear the variables (SH CHORD, V). You can find these three 
items in the Edit Menu as well. 
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Examples 
Algebra Question: Simplify the following expression 2+(3-1)*32.  
1. Following the order of operations, simplify the term inside 

the parenthesis first. In the edit window of FSCalc, type in 
computer Braille 3-1, then press ENTER. 

2. Next, type p w r ( 3,2 ) or press F2, F, ENTER to open the 
Functions Menu, then press ENTER on the Trig submenu 
and select Pwr. Pwr(2) will show automatically in the edit 
window so all you need to do is press the LEFT ARROW 
twice and type 3,. When you are done, press ENTER. 

3. The next order of operations to solve for is the answer 
from step 2 multiplied by the answer from step 1, which is 
(2)*9. If you cannot remember the answer from step 1, you 
can use UP ARROW to review each step taken in this 
expression. Select and copy the answer “2” by pressing 
DOTS 3-7 CHORD, E CHORD, C. Use the DOWN 
ARROW to move to the last operation, which was 9, press 
DOTS 1-6 and paste the “2” with E CHORD, P. When you 
are done, press ENTER. 

4. The last step to simplifying this expression is to add 2 
to18. Press DOTS 3-4-6 so expression now becomes 18+ 
and type DOTS 2-3, ENTER. (Answer = 20) 

5. Review the calculations for any errors by pressing the UP 
ARROW.  

6. Press F2, F, ENTER and choose Save As to name and 
save this calculation as a .txt file.  

7. Press SH CHORD, H to clear the history. 

Statistical Question: Find the average, standard deviation and 
sum from the following data. Data Set (6,8,9,10,2) 
1. Type a v g ( 6,8,9,10,2 ) and press ENTER. Or press F2, 

F, ENTER. With the Functions Menu opened move to the 
Stat submenu and press ENTER. Press ENTER again on 
Avg. Now type 6,8,9,10,2 and press ENTER. (Answer = 7) 

2. Use the UP ARROW and DOTS 1-3-7 CHORD, E 
CHORD, C to move, select and copy (6,8,9,10,2). Press 
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the DOWN ARROW once and BACKSPACE (DOT 7) 
over the 7, then paste the selected text. Move to the 
beginning of the line with DOT 3+LEFT ARROW and type 
s t d d e v. When you are done press ENTER. (Answer = 
2.82843) 

3. Clear the current line, 2.82843, with 0 CHORD. Press E 
CHORD, P and DOT 3+LEFT ARROW to paste the 
selected text that is still on the clipboard and move to the 
beginning of the line. Type s u m and press ENTER. 
(Answer = 35) 

Accounting Question: Your financial advisor is recommending 
that you invest $5000.00 in a particular fund for 10 years. He 
says that the annual rate of return is 7.18%. In order to make an 
informed decision, you need to find out how much your money 
would be worth in 10 years. 

To solve this problem you need to have some knowledge of the 
relationship between the rate of interest (r), time (t), the present 
value (pv) and the future value (fv) of the dollar. The relationship 
is as follows: 

fv=pv*(1+r)t 

pv = 5000   r = 0.0718  t = 10 years   fv = ? 

To help you grasp the concept, open Notes and take the 
variables above and plug them into the formula: fv = 
5000*(1+.0718)10.  You can solve this problem using the order 
of operations or you can use the financial functions in FSCalc. 

 

Using the order of operations: 
1. Solve 1+.0718 first.  
2. Press F2, F, ENTER to open the Functions Menu. From 

the Trig Menu select and press ENTER on Pwr.  
3. The edit window now reflects the following: pwr(1.0718). 

Because the cursor is outside the parentheses, you need 
to press the RIGHT ARROW once and finish the function 
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by pressing DOT 6, DOT 2, DOTS 3-5-6, ENTER. (Answer 
= 2.0005) 

4. Last, solve for fv by multiplying the future value factor, 
(1+r)t = 2.0005, and the present value = $5000.00. 
(Answer = $10,000) 

Using FSCalc: 

Note: When using the financial functions of FSCalc, you 
must list your known variables in the following order: 
fv(pv,r,t)     pv(fv,r,t) 

1. First clear the history with SH CHORD, H. 
2. Press F2, F, ENTER. From the Functions Menu, open the 

financial submenu and press ENTER on fv. 
3. The edit window now has fv(). Inside the parentheses, 

type 5000,.0718,10. When you are done press ENTER. 
(Answer = $10,0002.5) 

Accounting Question: You are concerned about your retirement. 
You want to know how much you have to invest today in order 
to accumulate $1 million dollars by time you are ready to retire. 
You have found an annuity that that is paying 10% return. You 
figure that you will retire in about 35 years.  

Using Notes, list out your known variables and set up your 
problem.   

fv = $1 million  r = 0.10  t = 35 years  pv = ? 

fv=pv*(1+r)t 

1000000=pv*(1+.10)35 
1. Press F2, F, ENTER. From the Functions Menu, open the 

financial submenu and press ENTER on pv. 
2. The edit window now has pv(). Inside the parentheses, 

type 1000000,.10,35. When you are done press ENTER. 
(Answer = $35,584.10) 

Arithmetic Question: You are shopping for a new desktop 
computer and have found one for $875.00. The computer store 
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salesman tells you that the special going on is 35% off all 
computers storewide. How much is the computer you picked 
out? 
1. In the edit window type 875*35% in computer Braille. 
2. When you are done press ENTER.  
3. Now, subtract $306.25 from $875.00 (Answer = $568.75) 

Conversion Question: The winter of 2002-2003 is reputed to be 
one of the coldest winters on record. To substantiate this your 
friends from Syracuse, New York call to tell you that the 
temperature outside is –25 degrees Celsius and the wind is 
blowing at 10 miles per hour. What is the temperature in 
Fahrenheit and the wind chill factor?  
1. Press F2, F, ENTER. From the Functions Menu select and 

press ENTER on Conversions. In the submenu select and 
press ENTER on Celsius to Fahrenheit. 

2. Press DOTS 3-6, DOTS 2-3, DOTS 2-6 and ENTER. 
(Answer = -13 degrees Fahrenheit) 

3. Next, go back into the Conversions submenu and press 
ENTER on Wind Chill. The edit window now has wc(-13). 

4. Press RIGHT ARROW once to move inside the 
parentheses and press DOT 6, DOT 2, DOTS 3-5-6, 
ENTER. (Wind Chill = -37.2555 degrees Fahrenheit) 

Operators 
Name Symbol 
Plus + (DOTS 3-4-6) 
Minus - (DOTS 3-6) 
Times * (DOTS 1-6) 
Divided by / (DOTS 3-4) 
Percent % (DOTS 1-4-6) 
Assignment = (DOTS 1-2-3-4-5-6) 
 
 

440060-001 Rev. A  131 



 

Arithmetic Functions 
Description Name 
Absolute value Abs() 
Reciprocal recip() 
Round round() 
Integer part trunc() 
Statistical Functions 
Sum of any number of 
arguments 

sum() 

Average of any number of 
arguments 

avg() 

Standard deviation of any 
number of arguments 

stddev() 

Median of any number of 
arguments 

median() 

Minimum of any number of 
arguments 

min() 

Maximum of any number of 
arguments 

max() 

Trigonometric Functions 
Arccosine sine acos()   
Arcsine   asin()   
Arctangent tangent atan()   
Arctangent of x/y atan2(arg x, arg y)   
Average avg() 
Cosine cos() 
Hyperbolic cosine cosh() 
Exponential exp() 
Floating Point Absolute Value fabs() 
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Floating Point Modulus 
Operations 

fmod() 

Natural Logarithm log() 
Base 10 Logarithm log10() 
Arg1 to the power arg2 pwr(arg1,arg2) 
Sine sin() 
Hyperbolic Sine sinh() 
Square root sqrt() 
Tangent tan() 
Hyperbolic Tangent tanh() 
Conversion Functions 
Celsius to Fahrenheit Fahr() 
Fahrenheit to Celsius cels() 
centimeter to inches in() 
inches to centimeters cm() 
meter to feet ft() 
feet to meter mt() 
kilometer to miles mi() 
mile to kilometers km() 
gallon to liters l() 
liter to gallons gal() 
pounds to kilograms kg() 
kilograms to pounds lb() 
ounces to grams gm() 
grams to ounces oz() 
wind chill (temperature in 
fahrenheit, wind speed) 

wc() 
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Financial Functions 
Present value of dollar  pv() 
Future value of dollar  fv() 

Pocket Word  
Pocket Word is a word processing program designed for Pocket 
PC. Pocket Word allows for synchronization of documents between 
your desktop computer and your PAC Mate so that you have the 
most up-to-date content in both locations. 

To open Pocket Word, go to the Start Menu (F3) and press P 
(DOTS 1-2-3-4) three times. Then press ENTER to open Pocket 
Word. The first time you open Pocket Word from the Programs 
Menu, it opens by default to a blank document so you can 
immediately begin typing. With Pocket Word, you can Braille in 
Grade 2. 

After you have created a document, Pocket Word will then open 
first to a list view where you can choose the document you want to 
open or create a new document. To select a document in the list 
view, use the cursor cross to move to the document and then press 
ENTER. To create a new document, press F2 and press ENTER 
on New.  

Pocket Word has several templates you can use as a default 
document. These templates contain preformatted text so much of 
the work is already done for you. To select a template, press F2 
and press ENTER on Tools. From the Tools Menu, press ENTER 
on Options. Press TAB to move to the Default Template combo 
box, and use the cursor cross to select a template type. 

In Pocket Word you can open only one document at a time. When 
you open a second document, the first one is saved and closed 
automatically. You can save a document you create or edit in a 
variety of formats, including Word (.doc), Pocket Word (.psw), Rich 
Text Format (.rtf), and Plain Text (.txt).  

To save a document, press F2, move to Tools and press ENTER. 
From the Tools Menu, press ENTER on Save Document As. In the 
Name edit field type a name for your file. If you want your 
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document to get saved in a particular folder, press TAB to move to 
the next control and use the cursor cross to select a folder. The 
next control allows you to change the documents format. Since this 
is also a combo box, use the cursor cross to select a file format. 
The last control in this dialog designates where you want to save 
your file. You have a choice of using the Main Memory or FlashFx 
Disk. To close and exit this dialog, press ENTER. 

As you continue to create, synchronize and edit documents, you 
may find that having all files appear in the list view too 
cumbersome to navigate. To have your files show in the list view 
by their respective folders, press F2 and press ENTER on Show 
By. Next, select the folder that contains the file you want to open or 
add a new folder by selecting the Add/Delete option from the 
menu.  

In addition to showing files by their respective folders, you can sort 
files by date, name, size and type. To do this, press F2 and press 
ENTER on Sort By. Use the cursor cross to make your selection. 

To delete, copy, rename or move, use the editing commands such 
as E CHORD, D; E CHORD, C; or E CHORD, R. For more 
information on these commands, please see PAC Mate Basics, 
Working with Text, Editing. 

To e-mail a document, open the list view of Pocket Word and 
select the file then press F2 CHORD. From the context menu use 
the cursor cross to select the appropriate action.  

Synchronizing Pocket Word Documents 
Pocket Word documents can be synchronized with Word 
documents on your PC. To synchronize files of any type, you 
must first open ActiveSync on your PC and from the Tools Menu 
(ALT+T) select Options. In the Mobile Device list view place a 
check in the Files’ check box. When you select Files, a 
PACMate My Documents folder is created on your PC's 
desktop. Place all files you want to synchronize with the PAC 
Mate in this folder. Password-protected files cannot be 
synchronized.  
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All Pocket Word files stored in My Documents and its subfolders 
are synchronized with the PC. ActiveSync converts documents 
during synchronization.  

For more information on synchronization or file conversion, see 
ActiveSync Help on the PC. 

Note:  When you delete a file on either your PC or your 
PAC Mate, the file is deleted in the other location the 
next time you synchronize. 

File Conversion 
Word documents (.doc) and templates (.dot) created in Word 
6.0 or later on the PC are converted to Pocket Word documents 
(.psw) during file synchronization.  

Pocket Word documents are converted to Word documents 
when they’re synchronized back to the PC. During conversion 
from Word to Pocket Word, most simple text and paragraph 
formatting are retained and displayed, although some formatting 
attributes may be changed or lost. For more information, see 
ActiveSync Help on the PC. 

Note:  To use your new document as a template, move the 
document to the Templates folder. 

The section below lists conversion behavior between Pocket 
Word and Word. 
• Borders and shading are not displayed in Pocket Word, but 

are restored when converted back to a Word document. 
Shading is not restored when used in a table, but simple 
borders are restored.  

• Character formatting such as bold, italic, strikethrough, 
superscript, subscript, and hidden text are retained and 
displayed. Other effects are changed or removed.  

• Colors are retained and mapped to colors available on your 
device.  

• Fonts and font sizes not supported by PAC Mate are mapped 
to the closest font available. The original font will be listed on 
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your PAC Mate. When converted back to Word, the data is 
displayed in the original font.  

• Page formatting such as headers, footers, footnotes, 
columns, page setup information, and style sheets are 
removed during conversion to Pocket Word. Pocket Word 
supports built-in headings.  

• Paragraph formatting such as tabs, alignment, bullets, 
indentation, simple numbered lists, and paragraph spacing 
are retained and displayed in Pocket Word.  

• Pictures are removed during conversion.  
• Table of contents, text and some formatting are preserved. 

However, any text set at right-aligned tab stops may wrap to 
the next line.  

• Index text and some formatting are preserved.  
• Table formatting is removed, but text is preserved.  
• OLE objects are removed during conversion.  
• Revision marks are visible but cannot be changed.  
• Annotations and comments are removed during conversion. 

Finding and Replacing Text 
Within Pocket Word is a Find/Replace Feature that is very 
similar to the Find/Replace Feature in Word. With this feature 
you can search for strings of text or a single word and replace it 
with other text. To use the Find/Replace Feature press F2, 
move to Edit, and press ENTER (DOT 8). From the Edit Menu 
select Find/Replace. Type the text you want to find. Press TAB 
(DOT 4-5 CHORD) to move to the Find button and press 
ENTER. If you’re replacing text, TAB to the Replace button and 
press ENTER. Type the replacement text. With this feature you 
can match case and match whole words. Use the SPACEBAR 
to check these options. When you are ready to Find a word(s) 
press ENTER on the Find button.  

Pocket Word selects the first instance of the text in the 
document and displays a window with buttons that allows you to 
find the next instance or replace the text.  
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Formatting  
The formatting options available in the Pocket Word Edit Menu 
are fairly robust. With it you can control point size and font type, 
determine text attributes such as bold, italic, underline etc., and 
align, bullet or indent text as needed.  

Of course, you can always use PAC Mate’s formatting 
commands. For more information on these commands, please 
see PAC Mate Basics, Working with Text. 

To format your document using Pocket Word’s Edit Menu, press 
F2, move to Edit and press ENTER. If you want to work with the 
font and alignment, go to Format on the Edit Menu and press 
ENTER. To work with paragraph alignment, bulleted lists and 
indentation, go to Paragraph on the Edit Menu and press 
ENTER.  

As you are working in Pocket Word, remember to select the text 
you want affected, then go into the menus and make your 
changes. For more information on selecting text, please see 
PAC Mate Basics, Working with Text. 

You can also insert the date if you want. To do this press F2, go 
to the Tools Menu and from the Tools Menu select Insert Date. 
The date is then placed into your document at the cursor 
location. 

Saving, Renaming, Moving, and Deleting  
When you create a new document, the information you enter is 
saved automatically and named according to the first characters 
of text entered in the document. In an open document, you can:  
• Save a copy of the document. Go to the Tools Menu by 

pressing F2 and select Save Document As.  
• Rename the document. Go to the Edit Menu by press F2 and 

select the Rename/Move. In the Name box, type the new 
name.  

• Move the document to a storage card or folder. Go to the Edit 
Menu, and select Rename/Move. Select the appropriate 
folder or location.  
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• Delete the document. Go to the Tools Menu and select 
Delete Document.  

Note:  To move or delete multiple documents, in the list 
view, select the documents. Then, press F2 
CHORD. From the menu, choose Rename/Move or 
Delete. 

Attaching a Document to E-mail 
In the documents list view; select the document and press F2 
CHORD. To select multiple documents, use the 
SPACEBAR+UP/DOWN ARROW. Then, press F2 CHORD. 
From the Context Menu, choose Send via E-mail.  

A new e-mail message is created with the document attached.  

Changing Default Options 
You can change the defaults for creating and storing Pocket 
Word documents by going to the Tools Menu and selecting 
Options in the list view.  

Select a template to be used for new documents. You can 
change this default when creating specific documents. Only 
documents saved in the Templates folder are listed.  

Select a location for storing documents. You can choose 
between main memory and a storage card, if you have one 
installed.  

Select the type of documents you want displayed in the 
document list view. 

StopWatch  
The PAC Mate StopWatch can measure both elapse and 
countdown time. Use the elapse timer to measure the amount of 
time it takes to complete an event. Use the countdown timer to 
mark the time remaining in an event.  

To use the StopWatch, go to the Start Menu (F3) and press P for 
Programs, then S for StopWatch. 
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The table below lists the commands that are specific to the 
StopWatch program.   

Description Command 
L (DOTS 1-2-3) 

Say Current Time T (DOTS 2-3-4-5) 
Start-Stop S (DOTS 2-3-4) 
Reset R (DOT 1-2-3-5) 
Enter Count Down Dialog C (DOTS 1-4) 

Say Last Time 

Using the Elapse Timer 
When the program opens, the elapse timer is ready for you to 
press the ENTER key. When you do, the PAC Mate announces 
"Starting StopWatch" and upon every passing minute 
announces the current elapsed time. 

To stop or pause the elapse timer, press ENTER. 

To resume timing, press ENTER again. 

To reset the timer, press TAB to move to the Reset button and 
press ENTER. 

Using the Countdown Timer 
To use the countdown timer, move to the Countdown button and 
press ENTER. This opens a dialog where you type in the 
minutes in the edit box, then press TAB to move to the next edit 
box and type in the seconds. Remember to use Computer 
Braille. When you are done, press ENTER. This returns you to 
the main StopWatch dialog where PAC Mate starts the count 
down. PAC Mate announces remaining time at every one-
minute interval. With fifteen seconds remaining, PAC Mate 
announces each second until zero is reached. 

To stop or pause the elapse timer, press ENTER. 

To resume timing, press ENTER again. 
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To reset the timer, press TAB to move to the Reset button and 
press ENTER. 

Reading the Timer 
To read elapsed or remaining time at any point, press 
SHIFT+TAB to move to the time edit box, then use any of 
reading commands or press the SPACEBAR.  

Windows Media Player 
Windows Media Player, available on your Companion CD, allows 
you to play sound files on your PAC Mate. It supports a wide range 
of audio file formats (.wma, .asf, .mp3, .wav, and .wmp) including 
streaming audio, which is used primarily by Internet radio. Because 
Windows Media Player for Pocket PC has limited support on PAC 
Mate, the following description offers you detailed instructions on 
the functions available, but does not endorse their reliability. You 
find Windows Media Player in the Start Menu by pressing F3, W. 

Installing Windows Media Player 
Ensure that Active Sync is installed on your desktop computer, 
and that the PAC Mate is connected to your computer with 
either a full or guest partnership.  
1. Insert the Companion CD into your computer’s CD ROM 

drive.  
2. When the setup page loads, select "Enhance Your Pocket 

PC." 
3. On the next page, select "Entertainment." 
4. Find the paragraph about Windows Media Player. Below 

that you will find an install link. Activate this link, and follow 
the instructions to install Windows Media Player onto the 
PAC Mate. 

5. While you are installing Windows Media Player, you will be 
asked if you want to overwrite files. Select “No” each time 
you are asked. If you select “Yes” your Help Files 
preinstalled for Media Player will be overwritten. 
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Copying Sound Files to Your PAC Mate 
You can copy sound files to your PAC Mate by synchronizing 
them with ActiveSync or if you have Windows Media Player 7 or 
later on your PC you can use its Portable Device feature. For 
more information on this feature, please see the online Help for 
Windows Media Player on the PC. 

After synchronizing or copying files to the PAC Mate, open up 
Windows Media Player and press F2 and press ENTER on 
Select. This will bring up the Playlist Manager. This displays all 
of the media available on the PAC Mate and lets you arrange it 
however you want. Press F2 CHORD on a track to perform 
actions such as play selection, move earlier, move later and/or 
delete. Any subsequent synchronizing of audio files to PAC 
Mate may not display in the Playlist Manager. To access these 
audio files, please use File Explorer. 

Note:  Once you access an audio file with File Explorer, 
you must continue using File Explorer thereafter as 
you will no longer be able to access them from the 
Playlist. 

Listening to Sound 
With Windows Media Player you can listen to music on the PAC 
Mate while reading e-mail or editing a file. To do this, simply 
open Windows Media Player (F3, W) and press F2 and press 
ENTER on Select. Use the arrow keys to select the song you 
want to play, and then press F2 CHORD and choose “Play 
Selection” from the Context Menu. Next, open the program you 
want to work in. If you want to listen to the whole playlist, just 
open Windows Media Player and press P CHORD, P. To pause 
or stop the audio file, you must leave the program you are 
working in and return to Windows Media Player for the pause (P 
CHORD, P) and the stop (P CHORD, S) commands to work. If 
you have only Windows Media Player open, then you only need 
to press the second letter as they then work as layered 
commands. 
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To disable Background Play, press F2 and press ENTER on 
Tools. Move to Settings and press ENTER. On the Settings 
submenu press ENTER on Audio & Video. When the Audio & 
Video dialog opens, press TAB three times to move to the 
“Background Play” combo box and use the arrow keys to select 
Pause. When you are done, press ENTER to close the dialog. 
Now when you move into another program to work, Windows 
Media Player will automatically pause the audio file. Press F4, 
switch to Windows Media Player and play resumes.  

To decrease or increase the volume, use S CHORD, DOWN 
ARROW or UP ARROW. 

Note:  The volume of JAWS and Windows Media Player 
are not independent of one another. 

The following table lists the commands available in Windows 
Media Player. 

Play/Pause P CHORD, P 
DOTS 1-2-3-4 CHORD, DOTS 
1-2-3-4 

Stop P CHORD, S 
DOTS 1-2-3-4 CHORD, DOTS 
2-3-4 

To open a Website to listen to Internet radio, press F2 and press 
ENTER on Tools. On the Tools Menu move to Open URL and 
press ENTER again. In the Edit Combo box, type in the URL of the 
Website and then press ENTER. 

You are encouraged to explore the Tools Menu, as there are more 
items that may enhance your experience with Windows Media 
Player. 
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Contacting Freedom Scientific 
Corporate Headquarters 

Freedom Scientific BLV Group, LLC  
11800 31st Court North 
St. Petersburg, FL 33716-1805 
USA 

Telephone: (727) 803-8000 
Fax: (727) 803-8001 
World Wide Web: http://www.FreedomScientific.com  

Office hours: Monday through Friday 8:30 A.M. to 5:00 P.M. 
Eastern Standard Time (USA) 

The Freedom Scientific Website, 
http://www.FreedomScientific.com, is a comprehensive source of 
information regarding screen reader software, screen magnification 
software, training opportunities, application-specific cassette 
tutorials and the company that develops these products.  

The Freedom Scientific Web site is designed to be accessible by 
people with disabilities and includes a great deal of technical 
support information as well as online ordering capability, RealAudio 
descriptions of many products, and continuous product update and 
maintenance downloads. 

At Freedom Scientific, we strive to produce the highest quality 
documentation products, and welcome your feedback. If you have 
comments or suggestions about our online Help or printed guides, 
send your e-mail messages to 
documentation@FreedomScientific.com. 

Sales Department 
Sales Telephone: (800) 444-4443 
International Sales Telephone, including Canada: (727) 803-8000 
Sales Fax: (727) 803-8001 
Sales e-mail: Info@FreedomScientific.com 

144 440060-001 Rev. A 

http://www.freedomscientific.com/
http://www.freedomscientific.com/


 

To ensure that your request is handled promptly, include your 
complete address and telephone number. 

Technical Support 
You must be a registered user to access Freedom Scientific 
support services. Freedom Scientific support services are subject 
to Freedom Scientific terms and conditions in place at the time the 
service is used.  

Reach Technical Support using the following options: 

Technical Support e-mail: Support@FreedomScientific.com 

Technical Support Telephone: (727) 803-8600  

Office hours: Monday through Friday 8:30 A.M. to 8:00 P.M. 
Eastern Time (USA) 

When you call, be at your computer, have your documentation in 
hand, and be prepared to provide the following information: 

• Product serial number used for registration. 
• Product name and version number. 
• Type of computer hardware you are using. 
• Software version number of Windows. 
• Exact wording of any messages that appear on your screen. 
• What you were doing when the problem occurred. 
• How you tried to solve the problem. 
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Appendix A: PAC Mate Commands 
Function Keys and General Navigation 
Description Command 
ESC F1 

Menu Bar F2 

Start Menu F3 

List Recent Apps w/ first letter  
navigation 

F4 plus first letter of application 

BACKSPACE DOT 7 

ENTER DOT 8 

TAB DOTS 4-5 CHORD 

SHIFT+TAB DOTS 1-2 CHORD 

INSERT+TAB 
(Read Type and Text) 

DOTS 1-2-4-5 CHORD 

Context Menu F2 CHORD 

Refresh F1 CHORD 

Access Keys DOTS 2-3-4-5-6 CHORD   
plus the Access letter 

Read Access Key Dropped G CHORD 

Reading and Moving through Text 
Description Command 
Prior Character DOT 3 CHORD 

Next Character DOT 6 CHORD 

Current Character DOTS 3-6 CHORD 

Current Character Phonetic DOTS 3-6 CHORD 
twice quickly 
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Prior Word DOT 2 CHORD 

Next Word DOT 5 CHORD 

Current Word DOTS 2-5 CHORD 

Spell Current Word DOTS 2-5 CHORD 
twice quickly 

Prior Line DOT 1 CHORD 

Next Line DOT 4 CHORD 

Current Line DOTS 1-4 CHORD 

Prior Sentence DOT 4+LEFT ARROW 

Next Sentence DOT 4+RIGHT ARROW 

Current Sentence DOT 4+LEFT+RIGHT ARROW 

Prior Paragraph DOT 1+UP ARROW 

Next Paragraph DOT 1+DOWN ARROW 

Current Paragraph DOT 1+UP+DOWN ARROW 

Page Up DOT 2+UP ARROW 

Page Down DOT 2+DOWN ARROW 

Move to 
Beginning of Line 

DOT 3+LEFT ARROW 

Move to 
End of Line 

DOT 3+RIGHT ARROW 

Move to 
Top of File 

DOT 3+UP ARROW 

Move to 
Bottom of File 

DOT 3+DOWN ARROW 

Read from 
Beginning of Line 

DOTS 3-7+LEFT ARROW 

Read to 
End of Line 

DOTS 3-7+RIGHT ARROW 
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Prior Document Window DOTS 2-3 CHORD 

Next Document Window DOTS 5-6 CHORD 

Selecting Text 
Description Command 
Select Prior Character DOTS 3-7 CHORD 

Select to Next Character DOTS 6-7 CHORD 

Select Prior Word DOTS 2-7 CHORD 

Select to Next Word DOTS 5-7 CHORD 

Select Prior Line UP ARROW CHORD 

Select to Next Line DOWN ARROW CHORD 

Select Prior Sentence DOT 4+LEFT ARROW CHORD 

Select to Next Sentence DOT 4+RIGHT ARROW CHORD

Select Prior Paragraph DOT 1+UP ARROW CHORD 

Select to Next Paragraph DOT 1+DOWN ARROW 
CHORD 

Select Page Up DOT 2+UP ARROW CHORD 

Select Page Down DOT 2+DOWN ARROW 
CHORD 

Read Selected Text DOTS 4-5-6-7-8 CHORD 

Selecting to/from File Edges 
Description Command 

Select to 
Beginning of Line 

DOT 3+LEFT ARROW CHORD 

Select to 
End of Line 

DOT 3+RIGHT ARROW CHORD
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Select to 
Top of File 

DOT 3+UP ARROW CHORD 

Select to 
Bottom of File 

DOT 3+DOWN ARROW CHORD

Information 
Many commands provide information you may find useful. Most of 
these commands are layered commands that start with I CHORD, 
DOTS 2-4 CHORD. A layered command is a two-part command. 

After pressing I CHORD, press T, DOTS 2-3-4-5, for window title, 
F, DOTS 1-2-4 for Font Information, or W, DOTS 2-4-5-6 to read 
the current window.  

Description Command 
Window Title I CHORD, T 

DOTS 2-4 CHORD, DOTS 2-3-4-5 

Read Entire Window I CHORD, W 
DOTS 2-4 CHORD, DOTS 2-4-5-6 

Font Information I CHORD, F 
DOTS 2-4 CHORD, DOTS 1-2-4 

Default Button in Dialog I CHORD, E 
DOTS 2-4 CHORD, DOTS 1-5 

Time F3 CHORD 

Date F3 CHORD twice quickly 

General Editing Commands 
Description Command 
Undo E CHORD, U 

(DOTS 1-5 CHORD, DOTS 1-3-6) 

Cut E CHORD, X 
(DOTS 1-5 CHORD, DOTS 1-3-4-6) 
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Copy E CHORD, C 
(DOTS 1-5 CHORD, DOTS 1-4) 

Paste E CHORD, P 
(DOTS 1-5 CHORD, DOTS 1-2-3-4) 

Select All E CHORD, A 
(DOTS 1-5 CHORD, DOT 1) 

Find E CHORD, F 
(DOTS 1-5 CHORD, DOTS 1-2-4) 

Find Next E CHORD, N 
(DOTS 1-5 CHORD, DOTS 1-3-4-5) 

Replace E CHORD, R 
(DOTS 1-5 CHORD, DOTS 1-2-3-5) 

Delete E CHORD, D 
(DOTS 1-5 CHORD, DOTS 1-4-5) 

Formatting Text 
Description Command 
Bold F+DOT 8, B  

(DOTS 1-2-4-8, DOTS 1-2) 

Italic F+DOT 8, I  
(DOTS 1-2-4-8, DOTS 2-4) 

Underline F+DOT 8, U  
(DOTS 1-2-4-8, DOTS 1-3-6) 

Strikethrough F+DOT 8, S  
(DOTS 1-2-4-8, DOTS 2-3-4) 

Center F+DOT 8, C  
(DOTS 1-2-4-8, DOTS 1-4) 

Left Justify F+DOT 8, L  
(DOTS 1-2-4-8, DOTS 1-2-3) 

Right Justify F+DOT 8, R  
(DOTS 1-2-4-8, DOTS 1-2-3-5) 
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Margins F+DOT 8, M  
(DOTS 1-2-4-8, DOTS 1-3-4) 

Set Font F+DOT 8, F CHORD  
(DOTS 1-2-4-8, DOTS 1-2-4 CHORD)

Uppercase 
Description Command 
Caps Lock On U CHORD, U 

(DOTS 1-3-6 CHORD, DOTS 1-3-6)

Caps Lock Off U CHORD, L 
(DOTS 1-3-6 CHORD, DOTS 1-2-3)

Inserting Information 

Description 
Command 
DOT Pattern 

Insert Date and Time I+DOT 8, D 
(DOTS 2-4-8, DOTS 1-4-5) 

New Paragraph DOT 8 pressed twice  

Advanced Commands 
The Advanced Commands provide users the ability to explore 
Pocket PC applications, but are not necessary for ordinary use 
of the PAC Mate.  

The HOME ROW commands are part of a utility that provides 
users who are familiar with JAWS scripting the necessary 
information for scripting Pocket PC applications. 

Activate JAWS Cursor DOT 8 CHORD, J 
(DOT 8 CORD, DOTS 2-4-5) 

Activate PC Cursor DOT 8 CHORD, P 
(DOT 8 CHORD, DOTS 1-2-3-4) 
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Restrict Current Cursor DOT 8 CHORD, R 
(DOT 8 CHORD, DOTS 1-2-3-5) 

Route JAWS to PC DOT 8 CHORD, DOTS 3-6 

Route PC to JAWS DOT 8 CHORD, DOTS 3-4-6) 

Say Active Cursor DOT 8 CHORD, C 
(DOT 8 CHORD, DOTS 1-4) 

Left Click DOT 8 CHORD, DOT 7 

Set Graphics Verbosity DOT 8 CHORD, G CHORD 
(DOT 8 CHORD, DOTS 1-2-4-5 
CHORD) 

Open Graphics Labeler DOT 8 CHORD, G 
DOT 8 CHORD, DOTS 1-2-4-5) 

Say Color and Active 
Cursor 

DOT 8 CHORD, E 
(DOT 8 CHORD, DOTS 1-5) 

Say Current Script and 
Application 

DOT 8 CHORD, Q 
(DOT 8 CHORD, DOTS 1-2-3-4-5) 

Toggle Home Row Mode DOT 8 CHORD, U 
(DOT 8 CHORD, DOTS 1-3-6) 

Route JAWS to Home 
Row Position 

DOT 8 CHORD, DOTS 1-2-5-6) 

Initialize Home Row 
Position 

DOT 8 CHORD, DOTS 2-6 

Read Current Home Row 
Window 

DOT 8 CHORD, DOTS 2-3-6 

152 440060-001 Rev. A 



 

Read Output Information 
for Current Home Row 
Window 

DOT 8 CHORD, DOTS 3-5 

View Output Information 
for Home Row Window in 
Message Box 

DOT 8 CHORD, DOTS 3-5 CHORD 

Set Output Mode for 
Home Row Window 

DOT 8 CHORD, DOTS 2-5 

Next Home Row Window DOT 8 CHORD, DOTS 4-5 

Prior Home Row Window B  
(DOTS 1-2) 

First Child Home Row 
Window 

DOT 8 CHORD, DOTS 3-5-6 

Move to Parent Home 
Row Window 

DOT 8 CHORD, DOTS 2-5-6-7 

Visibility Status of Current 
Window 

DOT 8 CHORD, DOTS 2-3-5 
CHORD 

Toggle Speaking Window 
Visibility 

DOT 8 CHORD, DOTS 2-3-5 

First Requested Attribute 
in Home Row 

DOT 8 CHORD, A 
DOT 8 CHORD, DOT 1 

Last Requested Attribute 
in Home Row 

DOT 8 CHORD, DOT 4 

Next Requested Attribute 
in Home Row 

DOT 8 CHORD, DOT 5 

440060-001 Rev. A  153 



 

Prior Requested Attribute 
in Home Row 

DOT 8 CHORD, DOT 2 

Set Attribute Mode in 
Home Row 

DOT 8 CHORD, DOTS 1-4-6 
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Appendix B: Special Considerations 
Lithium Ion Battery 

Incorrect battery usage may lead to the leakage of battery fluid, 
a bursting of the battery, or ignition of the battery. To prevent 
such accidents, observe the following precautions: 
• Do not carry or store battery together with necklaces, hairpins 

or other metal objects. 
• Do not disassemble or modify the battery. The battery 

contains safety and protection devices, which if damaged, 
may cause the battery to generate heat, explode or ignite. 

• In the event the battery leaks and the fluid gets into your eye, 
do not rub the eye. Rinse well with water and immediately 
seek medical care. If left untreated, the battery fluid could 
cause damage to the eye. 

• The temperature range over which the battery can be used is 
-4°F (-20°C) to 140°F (60°C). Use of the battery outside this 
temperature range may damage performance of the battery 
or may reduce its life expectancy. 

• The temperature range over which the battery can be 
charged is 32°F (0°C) to 113°F (45°C). Charging the battery 
at temperatures outside this range may cause severe 
damage to the battery or reduce battery life expectancy. 

• Do not place the battery in or near fire, or in direct sunlight. 
Heating the battery can damage the safety circuitry, which 
can cause additional heating, rupture or ignition of the 
battery. 

• When charging the battery, either use a specified battery 
charger or otherwise ensure the battery charging conditions 
specified by Freedom Scientific are met. These are: (Model 
#SB-123A0F-11)(Input 100 – 250V ~ 47 – 63Hz 0.8A)(Output 
12V – 3.0A) 

• Immediately discontinue use of the battery if, while using, 
charging or storing the battery, the battery emits an unusual 
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smell, feels hot, changes color or shape, or appears 
abnormal in any other way. 

• Contact Freedom Scientific if any of these problems are 
observed. 

Note:  Freedom Scientific assumes no liability for problems 
that occur when the safety precautions and warnings 
listed above are not followed. 

Protecting Your Hearing 
Avoid using headphones/earphones in noisy environments 
where you are likely to increase the volume. Using 
headphones/earphones at high volumes can transmit loud, high 
frequencies that cause hearing damage.  

To prevent listening fatigue, rest the ears in silence after long 
sessions with headphones.  

If you experience a ringing in your ears, reduce the volume or 
discontinue use.  
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Appendix C: Unsupported Items  
• Games - Solitaire 

• Settings – Input dialog – Input Method page 

• Settings – Input dialog – Word Completion page 

• Settings – Input dialog – Options page – Default zoom level for 
writing 

• Settings – Input dialog – Options page – Default zoom level for 
typing 

• Settings – Input dialog – Options page – Scroll upon reaching 
the last line 

• Settings – Today dialog – Appearance page 

• Settings – Sounds & Notifications dialog – Volume page – 
Enable Sounds for Screen taps 

• Settings – Sounds & Notifications dialog - Notifications page – 
Display message on screen and Flash light notifications  

• Settings – Menus dialog – New Menu page – Turn on New 
button menu 

• Settings – Buttons dialog – Up/Down Control page 

• Pocket Word – Tools Menu – Writing, Drawing, Zoom 

• Windows Media Player – Tools Menu – Settings – Audio & 
Video – Video Full Screen, Oversized, and Video File of Large 
dimension and High Bit Rates 

• Windows Media Player – Tools Menu – Settings – Skin Chooser 

• Windows Media Player – Tools Menu – Settings – Buttons 

• Windows Media Player – Select Menu – Add 

• Windows Media Player – Select Menu – Show By Menu 
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Appendix D: Alpha Braille Reference  
A DOT 1 N DOTS 1-3-4-5 
    
B DOTS 1-2 O DOTS 1-3-5 
    
C DOTS 1-4 P DOTS 1-2-3-4 
    
D DOTS 1-4-5 Q DOTS 1-2-3-4-5 
    
E DOTS 1-5 R DOTS 1-2-3-5 
    
F DOTS 1-2-4 S DOTS 2-3-4 
    
G DOTS 1-2-4-5 T DOTS 2-3-4-5 
    
H DOTS 1-2-5 U DOTS 1-3-6 
    
I DOTS 2-4 V DOTS 1-2-3-6 
    
J DOTS 2-4-5 W DOTS 2-4-5-6 
    
K DOTS 1-3 X DOTS 1-3-4-6 
    
L DOTS 1-2-3 Y  DOTS 1-3-4-5-6 
    
M DOTS 1-3-4 Z  DOTS 1-3-5-6 
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Appendix E: Numeric Braille Reference 
 

1  DOT 2 
  
 2  DOTS 2-3 
  
 3  DOTS 2-5 
  
 4  DOTS 2-5-6  
  
 5  DOTS 2-6 
  
 6  DOTS 2-3-5 
  
 7  DOTS 2-3-5-6 
  
 8  DOTS 2-3-6 
  
 9  DOTS 3-5 
  
 0  DOTS 3-5-6 

440060-001 Rev. A  159 



 

Appendix F: Computer Braille Symbols 
 

: (Colon) DOTS 1-5-6 

; (SEMI COLON) DOTS 5-6 

( (LEFT PARENTHESIS) DOTS 1-2-3-5-6 

) (RIGHT PARENTHESIS) DOTS 2-3-4-5-6 

< (LESS THAN) DOTS 1-2-6 

> (GREATER THAN) DOTS 3-4-5 

{ (LEFT BRACE) DOTS 2-4-6 

} (RIGHT BRACE) DOTS 1-2-4-5-6 

[ (LEFT BRACKET) DOTS 7-2-4-6 

] (RIGHT BRACKET) DOTS 7-1-2-4-5-6 

/ (SLASH) DOTS 3-4 

\ (BACKSLASH) DOTS 7-1-2-5-6 

* (ASTERISK OR STAR) DOTS 1-6 

# (NUMBER SIGN) DOTS 3-4-5-6 

$ (DOLLAR) DOTS 1-2-4-6 

? (QUESTION MARK) DOTS 1-4-5-6 
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+ (PLUS) DOTS 3-4-6 

- (HYPHEN, DASH, MINUS) DOTS 3-6 

= (EQUALS) DOTS 1-2-3-4-5-6 

& (AND OR AMPERSAND) DOTS 1-2-3-4-6 

! (EXCLAIM) DOTS 2-3-4-6 

% (PERCENT) DOTS 1-4-6 

' (APOSTROPHE) DOT 3 

" (QUOTE) DOT 5 

, (COMMA) DOT 6 

. (PERIOD) DOTS 4-6  

@ (AT) DOTS 7-4 

_ (UNDERLINE) DOTS 7-4-5-6 

^ (CARET) DOTS 7-4-5 

~ (TILDE) DOTS 4-5 

` (GRAVE ACCENT) DOT 4 
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Appendix G: Grade 2 Braille Reference 
 

about           ab 
above         abv 
according     ac 
across         acr 
after             af 
afternoon        afn 
afterward        afw 
again             ag 
against          ag(st) 
ally    DOT 3, DOTS 1-3-4-5-6 
almost            alm 
already           alr 
also         al 
although        al(th) 
altogether      alt 
always           alw 
ance        DOTS 4-6, DOTS 1-5 
and           DOTS 1-2-3-4-6 
ar            DOTS 3-4-5 
as             z 
ation     DOT 6, DOTS 1-3-4-5 
bb              DOTS 2-3 
be                     DOTS 2-3 
because           (be)c 
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before              (be)f 
behind              (be)h 
below               (be)l 
beneath            (be)n 
beside              (be)s 
between           (be)t 
beyond             (be)y 
ble                    DOTS 3-4-5-6 
blind                 bl 
Braille               brl 
but                    b 
by                     DOTS 3-5-6 
can                  c 
cannot           DOTS 4-5-6, DOTS 1-4 
cc                     DOTS 2-5 
ch                     DOTS 1-6 
character          DOT 5, DOTS 1-6 
child                 DOTS 1-6 
children            (ch)n 
com                  DOTS 3-6 
con                   DOTS 2-5 
conceive          (con)cv 
conceiving        (con)cvg 
could                cd 
day                  DOT 5, DOTS 1-4-5 
dd                     DOTS 2-5-6 
deceive            dcv 
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deceiving         dcvg 
declare             dcl 
declaring          dclg 
dis                    DOTS 2-5-6 
do                     d 
ea                     DOT 2 
ed                     DOTS 1-2-4-6 
either                ei 
en                     DOTS 2-6 
ence                 DOTS 5-6, DOTS 1-5 
enough             DOTS 2-6 
er                     DOTS 1-2-4-5-6 
ever                  DOT 5, DOTS 1-5 
every                e 
father               DOT 5, DOTS 1-2-4 
ff                       DOTS 2-3-5 
first                   f(st) 
for                    DOTS 1-2-3-4-5-6 
friend                fr 
from                 f 
ful                   DOTS 5-6, DOTS 1-2-3 
gg                     DOTS 2-3-5-6 
gh                     DOTS 1-2-6 
go                     g 
good                 gd 
great                grt 
had             DOTS 4-5-6, DOTS 1-2-5 
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have                 h 
here                 DOT 5, DOTS 1-2-5 
herself              h(er)f 
him                   hm 
himself             hmf 
his                    DOTS 2-3-6 
immediate        imm 
in                      DOTS 3-5 
ing                    DOTS 3-4-6 
into                DOTS 3-5, DOTS 2-3-5 
it                       x 
its                     (x)s 
itself                 (x)f 
ity            DOTS 5-6, DOTS 1-3-4-5-6 
just                   j 
know                DOT 5, DOTS 1-3 
knowledge       k 
less                DOTS 4-6, DOTS 2-3-4 
letter                 lr 
like                   l 
little                  ll 
lord                  DOT 5, DOTS 1-2-3 
many          DOTS 4-5-6, DOTS 1-3-4 
ment              DOTS 5-6, DOTS 3-4-5 
more                m 
mother             DOT 5, DOTS 1-3-4 
much                m(ch) 
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must                 m(st) 
myself              myf 
name              DOT 5, DOTS 1-3-4-5 
necessary        nec 
neither              nei 
ness               DOTS 5-6, DOTS 2-3-4 
not  n 
o’clock o’c 
of  DOTS 1-2-3-5-6 
one DOT 5, DOTS 1-3-5 
oneself (one)f 
ong  DOTS 5-6, DOTS 1-2-4-5 
ou DOTS 1-2-5-6 
ought   DOT 5, DOTS 1-2-5-6 
ound DOTS 3-6, DOTS 1-4-5 
ount   DOTS 4-6, DOTS 2-3-4-5 
ourselves (ou)rvs 
out   DOTS 1-2-5-6 
ow       DOTS 2-4-6 
paid   pd 
part   DOT 5, DOTS 1-2-3-4 
people     p 
perceive  p(er)cv 
perceiving p(er)cvg 
perhaps     p(er)h 
question   DOT 5, DOTS 1-2-3-4-5 
quick  qk 
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quite  q 
rather  r 
receive  rcv 
rejoice rjc 
rejoicing rjcg 
right   DOT 5, DOTS 1-2-3-5 
said sd 
sh   DOTS 1-4-6 
shall     DOTS 1-4-6 
should              (sh)d 
sion           DOTS 4-6, DOTS 1-3-4-5 
so        s 
some              DOT 5, DOTS 2-3-4 
spirit         DOTS 4-5-6, DOTS 2-3-4 
st                      DOTS 3-4 
still                    DOTS 3-4 
such                 s(ch) 
th                      DOTS 1-4-5-6 
that                   t 
the                    DOTS 2-3-4 6 
their       DOTS 4-5-6, DOTS 2-3-4-6 
themselves       (the)mvs 
there             DOT 5, DOTS 2-3-4-6 
these         DOTS 4-5, DOTS 2-3-4-6 
this                   DOTS 1-4-5-6 
those         DOTS 4-5, DOTS 1-4-5-6 
through        DOT 5, DOTS 1-4-5-6 
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thyself               (th)yf 
time              DOT 5, DOTS 2-3-4-5 
tion            DOTS 5-6, DOTS 1-3-4-5 
to                      DOTS 2-3-5 
today                td 
together            tgr 
tomorrow          tm 
tonight              tn 
under DOT 5, DOTS 1-3-6 
upon             DOTS 4-5, DOTS 1-3-6 
us                     u 
very                  v 
was                   DOTS 3-5-6 
were                 DOTS 2-3-5-6 
wh                    DOTS 1-5-6 
where             DOT 5, DOTS 1-5-6 
which                DOTS 1-5-6 
whose            DOTS 4-5, DOTS 1-5-6 
will                    w 
with                   DOTS 2-3-4-5-6 
word          DOTS 4-5, DOTS 2-4-5-6 
work             DOT 5, DOTS 2-4-5-6 
world DOTS 4-5-6, DOTS 2-4-5-6 
would wd 
you y 
young  DOT 5, DOTS 1-3-4-5-6 
your  yr 
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yourself  yrf 
yourselves  yrvs 
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